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Thoughts on Making a Good Show
by Dick Knisely

Is Easy on the Eye & Ear

Using PSG or PSP to build a slideshow is pretty
straightforward—maybe not easy, but not difficult
once you’ve learned the tools. But no matter how
good you get with the tools, there’s no guarantee
that will lead to a really good show. The first issue
is what I mean by “good.” For me, a good show
tells a story that engages me somehow and that I
want to remember. I’ve tried to identify the characteristics I think make a show a “good” one.

This is hard to explain, easy to recognize.
Partly, it’s mechanics: overuse of zooms, pans, and
other motion are the second most common characteristics detracting from a show. Unless you’re making a demo for Photodex or telling the story of how
much you’ve learned about the software, be wary
of fancy effects. If you can’t give a specific reason
for it, then you’re probably better off leaving it out.
In any case, effects should be used lightly.
Likewise, music is crucial to a really good
show. It’s a powerful tool for setting and reinforcing the mood and pace of both the individual pictures and the whole show, but if used poorly, that
power will damage your show badly. For most
shows, the music isn’t the story, so unless you’ve
got a very good reason, don’t let it grab the limelight away from the pictures.

Has a Story and Sticks to it
Someone once wrote, “I didn’t have time to
write you a short letter, so I wrote a long one instead.” Slideshows are like that, too. It’s a lot harder
to create a short one than a long one, but it’s important that you make it as short as possible—but no
shorter. That’s what stick to the story is about. Short
isn’t an end of itself; it’s a means to the end of telling a story well. In the well-told story, you’ve eliminated all the extraneous stuff and the distractions.
Know your story and aggressively remove anything that doesn’t support the show’s story. This is
hard! It’s natural to want the audience to see all the
wonderful pictures you took, but no matter how fantastic the picture, if it isn’t needed to tell the story,
then it doesn’t belong in the show. Likewise, no
matter how good they are, it’s rare that two similar
pictures are better than one in telling a single story
point. Did I mention it? This is hard! But be ruthless, and you’ll have a better presentation.
And you can’t stick to it if you don’t know what
your story is—a collection of pictures will tell a
story, but is it the story you wanted to tell?

Contains Good Photography
A good slide show needs good pictures, but
great photography won’t necessarily result in a great
slideshow. In a slideshow the audience typically gets
only a few seconds with each picture, and thus many
flaws might not be noticed. At the very least, you
want shots that are in focus and certainly well composed.
Those few seconds, being all the viewer gets
to see what’s there and understand it, means that a
busy or poorly composed shot may confuse that
viewer. Therefore, it’s important to ensure they’ll
get the point. After all, the picture does have a point
to make or it wouldn’t be there. Crop to reduce visual clutter and/or zoom in to force the focus point
onto what you want them to see.
6

Good Pacing in the Show

require a very different pace from one showing the
wide-open landscapes of the Grand Canyon. Even
within the overall pace of the show, I think the pacing needs to be tweaked to suit specific scenes and
sometimes even individual pictures.
NOTE: These are my thoughts, and I make no
claim that everyone should agree with them or that
a show matching these ideas is necessarily a good
one in everyone’s eyes, but I believe that thinking
about these things will help.

This one is all about “feel,” which is another
hard-to-define but easy-to-recognize characteristic.
Good pacing is, for me, keeping things moving, giving me enough time to appreciate the pictures but
not enough to get bored. Across a typical show, pacing may vary, though not dramatically, because it
needs to match that elusive “feel” for the overall
storyline. A show about a sports team is likely to
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Good Design Has…
by Barbara Coultry

Balance

Economy

A large photo above a small one is like a giant
sitting on a tiny toadstool. Imagine that each photo
and each graphic element has weight, and then decide if it can support what’s above it. Think also of
the weight of colors. Doesn’t a brilliant, saturated
color “weigh more” than a muted one? Imagine an
old photo in soft sepia tint laid on a background of
emerald green. The eye will go to the green because
it has more weight—a stronger visual attraction—
than the sepia tint. The photo is the subject, not the
background, and so using a brilliant green throws
off the balance.
Balance can be very subjective, but when a slide
layout “just doesn’t look right,” try considering the
placement of pictures and lines as if they all had
weight. Also, pay attention to where the eye goes
first and if that’s really where you want it going.
If you’re interested in learning about composition, look for books about Web or advertising design since they’re closest to what we do.

Nothing beyond what’s needed to convey an
idea should exist in a slide. This doesn’t mean that
decorative elements can’t be used; they are extraneous only when they don’t help define the subject of
the slide. Thus, if a show is about modern steel skyscrapers in the city, it’s likely to call for little or no
décor, but if it’s about a Victorian ancestor, a bit of
lace could help define the person.

Unity
Create a theme and stick to it. For instance, don’t
suddenly change the background from pure black to
a texture and then to a gradient. To do this risks turning your show into a circus. There should be a consistent element throughout, something that works to
tie everything together. It could be as noticeable as a
frame, or as basic as using the same background
throughout. Background elements can change, but
they still need consistency. For instance, a single
flower might be placed in the background, the type
of flower changing periodically, but because it’s always a flower, consistency remains.
Keep your images in tune with the theme, sticking to the subject, not tossing in a perfectly lovely
photo only because it’s lovely. It could be the greatest darned picture you’ve ever taken, but you should
still save it for another show.

Contrast
We’re constantly choosing black backgrounds
to contrast with our images, but black isn’t always
the best choice. Sometimes a complementary color
works better or picking up a color from within the
image works both as contrast and as a way of drawing the eye to that same color within the picture.
Contrast in design doesn’t necessarily equate to opposition. If you lay a white object on a white background, the shadows contrast with the object and so
define its form.
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Finding a Theme
by Barbara Coultry

color, then style. By shifting the pictures’
positions, your thoughts also shift. There’s
that crooked old door with peeling paint
next to the state capitol’s massive doors.
What if the show begins with that arthritic
door, progresses through ever-fancier
doors, and then finally reaches the ornate
capitol beauties? And what if the show
ends with those beautiful doors dissolving down into the old, decrepit door?
You’ve created a metaphor for life’s stages
and you’ve got your show.

To explain how to find a theme, it’s easier to
use examples...
(1) You have a heap of family photos going back an entire century, and you want
to build a show from those pictures. For
this hypothetical family, it’s your family
knowledge that grows the theme. If, for
instance, the earliest ones in this country
were immigrants, you could focus on the
hardships of leaving kith and kin behind
in search of a better life, perhaps adding
photos of the town they left and then of
the port or train station where they began
their journey, doing the same for the end
of that journey. Then again, you could focus on style of dress down through the
years, or if you have a lot of wedding portraits, you might concentrate on marriage.
Whatever you choose as the subtext for the
show, this will be the glue that holds it all
together.

(3) Travel shows always threaten to be
deadly. It takes a bit of devilish plotting to
deal with photographs from State WhoopDe-Doo Park. Once again, you start shuffling and talking to yourself, this time questioning why you took this picture or that
one. While looking for similarities, you
notice how you kept dipping the camera
down toward flowers. Mixed in was periodic hocus-pocus with focus in an effort
to grab animal portraits. What if, you ask
yourself, the flowers are matched up with
the animals? What if the flowers are
dreaming of animals? It’s kind of nutty,
but it might work as a theme: the connection between wildlife and its environment.

(2) Shows about inanimate objects can be
tough because we humans are more interested in things that move, or at the very
least, breathe. So for the heck of it, let’s
look at doors:
You love doors. You have hundreds of
door pictures, but who, besides you, of
course, is interested in doors? Explain to
yourself what you like about doors. Is it a
philosophical notion about life’s doorways? Or maybe it’s the concept of concealing and revealing. Neither rings a bell.

These have been examples of shows you will
never do, but the methods for finding a theme are in
the descriptions. Here’s the short version plus a
couple of extra ideas thrown in:

You try a different tactic, shuffling the pictures, pairing them according to shape, then
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Use free association, letting your mind
wander where it will.



Ask yourself why you took these pictures
and not others.



Look in the dictionary for definitions of
your subject matter. It can spark an idea.



Shuffle the photos and reshuffle them,
watching for similarities.



Think of your photographic subjects as
symbols of something else.



If all else fails, pick the music. Music can
sometimes bring in a theme where none
existed before.
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Commercial Mining
by Barbara Coultry

and essentially do all the things that life
in motion can do plus a few things life
can’t do. TV ads are a huge resource for
such ideas.

When the commercials arrive and everyone
moseys on out to the kitchen or bathroom, keep your
seat. In as little as fifteen seconds, an ad must present
a product, tell you why you need that product, and
convince you to buy it. Just fifteen seconds. If a big
corporation produces it, the ad might run for an eternity of thirty seconds. It’s amazing just how much
information and allure can be packed into a half
minute or less.
Ads go for high impact, but because you have
the luxury of time, you need not (nor should you)
try for high impact in every slide. Often enough, it
can be one image, one style of motion, one caption,
or a simple geometric in a commercial that will set
you off in a new direction or supply the missing link
in a show you’re working on.
Beyond bright ideas are the lessons we can
learn from the talented people who create television
commercials.
Paying attention to specifics:

• Colored text isn’t the rule. Black or
white is. Therefore, watch when color is
used. Decide whether or not you like it,
and then figure out why. Green captions
might say it’s an eco-friendly product, but
what does it say about a mattress? When
the text is black or white, consider why
one was chosen over the other. Sometimes
it’s just a matter of contrasting with the
background, but it isn’t always. White signifies purity, airiness, and maybe even elegance. Black is bolder, more down-toearth. Analyze the color choices, learn
from them, and bring this knowledge back
to slide show production.
• The shape of a letter speaks. Commercials use fonts to further the message. The
big sale at a local car dealer requires large,
bold, sans-serif lettering; the ad for a group
of lawyers will use a font that speaks of
reliability, strength, and stability; and the
commercial touting expensive perfume
might use a light, feminine font with flourishes. Your wedding show will not use
Arial and your child’s birthday show
won’t use a formal script. Watching commercials broadens our awareness of fonts.

Captions
• We expect pictures, not text, on a
screen. It’s more difficult to read words
on a glowing screen than on a piece of
paper, and because of this, advertisers are
excellent at saying as much as they can in
as few words as possible—three words
instead of six, one word instead of two.
Because our situation is similar, it pays to
watch commercials, studying how they
manage to say so much with so few words.

Pictures

• Captions are pictures, often reflecting
the entire point of a commercial. Words
climb stairs, drip from bottles, lie down,

We aren’t all professional photographers, but
we can educate ourselves on how to present pictures by watching commercials.
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• Applied effects are a constant. It isn’t
true that every picture is supposed to be
tack sharp. In thirty seconds or less, commercials want to convince you that a lotion will make you look twenty years
younger, that a car is powerful and fast,
or that a specific liqueur leads to romantic, moonlit nights. We read pictures on
an emotional level. If an image is lightened to a tint, it can indicate delicate
youth. If a “wind” effect is added, we have
a sense of speed. If a spotlight effect is
applied, a boring evening scene becomes
an intimate moonlit evening.

backgrounds. It’s the default, after all, and it does
provide the necessary depth and high contrast, but
is it always the best choice? Watch how backgrounds
are used in commercials: color, pattern, image, and
motion.

Sound
• Music is as vital in commercials as it is
in slide shows. Listen and watch, analyzing the reasons for the music chosen. Like
text and pictures, music speaks, and in a
commercial, it speaks in under a minute.
We’re now hearing a lot popular music,
particularly in car commercials. If it’s
music with vocals, you can bet those lyrics are vital; if it’s an instrumental, then
it’s the aura of the music. Where and why
is hard rock used? Romantic vocals?
Single instruments versus whole orchestras? The music isn’t chosen because it’s
Joe Executive’s favorite; it’s chosen because it enhances the image of a product.
We use music for the same reason, though
our product is a story or a theme.

• Framed pictures are often used in commercials, though you might not at first recognize them as frames. Watch for static
or moving lines, drop shadows that work
as a dark border, scrollwork, color
swatches in the background, and text designed as a framework.
• Motion in commercials isn’t always
done with a video camera. Some of the
ads are actually slideshows, and when they
are, watch every last detail of motion and
you’ll see there’s more to it than panning,
zooming, and rotating. Not only will colors change, but so will depth and opacity.
When it’s the kind of motion we’re used
to—pan, zoom, and rotation—watch for
speed, angle, and the mix of motion and
other effects.

• The part of the song chosen follows
the same logic as above, but it gets right
down into the details of which verse best
matches the product or which part of the
instrumental has the highest impact or best
reflects the aura of the product. Studying
this can give a deeper understanding of
music selection.

• Positioning of photos in commercials
might be an eye-opener. After a while,
you’ll notice that the photo isn’t necessarily centered. Watch for the amount of
space allotted to a photo. A small picture
sitting alone on a field of white snaps us
to attention, but that same picture in a row
of photos might never be noticed.

• Making fifteen seconds feel complete
requires a good ear along with sound-editing software. What you’ll notice when
parts of known songs are used is that the
fade-out isn’t used. Trailing off sounds
incomplete. Studying the parts of songs
chosen furthers your sense of how the
heart of a song can be made to sound as if
that’s all there ever was.

Background

• Voice-over is an art form, and if you
intend to use it in your slide shows, there’s

We start out slideshow life using black

12

no better place to learn than from the masters. Listening to the spoken word without seeing the speaker means that the normal visual cues are absent—no raised eyebrows, no little smiles, no hand gestures.
Pay attention to inflection, emphasis, timing, pronunciation, pattern, and tonal

quality. Imitate what you hear. Practice
by recording short stretches as you read
from books, newspapers, and magazines.
Listen to yourself and compare what
you’re hearing with the voice-over experts
used in commercials. Unless you were
born with a natural gift for animated
speech, it’ll take practice.
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Taking Photos with Shows in Mind
by Barbara Coultry

Volume

Stop trying to impress everyone, including
yourself, and take pictures as if you were a child.

No matter where you take your camera,
whether it’s for a walk down the street or to China,
fill those memory cards. If you think a professional
photographer takes all the right photos, not a clinker in the bunch, then think again. Would you
proudly display your clinkers?
Take photos of everything, not just what you
think the subject is supposed to be. On that walk,
take a picture of your foot, a blade of grass, the neighbor walking in his door, the long view of the street
and the short view, a car with a flat tire. A walk
isn’t just one step after another; it’s an entire experience involving the things you see even when you
don’t know you’re seeing them. Use your camera to
comment on them. Pay attention to yourself and to
what’s around you.

Story
This isn’t the same kind of story as what you
find in a novel or biography. It’s used for lack of a
better term. You want a progression in your show, a
feeling that an idea is expressed with a sense of beginning, middle, and end. It doesn’t have to be a big
idea, and anyway, how many big ideas would fit
into a slideshow?
For instance, Uncle Joe invited you and the rest
of your oddball family to a backyard barbecue.
You’d rather clean the bathroom than go, but you
just can’t get out of this one, so you take your camera with the thought that at least you’ll have something to do other than listen to Aunt Henrietta go on
at length about her bursitis. Is there a story here?
No? What about the food? Can you capture preparations in the kitchen? Can your camera watch salads being arranged on the plastic tablecloth? Are
hamburgers smoking on the grill? Can you see Rover
wagging and waiting for food to drop from the sky?
How about sticky kid fingers? How about…? In any
case, you can collect enough photos to tell the story
of Uncle Joe’s barbecue, and it’s likely to be a funny
story.
Slideshows are waiting for you wherever you
go, even in annoying situations. Bring your camera
and keep your sense of humor.

Loosen up
Composition is important, but sometimes for
a slideshow, variety may be more so. Stop thinking
about what makes a good picture according to all
the rules. There’s a lot more than classic composition, tack-sharp focus, and white balance. Think
about the what-if’s. “What if I sit on the ground and
shoot upward?” “What if I go behind, not in front
of, that building?” “What if I take lots of pictures of
blurry motion?” “What if I photograph the spaces
between stuff instead of the stuff itself?” “What
if…?”
Go back to your childhood. Wasn’t it a time
when the world constantly amazed you? Let it amaze
you again, all the way from that funny-shaped cloud
over there between the hills down to the ant on a
daisy. Watch people as if you were a kid puzzled by
all those really strange grownups.

Theme
This is different from “story.” The theme of a
show isn’t about who did what and when; it’s more
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the glue that holds a show together. It’s the thought
behind the story, and in terms of a slideshow, it can
be as complicated as the idea of the devotion between two people married for half a century or as
simple as the color red.
Going back to Uncle Joe’s awful barbecue, the
story is about the food, but what’s the theme? That’s
up to you, of course, but if you focus more on the
food that gets dropped or left sitting on paper plates,
if you point your camera at the inevitable garbage
produced at such an affair, your theme might be
wastefulness.
You don’t have to have a theme, but when it
shows up, run with it. It can make a truly good
slideshow into a memorable one.

load the free IrfanView. You’ll need something like
this to do proper weeding.
Looking at pictures in large groups, patterns
tend to emerge, and with patterns come slideshows.
If you’d been looking at your pictures merely one
by one, would you have noticed that thirty of them
happen to be of workers behind the scenes or of lovers both young and old? Two sets, two slideshows.
Once you have a set, make sure you aren’t duplicating a scene unless there’s good reason. If you
decide to include both pictures because they’re both
good photos—don’t. You’re immediately introducing the boredom factor into a show. Choose just one
and be done with it.
Here’s something to watch out for: the beautiful photograph, the one where you did absolutely
everything right, what you might call “the little darling.” It doesn’t matter how perfectly beautiful that
picture is. If it doesn’t fit the story or the theme,
save it for another show.

Weeding the Picture Garden
You’ve gone to a carnival, and you’ve remembered to take pictures of absolutely everything, no
holds barred. You load all 300 shots onto your computer, and you trash the junk photos right away, but
you’re still left holding a bag of 200 photos. You
can’t use every last blasted one of them in a show.
If you don’t have viewing software for seeing
multiple photos simultaneously on the screen, down-

Conclusion
Think about everything you see, keep your
camera busy, be a child, think weird thoughts, and
laugh.
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Continuity in Grouped Photos
by Barbara Coultry

When placed one after another, photographs
become parts in a larger composition where unforeseen problems can develop in their relationships with
one other.

show. You can fix this in your image editor, or in
ProShow, you can use a frame over the three photos, which allows you to adjust the photos so their
horizon lines match. If you don’t want an obvious
frame, hide it by making it match the background.

Horizon Lines
Exposure
Let’s say you’ve vacationed at the shore where
you’ve taken a three-picture set: one with your child
standing at the edge of the water, one standing kneedeep, and one turned back toward you and waving.
Unless you were using a tripod, slight alterations in
your position will change where sea meets the sky.
Viewed one after the other, the horizon line makes
small, distracting jumps, which will, in turn, take
attention away from your child and maybe even the

Variations in exposure can happen because of
nothing greater than a cloud briefly covering the sun.
Though this is a fix-up best done in an image editor, it’s possible to use the Edit Options screen to
make slight alterations. Once the exposure is the
same in all the photos in a group, there won’t be a
feeling that something is slightly “off.”
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A Few Camera Tricks
by Barbara Coultry

There’s nothing new here unless it’s new to you:

petroleum jelly. The amount you smear on should
be very slight—often, no more than a dot of it will
do. Rubbing with your finger, create streaks, circles,
waves, starbursts, etc. in the jelly. Hold the glass—
smeared side away—against the rim of the camera
lens, and while looking through the viewfinder,
watch how the jelly makes the light streak across
the scene. Move the glass until you like what you
see and then take the picture. You can leave a very
small area clear somewhere near the center of the
glass so that your subject is in sharp focus.

Stationary Object Appears in Motion
If your camera is an SLR, place it on a tripod,
use exposure compensation to underexpose, and start
with a slow shutter speed of 2 or 3 seconds. Focus
on the subject, and when the shutter opens, hold for
a heartbeat and then zoom the lens in or out. You’ll
end up with lines radiating outward from the subject. If it’s overexposed and you’ve maxed out your
exposure compensation, a neutral density filter can
help alleviate the problem. This little maneuver takes
practice getting the zoom correct along with exposure and shutter speed, but it’s worth the effort for
that single surprising photograph. A variation on this
effect is to pan the camera horizontally or vertically
instead of zooming.

Falling Leaves
Prop a whistle-clean piece of window glass between bricks, books, or whatever else will hold it in
an upright position. Using anything sticky that comes
to hand (a glue stick, Scotch tape, glycerin, etc.),
adhere a leaf or two or even three to the glass. Using your smallest aperture, photograph a scene
through the glass. The small aperture is for creating
as large a depth of field as possible so the leaves
aren’t completely blurred. You can also focus fully
on the leaves, allowing the background scene to go
out of focus. Variations are created by using items
other than leaves. You can create surreal scenes by
cutting out objects or people from photos in magazines or catalogs and sticking them to the glass.

Vignette
Cut a small shape in black construction paper
and hold the paper in front of the lens, framing the
scene with the hole in the paper. The closer to the
lens you hold the paper, the softer the edges will be,
and the vignette will be wider. These shapes need
be no larger than an inch or so, and they can be quite
a bit smaller. Experimentation is needed since camera lens diameters vary. The shape can be anything
you choose such as a circle, square, diamond, heart,
cross, or irregular shape. Let imagination guide you.

Soft Photo
This is possibly the oldest trick in the book,
and it requires nothing more than a scrap of nylon
stocking, preferably black. Stretch the stocking over
your lens and secure it with a rubber band. It will
soften the image like many professional portraits,

Dreamy Light
Smear a plain piece of thin window glass with
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particularly of women, because it softens flaws in
the complexion. The reason for black stocking material, not beige, is that beige is likely to reflect and
bounce light, which can cause splotches of light in
your photo.

second picture of the doorway with someone standing in it. In ProShow, put the empty doorway in the
first slide and the filled doorway in the second.
Cross-fade from the first picture into the second.
The longer the transition, the longer it takes for the
person to come into full view. To turn the person
into a ghost, have both pictures as layers in the second slide, the top layer being the one with the person in it. Lower the opacity of this layer so that even
after this slide has transitioned in fully, the person
appears translucent. Of course, this is just an example. Let your imagination fly.

Double Exposure (slide-show style)
This is best described by using an example.
With the camera on a tripod, take a picture of an
open doorway. Without moving the camera, take a
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Stock Photos, Your Own
by Barbara Coultry

How often do you scour the Internet for photos of items you’d never think to take a picture of?
How many items are all around you that might work
their way into your shows if only you had the pictures handy?
Take your own stock photographs. Do them as
if you were photographing rare beauties—lighting,
exposure, and composition all top-notch. Don’t forget that your scanner is also at your beck and call.
Try to have nothing blocking your subject so

Texture

that if you want, you can extract it for use on a transparent layer. If you know you’re likely to want to
extract the subject, use a contrasting color beneath
and behind the subject to make extraction easier.
For small objects, have poster board handy in a small
selection of bright colors plus black and white. Curve
the board so it forms a seamless backdrop.
What follows isn’t a complete list, but it should
give you some ideas for your own stock photos.

Plants

Landscape

Workshop

Cloth
Fur
Leather
Sand
Stone
Wood

Flower
Fruit
Leaf
Moss
Mushroom
Tree
Vegetable

Beach
Cliff
Moon
Sky
Snow
Water
Woods

Drill
Hammer
Saw
Utility Knife
Vise

Art

Gardening

Music

People

Canvas
Crayon
Easel
Paint Tube
Paint Brush
Palette

Clay Pot
Clippers
Hoe
Rake
Seed Packet
Trowel
Watering Can

Instruments
Microphone
Music Stand
Sheet Music

Bikers
Crowd
Farmer
Firemen
Police
Worker, any kind
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Party
Balloon
Blank invitation
Champagne glass
Confetti
Ornament
Streamer

Sports

Time

Ball
Bat
Boxing glove
Canoe
Karate belt
Off-road-bike
Racket
Skateboard

Clock
Hourglass
Pendulum
Sundial
Watch

Children
Bib
Chalk on sidewalk
High chair
Mobile
Playground
Stroller
Toy
`

Vehicles
Bootie
Child’s art
Kite
Pacifier
Rattle
Stuffed animal

Boat
Bus
Car
Tractor
Train
Truck
Wagon
Plane

Miscellaneous
Basket
Book
Candle
Coffee Cup
Cross

Eyeglasses
Flag
Hand
Hat
Heart

Mask
Park Bench
Pearl
Pen/Pencil
Pin Cushion
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Door
Kitchen Items
Road Sign
Stairway

Frame Settings & Image Size

of pictures remain inside the safe zone. Important
parts include captions—make sure you keep them
inside the safe zone.

Fit to Frame—fills the frame fully either horizontally or vertically while maintaining the aspect
ratio of the slide. You may have black bars top/bottom or sides.
Fill Frame—fills the frame both horizontally
and vertically while maintaining the aspect ratio of
the slide, but cropping may (and is likely to) occur
to maintain that ratio.
Stretch to Frame—fills the frame by stretching the picture if necessary, which can and often
does involve image distortion. Best used only for
backgrounds and geometrics where distortion will
not adversely affect it.
Fit to Safe Zone—the same as Fit to Frame,
but in this case, it’s fitting the image to the smaller
Safe Zone area.
Fill Safe Zone—the same as Fill Frame, but
in this case, it’s filling just the Safe Zone.
Change all slides from “Fit to Frame” to “Fit
to Safe Zone”—Right-click on the first slide and
choose Select All, then right-click on the first slide
again and choose Scale Image > Fit to Safe Zone.
All slides will be changed.
Image size: To maintain quality of photos for
any output option, use uncompressed files (such as
PSD and TIF), downsizing them in an image editor.
Several recommendations for exact size exist, but
one that seems to work well is 1280 x <height> or
<width> x 1280. If using Photoshop, resize using
the bi-cubic method.
Zooming: If you plan to zoom in on an image—say to 300%—the image size you use should
be a minimum of 3 times the output resolution. If,
for instance, you’re outputting to DVD and the resolution is 720x480, multiply that resolution by three.

Add Border & Drop Shadow to All
Photos
1. In Slide Options put a check mark in
the boxes for drop shadow and borders.
2. Right-click on each of the boxes and
you will see the option to “copy to all
slides” or “copy to selected slides.”

Change Background Color for Selected
Slides
1. Click to select the slides while holding
the Ctrl key.
2. Right-click to open Slide Options >
Background. (Right-click required to preserve selections.)
3. Choose the background color you want.
4. Right-click on the option to override the
default and choose Apply to Selected
Slides.
5. Right-click on the color you selected,
and again, choose Apply to Selected
Slides.

Fill TV Screen
B&W into Color Without a Mask

You’ll get a black framework around your show
on the TV screen when you use Fit to Safe Zone,
but if you use Fit to Frame, making sure only nonessential parts of a picture spill past the safe zone,
you can reduce the black areas or even get rid of
them altogether. Just make sure the important parts

1. Set up two slides next to each other with
the same image in each. For the first slide,
set it to Colorize, which will turn it to b&w.
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3. Between the two slides, use a very slow
fade, or try one of the wipes such as a
paintbrush or radar.

turn it into an image file to gain the ability to use
certain effects not available to captions. Another use
is to turn the text into a mask.

Create Clouds (Photoshop®)

Vignettes
1. On the “Editing” screen, select the layer
you want vignetted.

1. Create a plain white background.

2. Check the box next to Vignette

2. Set foreground and background colors—typically a shade of gray and a shade
of blue.

3. Click “Configure”

3. Apply Filter > Render > Clouds.

4. Select a Shape and Type for the Vignette. The checkerboard behind the image shows the area that will be transparent when the vignette is applied.

4. Apply the filter repeatedly (Ctrl-F) to
get variations.
5. You can also transform the width for
distortion.

5. Adjust the Size, Border Size and Corner Size.

6. Duplicate the background layer.
6. For right-angle corners, check Fill Corners. For a solid, picture-frame border,
check Solid Borders.

7. Delete the original background layer.
8. Feather the lower edge to transparent
for a better composite in Proshow.

7. If you are using Solid Color or Gradient as the vignette type, set the colors and
options for those features.

Use an Animated GIF (Photoshop®)
1. Open the GIF in Photoshop.

Capture the Preview Screen

2. Open the layer palette where you’ll see
that the motion has been broken up into
layers.

When previewing a show full-screen, rightclick and choose “Capture frame(s).” You can save
a single frame or a series of them as JPG’s. If you
prefer an uncompressed format, press the Print
Screen key to capture the current screen to the Clipboard. Use your image editor to create a new document, and then press Ctrl+V to insert the image in
the new document. Edit the image as you like, and
then save it in the format of your choice.
One of the uses for this is to capture text and

3. Save the layers as separate files using
Scripts > Export Layers to Files.
4. Resave these files in PNG format if you
wish.
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Slightly Fancier (edge in black)

5. In ProShow, place each PNG in order
of its movement and in its own slide, using a Cut transition between slides.

1. Do steps 1 through 4 above, and then
invert the selection.

6. On average, each slide should last about
.5 seconds, though you may have to adjust this depending on the action.

2. Fill the outside space with black.
3. Invert the selection so it’s once again
surrounding just the bubble.

Because each image has a transparent background, you can layer the images on top of any background or picture.

4. Increase the size of the selection by
small increments—1 pixel at a time—until you can see that a small amount of the
surrounding black is included in the selection.

Talk Bubbles (Photoshop®)
Basic

5. Invert the selection and delete the black.

1. Create a new document approximately
300 x 300 pixels with a transparent background.

6. De-select and save.
7. Flip the image horizontally so the
pointer is on the other side, and save this
as a separate file.

2. Make an oval selection and fill it with
white.
3. Being sure you use an add-to selection
tool, create a triangle selection at the bottom either toward the right or the left and
that’s connected to the previous selection.
This will be the pointer.

Really Fancy
1. Complete steps 1 through 5 in “Slightly
Fancier.”
2. De-select, and then apply both an inner
bevel and a drop shadow.

4. Fill the pointer with white.
5. De-select and save.

3. Save, then flip the image horizontally
and save again as a separate file.

6. Flip the image horizontally so the
pointer is on the other side, and save this
as a separate file.

Add the bubbles as layers to the slides, inserting the captions so they fit within the bounds of the
bubble.
Because you saved two versions of the
bubble—both right and left—you can choose whichever is a better fit for the slide.
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Candle-Flame Video

This will allow looping if it becomes necessary.

(thanks to Debbie Green)
1. Use a tripod.

10. For insurance, shoot four or five instances of the video, making each 10 to
20 seconds long. This gives you the ability to choose the best.

2. Use the highest resolution you can.
3. Use either macro or manual focus.

11. If the video is longer than you need,
cut and splice it at a point where the flame
is still.

4. Use a black background that’s set far
enough behind the flame to keep it from
being lit be the flame. Black cloth, mat
board, and foam-core board are some of
the possibilities.

12. Import the clip into your video editor.
(Windows Movie Maker will work.)

5. Trim the top of the candle so it tapers
toward the wick.

13. Mute the audio when editing. To do
this in Windows Movie Maker, choose
Clip > Audio > Mute.

6. Have just the flame in the frame, keeping the wax candle beneath out of the picture.

14. Save the file and insert it into your
show.

7. A good-sized wick, perhaps a half-inch,
produces a healthy-sized flame.

15. If necessary, play with the chromakey feature in Producer to remove the
background and the possibility of an ugly
blue line (Key Color Black, Intensity
Threshold 33%, Intensity Drop Off 20%),
and set the opacity to 85% so it doesn’t
look cartoonish when layered on the top
of a candle.

8. Occasionally fan the flame very gently
with a piece of cardboard to create movement.
9. Start the video while the candle is still
and end shooting with it still once more.
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Section III
Sound
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ProShow Sound Tutorial
by K. E. Hockenberry

Inserting music into your video slide show will
transform a seemingly ordinary show into something
awe-inspiring. In every instance, choosing the correct song can evoke feelings of laughter, love, romance, loneliness, sadness, or even spiritual awakening. You already know from watching movies just
how important music is in interpreting what you’re
seeing on the screen. It’s just as important to have
the right music for your video slide show.

there are five buttons: Add, Del, Play, Up, and Down
(see Figure 02).
The first button adds music to the soundtrack.
You can insert as many songs as you like by clicking
the add button and then browsing to where you store
music on your computer or CD.
To delete a song, select it, then click the second
button, which is the delete button.
The third button will play or preview the song,
but only after you’ve added it to the tracks window.
Use the fourth and fifth buttons when you have
Inserting Music
inserted more than one song into the tracks window.
When clicked, they will move a selected song up or
Double-click on the “Soundtrack” located at the down, changing the selected song’s position from,
bottom of the screen below the slide time-line. The say, first to second place, or from second to first
Show Soundtrack window will open, and in it are place, depending on which button you click.
various settings and adjustments (see Figure 01).
You can also open the show’s soundtrack window by clicking the music icon located in the tool Adding a Song from Your Computer
bar at the top of the main screen.
For those who like keyboard shortcuts, press
ProShow will only allow you to insert .MP3,
Ctrl+F4.
.OGG and .WAV file extensions into your show.
In the large window to the left marked “Tracks,”

Figure 01.

Figure 02.
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Note: MP3 is the file extension given to audio
files usually ripped from CD‘s. WAV is the extension for files in Microsoft’s audio file format. The
term ‘OGG’ is commonly used to refer to an audio
file format that is Vorbis-encoded audio in the OGG
container.
Note: Uncompressed .WAV files are quite
large. If possible, use MP3 or OGG files, which are
compressed.
Click on the Add button, and then click on
“Add Sound File.” A window will pop up allowing
you to browse for music on your computer. Select
the song you want to use, and then click the Open
button (see Figure 03).
You can click the Play button to preview the
song. A song preview window will appear and your
selected song will begin playing. Click the Close
button and the song preview box will close (see Figure 04).

At this point, the song will load into the “sound
track” at the bottom of ProShow’s main screen.
If you want to add another song to the sound
track, click the add button again and follow the same
procedure previously outlined.
Notice that there are more choices in the “Show
Soundtrack” window such as Master Volume, Defaults for Other Sounds, and Soundtrack during
Other Sounds. When you use more than one song,
ProShow gives you control of the time between song
tracks. ProShow has an internal music editor, but it
also allows you to use an external music editor.
Usually, nothing else needs adjusting. The volume levels are pretty much set to the correct levels.
Click the “Done” button (see Figure 05).
At this point, the selected song will appear in
the soundtrack (see Figure 06).

Figure 03.

Figure 05.

Figure 04.

Figure 06.
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Adding a Song from a CD

CD Audio Track”.
Now, browse to where you store your music
and click the “Save” button.
If you’ve chosen to add the song to your show,
the song will appear in the soundtrack at the bottom
of the screen (see Figure 08).

You can add music from a CD from within
ProShow. It uses the terms “Save Audio Track” to
pull music from a CD, but you might call this process “ripping”.
To save a song from a CD, insert a music CD
into your CD-ROM, and then click on the “Audio”
tab in the upper tool bar and choose “Save Music
from CD.” The “Save Audio Track” window will
open (see Figure 07). If you have more than one
drive on your computer, you may need to use the
drop-down box to select the drive that holds the CD.

Syncing to a Single Music Track
Synchronizing to a single music track is what
you’ll be doing in a majority of your shows.
To synchronize all the slides to one track, go
to “Audio” in the menu bar located at the top of the
screen.

Figure 07.

Figure 08.

Place a checkmark in the box next to “Retrieve
artist/track info from the Internet.” This will add
the CD’s info such as time, artist, album, and song
title to all the songs on the CD.
Select a song you want to “rip” from the CD
by clicking on the song to highlight it. You can select only one song at a time.
If you want to add the song to your show, place
a checkmark in the box next to “Add to Soundtrack”
located in the lower left-hand corner of the “Save
Audio Track” box.
Next, choose the format in which you want to
save the song. You can choose the popular MP3 or
.OGG by checking the box labeled “Format”.
The last button to click is the “Save Track”
button. This will open up another box called “Save

Select “Sync Show to Audio” (or press Alt+Y),
and ProShow will automatically divide all the slides
and transitions into equal amounts of time. As a
result, the length of your show will match the length
of the music.

Syncing to Multiple Tracks
You can also synchronize your show to multiple tracks. First, select and insert an additional
song into the soundtrack. Follow the “inserting a
song” instructions outlined earlier. In the soundtrack,
the first song’s waveform is colored green, and
the second is blue (see Figure 09).

29

Next, double-click on the soundtrack to bring
up the “Show Soundtrack” window. On the righthand side is a box titled “Offset from previous track.”
If you want a time separation between the two tracks,
enter that amount here (see Figure 10).
Select all the slides you’d like to synchronize
with the first music track.
To choose multiple slides, click on the first
slide, and then while holding down the shift key,
click on the last slide to be synced to the track.
All the selected slides will turn dark gray (see
Figure 11).

Next, click on “Audio” in the menu bar located
at the top of the screen and choose “Sync Selected
Slides to Track” (see Figure 12).
The “Sync Slides to Track” box will open with
a list of all the music tracks in your show.
Choose the track you want to use and then click
the “Sync” button (see Figure 13).
Follow the same procedure to synchronize the
second sound track.
You’ll see that the music tracks and slides are
now in sync.

Figure 09.

Figure 10.
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Figure 11.

Figure 12.

Figure 13.
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Basic Music Editing with Audacity
by K. E. Hockenberry

A third-party music editor is necessary because,
at some point, you’ll want to do something unique
to a music track.
We’ll be using Audacity (a free audio editor
and recorder) to show the basics of editing any music track for use in ProShow. You can download
Audacity at http://audacity.sourceforge.net/
You will also need to download and place a
“LAME” MP3 encoder in the audacity folder so you
can export your songs as MP3’s. Follow the install
instructions on the Audacity website.

The flat lines at both ends indicate unwanted
silence (see Figure 03).
Place your cursor at the beginning of the song.
You’ll know you are at the beginning when the cursor changes from an arrow to an “I” bar. Next, hold
the left mouse button while dragging across to where
you want to trim your song. Release the mouse button (see Figure 04).

Editing the Ends
Often, the beginnings and the endings of songs
are extended three or four seconds of silence, which
can cause timing problems.
First, load a music track into Audacity by clicking on “File” in the menu bar (see Figure 01).

Figure 02.

Figure 03.

Figure 01.

Next, click “Open,” browse to the song you
want to edit, and click on it to open it in Audacity’s
work area, which will display the waveforms of both
the left and right channels of a stereo song (see Figure 02).

Figure 04.
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Fading Out Your Song

Now, this is the easy part: press the delete key.
You’ve just trimmed the beginning of the song (see
Figure 05).

Many songs are already already include a slight
fade-out, but suppose you wanted to play just the
first verse of the song during your show. You need
to fade it out so it doesn’t end abruptly.
The procedure for fading out a song is in part
the same as trimming a song. First, highlight the
unwanted portion of your song by holding down the
left mouse button and dragging close to the section
of the song you want to fade out (see Figure 07).

Figure 05.

Follow the same procedure when trimming the
song’s ending (see Figure 06).

Figure 07.

Then hit the delete button (see Figure 08).

Figure 06.

Save the song by clicking on “File” in the menu
bar, and then click on “Export as MP3.” If you prefer, you can export your song as a .WAV or .OGG
file instead.
Next, a “Save As” window appears that will
allow you to either keep the current file name or to
rename it.
After saving the song, an “Edit ID3” window
will appear that allows you to edit the song’s information details. Click the “OK” button and save the
edited file to your hard drive.

Figure 08.

Next, highlight the section you want to fade
out. While holding the left mouse button, drag
across the waveform to highlight the section to fade
out (see Figure 09).
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Fading out a song can be a lot of trail and error,
so be patient. Use the undo feature located in the
“Edit” tab (or Ctrl+Z) to revert to the previous state
if necessary. You can use the undo feature as many
times as needed.

Fading In Your Song
Fading in a song is identical to fading out a song.
Highlight the section you want to fade in, and then
choose “Fade In” located in the “Effect” menu (see
Figure 12).

Figure 09.

Choose the “Effect” menu, and then “Fade Out.”
(See Figure 10.)
Notice the song’s ending is now faded out (See
Figure 11.).

Figure 12.

Cross Fading
The art of splicing two songs together is called
cross fading. In other words, the end of one song is
merged into the beginning of the second song.
Load up two songs. Go to “Project” and then
to “Import Audio.” (Shortcut is Ctrl+I)
Next, click on the “Time Shift Tool” located in
the top left corner of the tool bar (see Figure 13).

Figure 10.

Figure 11.

Figure 13.
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The time shift tool allows you to move a waveform to the left or right.
If you were to preview it as the waveform appears now, you would hear both songs simultaneously.
Use the time shift tool to move the bottom song
to the right until it overlaps the top song’s ending.
To make it easier to work with, move the top
song to the left, and then move the bottom song to
the right, overlapping the two songs (see Figure 14).

Using click-and-drag with the mouse and starting with the top song, highlight the ending portion
that you want to cross fade.
Next, since this is the ending of the song, you’ll
want to cross fade out the song. Click “Effect” on
the menu bar and then on “Cross Fade Out.” (See
Figure 15.)
Since this is the beginning of the song, you’ll
want to cross fade in the song. Highlight the beginning portion of the bottom song and then click “Effect” on the menu bar, choosing “Cross Fade In.”
(See Figure 16.)
Click the play icon to test how well you’ve
cross faded your songs.
You may not like your first, second, or even
your third attempt to cross fade two songs together.
This is a true trail-and-error process.
To render your cross-faded song, export it as
an MP3. Both songs will merge into one during the
export process. Remember to save your song with
an appropriate title, reflecting the new version of
the song.

Figure 14.

Figure 15.

Figure 16.
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Fixing Audio “Pop”
by Barbara Coultry and Ben Coultry

What follows is for those familiar with a sound
editor, its basic tools, and what they’re used for. You
don’t have to be a whiz kid, but basic familiarity is
necessary. The terms we’re using aren’t specific to
any particular editor; they’re standard terms, and all
serious editors will use the same names for the same
processes.
It helps if you have a good ear for music, but
understand that this isn’t something you have to be
born with. You can teach yourself to listen for
rhythm and the way instruments (including voice)
work with one another by playing the music in your
sound editor, quite literally watching the music as
you listen to it.

Fix “pop”: While listening to the music, watch
the bar as it moves across the waveform. When the
popping sound occurs, mark the spot. (See Figure
01.)
Zoom in on the waveform until the spike that
indicates the pop is relatively huge. (See Figure 02.)
Select from the exact beginning of the spike to
the exact end of it, and then delete it. It may not be
completely evident in the illustration below, but the
beginning and end of the selection were positioned
so that, when the pop was deleted, the parts on either side of it came together so the lines met. (See
Figure 03.)

Figure 02.

Figure 01.

Figure 03.
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Below is an illustration of doing it the wrong
way and the right way: (See Figure 04.)
Next, zoom out just a little so you can play the
section where you deleted the pop, listening care-

fully as the bar passes through where the spike had
been. It’s possible for it to still sound a little rough.
If it does, select only the rough spot and try reducing
the amplitude slightly. Often, it’ll require less than
even 3 decibels.

Figure 04.
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Create a Loop for Your Menu
by Barbara Coultry & Ben Coultry

Because a custom-designed loop is taken directly from the music in your show, you end up with
menu music that matches perfectly.
This isn’t for the complete beginner, but it also
doesn’t require a doctorate. If you’ve been editing
sound for a while and you know your way around
the basic parts of your sound editor, give looping a
try.
Make sure to save the original song to a new
name so no harm is done, and then play like mad. If
you end up without a loop, you’ve lost nothing but a
bit of time, and in spite of the seeming failure, you
will have become more alert to the kind of music
that lends itself to looping. Next time, you’ll do better.
If you’ve ever gotten a melody stuck in your
head (oh, the misery!), you’ll know that it doesn’t
always begin its wretched existence at the true beginning of the song, but it does start at a place that
sounds like a beginning. Usually, a stuck-in-the-head
song ends a short time later at a perfectly legitimate
ending place. That, my friends, is a loop. You’ve
been spontaneously creating loops for years.
Creating a loop requires that you train yourself
to listen very closely:
• Notice distinct patterns such as versechorus-verse-chorus or any repeated sections.
• Focus on the rhythm, whether it’s being spelled out by drums, bass guitar, or
any other instrument. Tap your foot, nod
your head, make audible sounds, or whatever else helps you pick out the beat.
• Keep alert for short sections that could
be tiny songs all on their own.
• Separate out the instruments, paying attention to just one, then another, and still
another.
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The quick method: Find a 15- to 30-second
section of a song that sounds complete in itself. The
most obvious spot is the chorus, but not all songs
have a chorus. In your sound editor, select this section, saving it as a separate file. Fade out the end and
then add a very slight fade-in to the beginning. This
is the method most often encountered on DVD collections of TV series. You’ll hear part of or even the
show’s entire theme with the aforementioned fades,
and then it’ll repeat endlessly until a sub-menu is
chosen.
Looping a sound effect: This is suitable when
a sound effect illustrates the idea of the show. For instance, if the show is about a trip to the shore, the
sound of waves during the menu might work. You’ll
still want to edit the sound clip to make it loop
seamlessly.
Not-so quick method: Begin with the song’s
waveform in front of you. Listen while also watching as the bar glides across the waveform. Listen and
watch for the patterns, getting a solid sense of the
rhythm while trying to spot telltale repetitions. Then
listen again, this time trying to pick out short sections that could be mini-songs all by themselves.
Once you locate a section that sounds right, select it, including a little extra space at the end. Below is an example where the “mini-song” was right
at the beginning. The selection’s right-hand side is
situated a little beyond what sounded like a good
end point (see Figure 01).
Invert the selection, deleting everything but the
part you want to loop. Save as a new file in .WAV
format, adding LOOP to the end of the file name.
Select all (Ctrl + A) of the waveform, and listen
to it in looping mode (usually indicated by the infinity symbol), adjusting the end position of the selection until the end blends into the beginning as perfectly as you can make it. Reverse the selection so
only the unwanted part is selected. Delete the selection.

the very last bit of sound along with the added silence (see Figure 4), finishing up by fading the selection. If the rhythm needs repair, you can use
“stretch” instead of fade.

Figure 01.

Unwanted section at end marked for deletion (see
Figure 02):

Figure 04.

Then again, it might require serious surgery
where an extra beat is needed at the tail end before
looping back to the beginning. In the illustration below, the perfect sound from another spot in the waveform was selected (see Figure 05).
Figure 02.

Listen to the music in looping mode again.
Unless you’ve an angel sitting on your shoulder, it
won’t be perfect. Timing is usually the problem, and
there are multiple cures that depend on the instruments, the style of song, and what instrument in particular is spelling out the rhythm.
Sometimes all that’s needed is to add a very
short amount of silence (see Figure 03), then select
Figure 05.

Then it was copied and pasted at the end of the
waveform. It added back in a beat that had been lost
during the cutting process. The lost beat couldn’t
be helped because including any more would have
also included a note from another instrument, and
the loop would have then ended poorly.

Figure 03.
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You have to listen in looping mode over and
over again, getting the transition from the end back
to the beginning as smooth as possible. Sometimes
it only requires lowering the volume at the very end,
sometimes it’s a matter of playing with the equalizer. It could be that the “stretch” tool will do the
trick. There’s no formula for this because it all depends on the individual piece of music. Try one thing

after another, undoing each in turn until something
works.
No rules and lots of practice: All kinds of
tools in your sound editor can help blend the end
back into the beginning. Don’t hesitate to try every
tool or effect. You can stretch a tone to keep the
rhythm, you can borrow parts from elsewhere, and
you can even lower the pitch of a note so it creates a
bridge back to the beginning. There’s no right or
wrong way. This is one of those cases where the
end justifies the means.
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Handy Audio Editing Techniques
by Barbara Coultry and Ben Coultry

Long Fade

ning of the sound with the end of the first song and
then do the same with the end of the sound and the
beginning of the second song. It’s easier to do this
in a sound editor than in ProShow because of the
ability to apply multiple effects: fade, volume
change, reverb, echo, stretch, and so forth.

Though you can create a long fade-out in
ProShow, it requires fading out sections of the song
you may not want faded out. What if, for instance,
you just want to fade the last note? In a sound editor, select that last note (it will be more than a single
peak), and then “stretch” it without changing the
pitch so it’s as if the note had been held for a good
amount of time in the original piece. Next, apply
fade to that single, stretched-out note. Depending
on how it sounds, you may want to add silence at
the end of the note before doing the fade-out. This
is something you can determine only by listening
carefully to tests done with and without the added
silence.

Shorten a Song by Cutting its End
Random amputation doesn’t work, and a fadeout can sound just like what it is: you ran out of
show before you ran out of sound. Not every song
is amenable to having its end lopped off, but if it is,
it’s likely to be because it has a place near the end
that could be the end. This requires the ability to
listen to each musical phrase while asking yourself,
“Does this sound like a natural end?” If it does, then
“slice” the song at the spot where you want to end
it, effectively creating two sound files. Slide the tobe-deleted section off to the right in case you need
it. Now listen to the spot leading up to your new
end and to the end itself. If you’re lucky, it’ll sound
natural. Often, though, it’ll require stretching and
adding a touch of reverb or echo along with a short
fade. Another trick is to grab the last note from the
section you just lopped off, adding it to the new end,
and blending it in. If you do decide to use that last
note, zoom in on it first, listening to it and watching
to see exactly where it begins. You’d be surprised
how often it begins before you think it does. Hint: a
single note is often a group of peaks and valleys.

Blend Two Songs with an Interim Sound
File
Simple cross-fades don’t always work well.
When you have songs with different tempos,
rhythms, styles, or keys, the effect can be jarring.
Create a “bridge” between the two songs by inserting a sound file and then cross-fading its two ends.
The sound file itself will depend on the slide show.
For instance, if it’s a show about the ocean, you
might insert the sound of surf, cross-fade the begin-
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Choosing Music
by Barbara Coultry
(with input from Ken Hockenberry)

Music is a form of communication, and this
means that our musical choices are vital. Watch any
movie or television show, keeping an ear to the music that’s inevitably there. What’s playing in the
background when the characters are flying a plane,
walking in the woods, or just contemplating the
moon? The music is an ongoing dialogue, telling
the story without words.
Consider this: You’ve visited Mount St.
Helens. You’ve photographed it from every angle,
trying to show the remnants of an eruption and the
rebirth of land. What do you want to say about this
volcano? That the land is beautiful? That here lies a
sleeping dragon? The music you choose will tell the
story for you. Pick a delicate, melodic piece, and
you’re emphasizing the beauty; pick a darker piece,
and you’re describing a dragon.
First, think about the show. What’s your message in it? Is it comic, happy, sentimental, thoughtful, melancholy, mysterious, majestic, peaceful,
silly, dramatic, frenetic, or any of a number of other
descriptions? You want to find the same message
in the music.
We don’t need a degree in music to understand the message in music. We’re human and we
“get it.” However, it helps to be alert to things in
music that help convey a message:
Instrument: Does anyone exist who wasn’t
exposed as a child to Prokofiev’s “Peter and the
Wolf”? In case you’re one of the few, here’s a headsup: The main characters are a bird (flute), a duck
(oboe), a cat (clarinet), the grandfather (bassoon),
the wolf (French horn), hunters (woodwind and
drum), and Peter (string). Each of these instruments
has a characteristic sound, a “flavor” that’s reminiscent of the character. Imagine using a tuba for a
bird, and you’ll understand what we mean here.
We can use this same kind of thinking by equating sound with an idea or a person. A daisy is light

and airy—piccolo?—while a lily is slightly
heavier—flute or clarinet? Mountains might prefer
a full orchestra, a child’s antics ragtime piano, a walk
along the river an acoustic guitar. If you were going
to paint a particular scene in notes rather than color,
which instrument would be your paintbrush?
Tempo: Though it’s the most obvious part of
music next to melody, tempo can still trip us up.
Our intuition usually works just fine, telling us how
slow or fast the music should be for a particular
show, but now and then a show just doesn’t “feel”
right. We may look all over for the problem with
the show, never realizing the problem is the music’s
tempo. It might have too rapid a tempo, leading us
into switching out the pictures too quickly, or it
might be the reverse where a slow tempo is forcing
the show to drag.
Rhythm: This is the pattern of stressed and
unstressed beats, and it’s one of the major qualities
that differentiate the styles of music. You aren’t
about to confuse a waltz and a blues tune even if
you don’t know any of the technicalities of what
makes one a waltz and the other the blues. How the
beats are stressed is what you want to pay attention
to, and for this very simple reason: we use stressed
beats for our transition points. You may love a particular tune, and it may seem perfect for your show,
but if the stressed beats make you cut short the duration of one picture while making another too long,
you should look for a different song.
Genre: We should never, not ever, refuse to
consider every style of music. If we do, we’re foolishly restricting ourselves. We’ve all heard statements such as that country music is whiny, heavymetal bands are noisy, classical music is complicated, and opera is quite simply beyond the pale.
Don’t believe a word of it. Country star Shania
Twain doesn’t whine. The self-described funky
metal band, Extreme, hit number one on the charts
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The problem is that we’re often listening to the
melody, humming along with it, while not paying
attention to the verses. Without meaning to, we can
inject comedy into a serious show, we can speak of
lost love in a wedding show, we can willy-nilly mismatch a song with a woman when it should be a
man, or we can find any number of better ways to
embarrass ourselves.
Searching For a Specific Subject: Go to
www.allmusic.com and type into the search box a
word that describes your show. For instance, if it’s
a birthday show, type “birthday,” or if it’s a show
about family, type “family” into the search box. A
long list of songs and albums is likely to result.
Clicking on any of the choices brings you to a sublisting with speaker icons scattered throughout, the
icons indicating that you can listen to a piece of the
song. The subject you search on can be an idea, an
emotion, a color, an object, etc.

with the incredibly sweet “More Than Words.” And
is Mendelssohn’s “Wedding March” all that complicated? Just because “Porgy and Bess” was written in English doesn’t mean it’s fake opera. Again,
drop any prejudices you have. Listen to everything.
Lyrics: Don’t ever use a song you haven’t paid
extremely close attention to. If you can’t quite understand all the words, look up the song on the
Internet. Enough sites post lyrics that you’re sure to
find the one you’re considering. A prime example
of why this is necessary comes from both my and
another member’s experience. The song was “The
First Time Ever I Saw Your Face.” I thought it would
be perfect for a wedding show, but then I paid attention to a particular verse, which turned out to be
not quite suitable for straight-laced sorts. The other
member in question used the song for a show about
a child, failing to notice that particular verse. He
ended up with very mixed reviews.
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Voice-over
by Barbara Coultry & Ben Coultry

Anyone can narrate a slide show, right? All you
need is a microphone, and you’re good to go. So
let’s start with that: the microphone.
You need a decent microphone, one that works
well with the human voice. You’ll be happy to know
that good microphones for the speaking voice are
cheap. There’s no need for an expensive contraption. Go to a place like Radio Shack and pick up a
headset microphone, either the kind designed specifically for hooking up to the computer or the kind
meant for hands-free telephone talk. These are directional microphones, which means that when
pointed at your mouth, they pick up your voice, not
the birds twittering outside the window. You may
have to buy an adaptor for the telephone mic, so
pay attention to that end of things.
There’s another reason for a headset microphone: it allows you to relax. You can turn your
head, lean back in your chair, or pull up your socks
without altering the sound at all.
Make sure the microphone isn’t right in front
of your mouth. If it is, it’ll pick up the “P pops”
which are caused by the hard little puffs of air created by pronouncing the letter P. There are also other
little mouth sounds we don’t want the mic picking
up, so if the mic has a flexible wand, bend it so the
mic is to the side of your mouth.
The real instrument in this process is, of course,
your voice.

If you answered “no” to all the above questions, you’re lying. Grab a book or magazine, pick
out a long paragraph, and then record yourself reading aloud. Play it back and then answer those questions again. Be honest.

Pattern
Listen again to your brief narration, this time
for pitch changes in your voice. Did you begin a
sentence with a mid-tone, raise the tone up as you
headed into the middle of the sentence, and then
drop back down toward the end, perhaps going to
the lowest note when you hit the period? Did you
do this consistently? That’s a pattern. It’s a song
that repeats the same four or five notes throughout,
and it can irritate the listener. You probably don’t
speak like this when talking over the fence with your
neighbor, so why are you doing it when recording?
For practice, say just the word “what” as a question, then as if you’re annoyed by an interruption,
and finally as if you’re surprised. It sounded different in each instance, didn’t it? You were using various pitches and inflections to get the point across.
In a sense, you were singing.
If you don’t have patterned speech when chatting with the neighbor, why is it there when you
read a paragraph? It’s because: (1) the paragraph
wasn’t composed of your words; and (2) you weren’t
talking to anyone. It’s also possible you were traumatized like every other school kid by being forced
to recite aloud. (May that teacher rot wherever.)
The cure: Make sure you’re all alone (no need
for people thinking you’ve gone nuts), and then
imagine someone is right there with you, the two of
you having a normal conversation. Try that paragraph again, this time pretending the words are your
very own. You’re telling your friend something, and

Do you:
• …speak in patterns?
• …swallow words at the end of sentences?
• …go without moments of silence?
• …remember to breathe?
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it’s really interesting. If this doesn’t work at first,
don’t give up. It’s not a natural thing for everyone
to do. If you’re having a lot of trouble with it, then
pretend you’re an actor in a movie bound for an
Oscar for your outstanding performance. Don’t deny
it—you had such daydreams while growing up. Say
hello to the child lurking within.
But not a complete cure: Unless you’re a total natural, the above exercise will improve your
speech a lot, but a great orator you’re not. If you
were, you wouldn’t be reading this, so here’s one
more exercise:
Repeat “First, do no harm,” each time stressing a different word. FIRST do no harm. First DO
no harm. First do NO harm. First do no HARM.
Two things are altered in each example. One is the
pattern. The other is an alteration in meaning.

Sometimes it’s just for a tick, sometimes it’s for
quite a while, and then they deliver the punchline.
Don’t use exactly the same length of pause throughout your voice-over. If you do, you’ll be creating a
pattern. So, don’t rush through your voice-over and
please don’t be afraid of silence.

Don’t Forget to Breathe
When you’re narrating, you need the breath to
carry you through an entire sentence, so take a nice,
deep breath, and then don’t spend that whole breath
during the first half of the sentence. If you spend it
too quickly, you’ll sound like Marilyn Monroe,
which was fine for Marilyn but probably not for you.
Additionally, this can lead to having to take a breath
in the middle of a sentence, creating an odd pause.

Eating Your Words
Stop Paper Rustling
This is an obvious problem and so easily remedied. Don’t lower your pitch and volume so much
at the end of each sentence that the last few words
get lost in a low mumble. You may not realize you’ve
been doing this, but you’ll spot it immediately when
you listen back to what you’ve recorded. If you have
this problem, it’ll take conscious effort to raise the
pitch a bit and to keep the volume up, but soon
enough, the proper way will become natural.

You’ll need a script, and since a script will be
on paper, the result can be paper rustlings on the
recording. To avoid this, put your script pages into
plastic page protectors. You won’t get the rustling
sound (but you may have to ad lib while you’re picking the slippery devils up off the floor).

And so…
Pause for Refreshment

You aren’t trying to be a professional voiceover actor, but this doesn’t mean you can’t improve
your narrative abilities. It takes practice and listening to yourself. It also helps to listen to others. When
watching television, listen to the professional voiceovers in commercials.

If your voice-over runs on and on, you’ll sound
like a bad poet at the microphone in a coffeehouse.
Well-placed pauses in speech can create both drama
and comedy. Comedians are masters of the pause.
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Organize Your Music
by Barbara Coultry

far faster, simpler, and more sensible for the way
we use music.

Your music folder is a wreck or it will be soon.
We’re necessarily collectors of music files, which
leads to such a mess that we can spend an hour,
maybe two, searching for just the right tune to go
with a show. We may eventually find we have nothing that will suit, and if we’d known sooner, we
wouldn’t have wasted so much time poking through
endless files.
The solution is simple-minded, and simpler
still if we do it earlier rather than later. It involves
setting up a system of folders custom-designed for
how we think and how we pick our music.
For me, the first cut is according to duration.
Why look at 5-minute songs for a 3-minute show?
Though I don’t bother with it, you may find style is
important. A standard oldie might be good for
Granny, but it’s not so hot for Bobby’s fifth birthday. Tempo is vital to me. Some shows are fastpaced, others are slow, and still more are in between.
I store all royalty-free and Creative Commons pieces separately but nevertheless using the
same system. I add in text files with all necessary
information about how the rights are to be handled.
Each text file is given the same name as the music
file so it can’t get misplaced.
Every important characteristic can be assigned
using Windows’ advanced properties pop-up screen
for file attributes, but categorizing with folders is

Here’s an illustration of my folder system:
 0 – 1 Minutes
 1 – 2 Minutes
2 – 3 Minutes
 Fast
 Medium
Slow
 Artist – Song Title
 Artist – Song Title
 4 – 5 Minutes
 6 – 7 Minutes

Suit the system to your own needs, not mine.
The time spent creating such a system will pay off
in the long run because you’ll no longer plow
through hundreds (eventually thousands) of unsuitable songs.
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Ripping in Windows Media Player

Don’t use ProShow to rip music from CD’s.
The reason is that it rips at a low bit rate, which you
cannot change and which translates to lower quality.
One of the easier programs to use for ripping
is Windows Media Player where you can set the bit
rate for MP3’s to 320 and where you can also choose
other formats, in particular the lossless WAV format. Best of all, Windows comes with the program.

rest of your music organized, but this single
folder works as an easily found holding
tank.

1. On the full screen in Media Player, go
to Tools > Options > Rip Music.

6. After placing a CD in your drive, click
on Rip.

2. Choose the format to rip to, which will
usually be MP3, but if you’re ripping a
song for editing in your sound editor,
choose WAV.

7. You’ll go to a screen where every track
on the CD is listed, each with a checkmark
in a small box on the left indicating that
all the songs will be ripped (Media Player’s
default).

5. Click “Apply” when you’ve finished
setting everything as you want it. Media
Player will remember these settings the
next time you rip music, so if you want a
different format at any time, you’ll have
to reset this option.

3. Move the slider all the way to the right
for the highest quality.

8. If you want fewer songs, uncheck the
ones you don’t want.

4. Choose a folder where you’ll consistently save all music files. You can move
them to other folders where you have the

9. Click “Rip Music,” and the chosen
songs will be ripped to the folder you’ve
chosen.
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How to Shorten a Song
by Barbara Coultry

Starting

Up-front warning: Do not edit an MP3 file.
Before you touch that music, convert it to a WAV
file. Otherwise, you risk lowering the quality.
Required software: A sound editor. You can
only do the most rudimentary editing in ProShow.
Reason for shortening: You’ve found the perfect song, but your show is, say, three minutes long
and the song is four minutes. Fading it out at the end
sounds just like what it is—you ran out of pictures
before you ran out of melody. The alternative is to
do some cutting and splicing, and for many songs,
it’s not too difficult a job.
Good candidates: The easiest songs to shorten
have a built-in repetition where verse and chorus
alternate. You’ll find examples of this in everything
from hymns to rock. The lyrics change in each verse,
but in between each verse is the chorus where the
lyrics stay the same. Each of the two sections has its
own consistent and distinct melody.
The method: Pick a verse and chorus you feel
can be cut from the song without doing harm. Watch
out for the very beginning of a song because it can
often be slightly different from the rest, working as
a kind of lead-in to the music. You may want to
retain this part. Look in the middle of the song, trying to judge what could be left out without ruining
the message or the flow of the music.
Technique: You’ll break the music at two
points and then eliminate the section that sits between those two points. The concept is the same as
in editing an audio tape where a chunk of tape is
removed, the ends lined up, and those ends are then
attached with splicing tape. Our stickum is digital,
which is ten tons easier to use.

• Bring the song into your audio editor,
and as mentioned above, if it’s an MP3,
save it as a WAV file.
• Next, do nothing other than start the
song playing while watching the bar move
across the waveform.
• You’re listening for the repetitions and
simultaneously watching for the graphic
representation of them in the waveform.
• It can take several runs through a song
before the patterns become fully apparent, so don’t jump right in the first time
through.

Cutting and Splicing
1. Place your cursor just a little before the
place where you believe the repetition begins, hold down the shift key, and then
click just a little after where you believe
the repetition ends. This creates a selection.
2. Zoom in on the selection and focus on
the beginning of it.
3. Play the selection, starting and stopping
it, listening and watching at the same time
so you can fine-tune the selection by moving it to the precise beginning of the repetition.
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• If the lines don’t meet at the same spot,
try cutting off just enough so they’re at
least really close to meeting.

4. Repeat the fine-tuning process for the
end of the repetition.
5. Place a cut at the beginning of the selection and at the end.

• Try a tiny fade-out at the end of the first
part and an equally tiny fade-in at the beginning of the second part. Start with no
more than a split-second fade.

6. Slide the section that’s been cut either
to the end of the track or to a separate
track, keeping it there just in case you need
it later.

• Try running the end or the beginning
through the equalizer, working the controls to tone down treble or bass. This may
get the mismatched ends closer to meeting.

7. Drag the second section of the waveform to the left until the parts meet perfectly.
8. Select from a few seconds before to a
few seconds after the cut and listen with
your ears wide open. If it’s a perfect match,
do a “mixdown” to create a single song
that’s minus the part you extracted. You’re
done. If it’s not perfect, don’t mix down
quite yet.

• Use the pitch control to raise or lower
one part in an effort to get them to meet.
Once the song plays through without a hiccup
at the spot where the section was extracted, do your
mixdown and save it as a WAV file before you save
it as an MP3. This is a safety precaution in case you
find out later that a little more editing is required.
If it looks as if this is going to take a half day
to do, find a different song.
A note about number of instruments: The
more instruments used in a piece, the more difficult
it can be to shorten. This is because there are likely
to be no silent spots in the music where naturalsounding cuts can be made.

If the match isn’t perfect: When things aren’t
quite right, you may hear a tiny pop or a jump in the
music. There are several methods for fixing this.
Sometimes it requires just one of the methods, sometimes a combination. First, zoom in on the cut spot
in the waveform, then try one or a combination of
the following:
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Sound Edits in ProShow

Three Sound Clips on One Slide

Silence Between Songs

Only one sound effect can be assigned to each
slide, but you can use the slide before and the slide
after to trick the middle slide into playing three
sounds.

3. Place the first sound clip on the slide
previous to the one where you want the
sounds to play.

Offsetting one song from another can lead to
popping sounds at the end or beginning of the tracks.
To eliminate this, bring a short sound file into your
sound editor, lower its volume down to nothing, then
save it to another file name such as Silence.wav or
Silence.mp3. Whenever you want silence between
two songs, insert this file, overlapping the tracks
slightly. This will get rid of the unwanted pop.
Even when one song begins immediately after
another with no time in between, you can get a small
popping sound when one song ends and the next
begins. To eliminate this, set the delay of the second song to -1 second. The negative number creates a slight overlap so that the popping sound is
eliminated.

4. Place the second sound clip on the slide
where you want the sounds to play.

Trim Silence from Songs Quickly

1. Write down the precise duration for
each sound clip and then total the amount
of time.
2. Give the slide the required duration for
it to stay on screen long enough for all
three clips to play.

1. In Soundtrack options, click on the
track you want to edit, then click Edit
Fades and Timing.

5. Place the third sound clip on the slide
immediately following.
6. Offset the sound in the first slide just
enough to push it into the second slide.

2. Zoom in on the track. Where you see a
flat line at the beginning or end is where
there’s silence.

7. Offset the sound in the second slide so
it doesn’t overlap the first.

3. At the beginning of the track, click as
close to the point where the silence ends
as you can.

8. Give a minus value to the offset for the
sound in the third slide so that it backs up
into the second slide.

4. Click “Start Here” to set this as the starting point for the track.

Another method is to combine all 3 sounds in
an audio editing program, making them a single
sound clip that can be dropped into just one slide.
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5. At the end of the track, locate the point
where the actual music ends and the waveform becomes a flat line. Click in the
waveform as close to the end of the actual music as you can.

Zoom in on Waveform for Easier
Syncing
Press the TAB key to go into timeline mode.
You’ll see two buttons at the bottom right of the
screen, one with a plus sign and one with a minus
sign. Click on the plus button to enlarge the view.
Continuing to click the button will slowly stretch
out the waveform so you can see the precise spots
where, for instance, there’s a hard drumbeat.

6. Click “End Here” to set the ending
point for the track.
7. If there’s more than one music track,
and after you’ve eliminated the areas of
silence, click on the second track and
make the offset a negative value of approximately –1.0 to –1.5 to create a crossfade. (While one track is fading out, the
next is fading in.)

Mute Video Clip Sound
1. Double-click on the slide with the video
clip.
2. Go to Layers in Options.

Move Soundtrack in Slide Timeline

3. On the right-hand side you’ll see
“Video Clip Settings” where you can slide
the volume control to zero.

Press TAB to switch to timeline mode. Hold
down the Control key while dragging your mouse
over the waveform to move it.
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Section IV
Motion

52

All Motion Is Relative
Op-Ed by Barbara Coultry

Comments often seen in the forum can be
boiled down to some version of one of these three:

Bring the photo onto the screen in full view, then
zoom in on your uncle. Quite often, this same ploy
works well with landscapes: fit the entire picture
onto the screen and then zoom in on the center of
interest.
Panning really comes into its own when you
want to sneak up on the center of interest. Imagine a
panoramic seascape in December. It’s desolate except at the far right where a lonely figure stands,
gazing out to sea. Sliding from left to right and stopping when the figure finally comes onto the scene
makes that pan earn its keep.
I find that landscape is generally more amenable to panning than people pictures. Humans are
innately interested in how other humans look, and
to have images of people floating past is
irritating…usually. As I said, motion is relative.
Folks can go barreling past if the key idea is frenetic activity, but please don’t send the bride flying
because I, for one, will stop the show and go elsewhere.
Zoom also needs a good reason: I absolutely
loathe watching shows where photos zoom in and
out for no reason I can fathom. Usually it’s because
the builder thinks it will make the show more interesting. It won’t. If you’re going to zoom in on something, do it because there’s a focal point you want
to emphasize; if you’re going to zoom out, do it
because you want to go from the center of interest
to what’s surrounding that center of interest. Otherwise, what’s the point?
Well, sure, there can be a point, and once again,
it depends on the intent of the show. If the photo is
less important than what you’re trying to say, zoom
can be used for emphasis, to match musical rhythm,
or to create either drama or comedy.
Pause your pan or zoom: A slide show is all
about the pictures, not about how well you can make
things dance around the screen. In most cases, it’s

“Tone down the motion – there’s too much.”
“You could use a little more motion.”
“Don’t use the same motion throughout.”

What’s a body to do? How are we supposed to
know when we have too much or too little? The
answer is complicated by the fact that the amount
of motion we use is relative to what we’re trying to
say or accomplish. Though what follows is based
on a lot of reading and studying and practicing, it is,
nevertheless, opinion.
Motion should match the image: Mountains
don’t move much, and so a rotating landscape is
inherently disturbing and reminiscent of the vertigo
one might feel before passing out. Unless you have
good reason to twirl that mountain, please don’t.
Rotate a ball, bounce a puppy, whiz a car across the
screen, but please don’t rotate the scenery. Things
being relative, what you do with the scenery does
depend on the show’s mission and flavor. A fastmoving show, an upbeat show, a comic show, or a
downright weird show might like an unruly mountain here or there.
Panning needs good reason: The classic place
for pan is in panoramas. There just isn’t enough
screen real estate for a picture that’s extremely wide
or tall, and a pan helps overcome the shortfall. The
problem I see quite often is that people use pan instead of zoom. For instance, say you’ve a wide photo
of the Class of ’49. It’s unlikely that the show is
about all seventy graduates, but you want to give
the audience a glimpse of Uncle Harold’s entire
class, so you pan and then stop at the young Harold,
maybe highlighting his face. No one cares about the
rest of the people in that photo, so why should you?
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best to start a pan or zoom after the picture has come
into view and then stop it before it goes out of view.
If you don’t believe me, pay attention to pan and
zoom in the movies. Give people a chance to actually see the picture, for goodness’ sake, rather than
forcing them to continuously refocus their eyes because of unending motion. Pan to something, zoom

to something. If you don’t, no one will know what
the heck they’re supposed to be looking at.
Negative comments are born mostly of misplaced motion. DO NOT use motion to add interest
to a show that you think is boring. It’ll still be boring. DO add motion when it enhances the story, the
theme, or a photo.
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Key Frame Basics
by Barbara Coultry

Key frames are rooted in the past when cartoon artists drew the individual pictures by hand—
frame by frame by frame. Studios such as Disney
hired a main or key animator whose job was to create the frame that began a motion and also the frame
that ended the motion. These two frames were called
key frames. All the frames in between, the ones that
went from the beginning to the end of the motion,
were drawn by assistants (called “betweeners”).
In Producer, you are the key animator, and the
software is the betweener.
New Producer users commonly believe that the
space between two markers on the timeline is the
key frame. It isn’t. The markers point to the key
frames. Here’s what’s really behind the timeline (see
Figure 01):

If you want a small red box to start out at the
bottom-left corner of the screen and rise diagonally
up to the top-right corner, you’ll need only two key
frames to accomplish it. You’ll position the box in
key frame 1, showing where you want the box to
start out, and then you’ll position the box in key
frame 2, showing its final resting place. Producer
then takes over behind the scenes, doing all the inbetween frames for you (see Figure 03):

Figure 03.

In the Motion Options screen, there are two
windows. The window on the left shows the beginning of an action, and the window on the right shows
the end of that action. As key animator, all you need
do is set those two key frames (see Figure 04).

Figure 01.

All those numbered squares are not slides;
they’re the in-between frames that Producer builds
and that create the appearance of motion. Here’s how
we see the timeline (see Figure 02):

Figure 02.

Notice the two circled markers. They are each
pointing to a single key frame: Marker #1 = key
frame 1 and marker #2 = key frame 2. Your responsibility as the key animator is to design key frame 1
for the beginning position and key frame 2 for the
ending position.

Figure 04.

In the illustration above (Figure 04) and in key
frame 1, the butterfly is sitting at the bottom-left. In
the window on the right (key frame 2), the butterfly
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In the illustration below (see Figure 06), a key
frame was added in the middle of the timeline. Notice the shaded bar between key frames 1 and 2. This
indicates you’re working on those two key frames.
In key frame 1, the butterfly is placed in its start
position, and in key frame 2, it’s placed at the top
center. Rotation was added so the butterfly will be
pointed in the correct direction when it flies back
down.
To move to the next set of key frames—key
frame 2 and key frame 3—either click the blue button with the right-pointing arrow just to the left of
the timeline, or click in the gray section of the
timeline between markers 2 and 3. Notice that the
window on the left now shows the butterfly’s position in key frame 2 (see Figure 07). That’s the beginning key frame for the next action. All we need
do now is go to the right-hand window and position
the butterfly for key frame 3.
When you preview the slide, you’ll see that the
butterfly floats from the bottom left up to the middle
top, then descends to the bottom right and nearly
off the screen.
Once you understand the basics of key
frames—what they really are and how to control
what happens using those two windows in the Motion screen—you’re on your way.

has been moved to its end position at the upperright. Producer, being the diligent assistant you’ve
hired, will do all the in-between frames for you,
making it appear that the butterfly has floated up on
the wind.
A lot more could be done with just those two
key frames, including a reduction in opacity, a
change from one color to another, and even an alteration in size so the butterfly appears to get smaller
as it flies away, but no matter what effect you choose,
you’ll be controlling it by setting the beginning of
the effect in the left-hand window, and the end of
the effect in the right-hand window.
Producer’s timeline defaults to just two key
frames, but you’re at liberty to add more key frames,
which you’d absolutely have to do if you wanted
the butterfly to change direction. Producer can do a
lot of things, but it can’t read your mind. So, if you
want the butterfly to move up and then to the right,
you have to tell Producer this is what you want.
That’s what key frames are—they’re instructions
telling Producer where to go, how to go, and when
to go.
To make the butterfly go from the lower left of
the screen to the middle top, then turn and go back
down to exit on the right side of the screen, you
need three key frames. The simplest way to add a
key frame is by clicking the “+” button to the left of
the timeline (see Figure 05).

Figure 05.

Figure 07.

Figure 06.
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Revolving-Door Effect

Two images appear interlinked and revolving.

13. Go to the Layers screen, turn off layers 1 and 4, and turn on layers 2 and 3.

1. Drop two pictures into a slide.

14. Go to the Editing screen and repeat
steps 7 through 12, but for layers 2 and 3.

2. Go to the Layers screen and set the
zoom for each layer to 50%.
4. Make sure the layers are as follows:

15. Select layer 2 in the Motions screen,
and change the pan for the ending position to 0 x 0.

Layer 1 = Photo A

16. Unlock the x/y axis on both the beginning and the ending positions.

3. Right-click on each layer and duplicate.

Layer 2 = Photo B

17. Change the ending zoom for x to 0,
leaving the zoom for y at 50.

Layer 3 = Photo B
Layer 4 = Photo A

18. Switch to layer 3 and change the ending pan to 0 x 0.

5. Turn off Layers 2 and 3 for now.

19. Unlock the x/y axis on both the beginning and ending zoom, and change the
end zoom for x to 0.

6. Go to the Editing screen and select
layer 1.
7. Choose the Crop button and change the
width (left-hand number) to half its
original size, rounding down to the nearest whole number if necessary. Click
OK.

20. Review the slide. Photo B should appear to rotate.
21. Go to the Layers screen and turn off
layers 2 and 3 while turning on layers 1
and 4.

8. Select layer 4 and crop as you did in
step #7, this time rounding up to the nearest whole number if necessary.

22. In the Motion screen, select layer 1.
23. Change the pan for the beginning position screen to 0/0.

9. Slide the crop outline as far right as it
will go and then click OK.

24. Unlock the x/y axis on both sides.

10. In the Motions screen, move the two
halves (layer 1 and layer 4) until they
match up without a gap.

25. Change the beginning zoom for x to
0, leaving y at 50.
26. Select layer 4 and repeat this process
(steps 23 through 25).

11. Pan values on the left should be the
same for layer 1 and layer 4, but layer 1
will be a negative number while layer 4
will be a positive number.

27. Go to the Layers screen, turn on all
layers, and preview the slide.
28. If you see a line where layers 1 and 4
are at the beginning of the slide, add an

12. Click “Copy Start to End” for both
layers.

extremely short fade-in (.03 seconds) to both
layers.
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Puzzle Technique
By Mike Gregg

8. Turn on each layer one at a time and
save it as a PNG file. (See end NOTE if
you use CS.) After each layer is saved,
turn it off, turn on the next one, and save
it. Do this until each layer is saved as a
separate file.

In Photoshop®
1. Download the free Puzzle Effects action: (See Puzzle Effects Link, pg 59.)
2. Open the photo you want to use, and
run it through the action

9. Turn off all the layers again so nothing
is showing.

3. The photo will be cut up into 20, 30 or
56 pieces depending on how many you
choose.

10. Time to start assembling the puzzle:
Whatever order you choose to put the
pieces together is up to you, but choose
the first piece/layer you want to start with
and turn on that layer.

4. The photo will be placed on a background image which you should remove
by going back seven steps in history, leaving only the photo cut up into pieces.

11. Save the file as puzzle01.png.
5. In the Layers palette, each puzzle piece
is in its own layer and is labeled a1, a2,
a3, a4, etc.

12. Keep that layer turned on and turn on
the second layer, saving it as puzzle02.png.
13. Be sure to write down the order of the
pieces you are choosing because you’ll
have to create your show in this same order.

6. Delete the background layer.
7. Unclick the little eyeball in the palette
next to each layer to turn off all the individual layers.

14. Repeat this process until you have
turned on all the layers and saved each
step as a new PNG file.
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sure the beginning and ending positions
for the image in this slide are set to 0,0
100%.

In ProShow
1. Create a new show and choose a solid
background color. (Don’t use an image
file for the background.)

8. Immediately after the third slide, insert
a blank slide using the file puzzle01.png
as a background image. Make sure you
have this set to “Fit to Safe Zone.” This
completes the placement of the first puzzle
piece.

2. Set it up so all images and background
are set to “Fit to Safe Zone.” This is very
important!
3. Start by dropping in the first image file
for the first puzzle piece you selected to
rebuild the puzzle with. (This is why you
wrote down the file names in the order
you saved them.)

9. Repeat steps 3 through 8 for each of
the remaining puzzle pieces: three consecutive slides for each piece separated by
a background slide in sequence. Make sure
you follow the order you wrote down.

4. Copy and paste this slide so you have
three consecutive slides with the same file.

10. Timing the slides: I chose 3 seconds
for the second slide in each set (the one
with motion), and 0 seconds for the first
and third slides.

5. In the first slide, move the image around
to a different location, making sure the
starting and ending position of the image
is the same.

11. Make sure you use 0 set for the transition time.

6. In the second slide, make sure the beginning position matches the previous
slide, and the ending position is set to 0,0
at 100%.

12. For the background image I chose a
duration of .5 seconds with a .5 transition
afterward. Change to suit your taste.

7. The third slide should be set to match
the end position of the second slide. Make

NOTE: If you have Photoshop® CS, go to file
> scripts > export layers to files. This automates the
process of saving each layer as a separate file.

Puzzle Effects Link:
http://www.panosfx.com/index.php?option=com_content&task=view&id=17&Itemid=27
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Moving Lines
(as per Mona)

1. Generate a solid-color image in Producer in the Options screen and in Layers
by pressing + and then choosing Add Solid
Color.

A Possibility for Moving Lines
By using more than one line, you can create a
grid. If you combine this grid with photos of varying sizes beneath it, then adjust the grid so it sits on
the edges where the photos meet, you can create an
effect where, first, the grid moves into place, and
next, the photos show up at varying times in the
blocks created by the grid. This is done by adjusting
the position of key frame 1 in each of the photos so
they show up at different times.

2. In Motion Options, unlock the x/y axes
on the left so you can adjust y axis to
squeeze the block of color down to a line.
3. You can shorten the line by adjusting
the x axis.

Different Kinds of Lines

4. When the line is as you want it, press
Copy, and then Copy to End.

The lines need not be composed of simple colors. By reducing the X or Y axis of images, you can
use those as your lines.

5. To move the line—for instance to the
left—start it at the far right in key frame 1.

Something to Try
Reduce the x/y axes to zero, then depending
on which direction you’re going in, increase the x
or y axis to a thin line, then increase the other axis
up to or beyond 100% so the line appears to expand
outward in opposite directions from the center.

6. Take it to where you want it to end in
key frame2.
7. Use additional key frames if you want
the line to pause or change direction.
In the illustration, you can see that
the same process might be used for any
shape, such as the rectangle (see Figure 01).

Figure 01.
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Out-of-Bounds Technique

• Layer 2: Frame on a background large
enough to conceal layer 3 even when this
third layer is at full zoom (see Figure 03).

It starts here (see Figure. 01):

• Layer 3: Original image (see Figure 04).

Figure 01.

And it ends here (see Figure 02):
Figure 03.

A suitable image for this technique has the subject in full view, no small part of it hidden by any
other object in the scene (see Figure 04):

Figure 02.

This entire effect requires only three layers:
• Layer 1: Cutout from the original image.

Figure 04.
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3. Key frame 4: Copy the settings from
key frame 3 to key frame 4 for both layers
so that the image stops outside the frame
border, lingering for however long you
want it to linger—perhaps a second or so.

The only part of the cutout that needs to be cut
with extreme care is the section that will appear in
front of the frame. The rest need only be erased close
to the cutout portion (see Figure 05):

Gold Instructions for OOB
Slide One:
1. Layers are set up so it appears to be a
simple, framed photograph.
2. Copy and paste this slide to the next
one.
Figure 05.

Slide Two:

Producer Instructions for OOB

1. Zoom (and pan if necessary) layer 1 in
the right-hand window until it appears that
the object has slipped beyond the bounds
of the frame.

Leave the picture frame as is and then set up
four identical key frames for layers 1 and 3 as below:

2. Apply the identical settings to layer 3.
3. Copy the end positions of the three layers to the next slide.

1. Key frames 1 and 2: both layers start
and end in their original positions

Slide Three:
2. Key frame 3: Set layer 1’s zoom so the
object appears to have slipped forward and
out of the frame. It’s possible you might
have to pan a bit to get everything looking correct. Copy all settings to layer 3.

Give it 1 or 2 seconds to remain on screen
before transitioning out.
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Screen Coordinates

Zoom Beyond 500%

Everything from the center of the screen
up is a negative number.

Though the slider for setting zoom indicates
that 500% is the top limit, it isn’t. You can type in a
larger percentage, but you should remain alert to
possible quality loss. Solid blocks of color and images used as masks aren’t as prone to damage.

Everything from the center of the screen
left is a negative number.
Everything from the center of the screen
down is a positive number.

Twinkling Star

Everything from the center of the screen
right is a positive number.

1.

In a photo editing program, create a star
shape (white or perhaps yellow) on a
transparent background.
2. In ProShow, place the star as a layer over
the picture where you want the star.
3. Zoom it in and out very quickly for a
duration of what might be no more than .1
seconds. (Producer: use key frames. Gold:
use separate slides of short duration.)
4. If you like, you can overlay the star with a
much smaller one that’s slightly offset,
doing the same thing with zoom, possibly
getting more of the twinkle effect.

In the position boxes:
The left-hand box is the horizontal axis
The right-hand box is the vertical axis
If you can’t, like most of us, remember which
box is which, draw a picture of the boxes, insert the
directional arrows in their respective spots, and then
tape the picture to the bottom of your monitor.

Motion Style Controls
NOTE: This often works better with a star like
that seen on Christmas cards where a vertical line
and a horizontal line form a cross, and then there’s
an “X” at the intersection of the vertical and horizontal lines.

• Linear: the object proceeds at a steady
pace, starting and ending at the same
speed.
• Accelerate: the object begins slower and
picks up speed as it goes, coming to a
screeching halt at its destination.

Moving Road on a Map

• Decelerate: the object starts off at a good
clip, then slows down as the destination
is approached.

1. Layer 1: A copy of the original map
with the road deleted, leaving a transparent line instead.

• Smooth: the object starts off a bit
slower, speeds up as it moves toward its
destination, then slows back down as it
nears its destination.

2. Layer 2: A large rectangle of whatever
solid color you’d like for the line.
3. Layer 3: The original map.

Note: If the duration of motion is short, you
may see little difference amongst the settings.

4. In Motions, start the color layer (layer
2) at the beginning of the “road,” and then
pan it so it slowly fills the entire road from
beginning to end.
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4. When you bring them into ProShow,
you’ll have to put them in reverse order
so the very first picture has the highest
number, and the very last has the lowest
number such as Writing001 in the example above.

Note: The map in layer 3 fills in the transparent area so the original road is visible until the colored “line” starts moving beneath layer 1.

Flipping Pictures

5. Use a cut for all transitions and set slide
durations to 0.033.

A picture appears to flip, either to a reversed
version of itself or to a different picture as if a card
was being flipped over.

6. If desired, save the series as an AVI so
you can drop it into any show.

1. Use 3 key frames per picture.

(OR)

2. Set the zoom to manual and unlock the
x/y axis.

Try Dave Fitzpatrick’s VisiSketch, which
comes in two flavors. You can download the “Lite”
version for free in “Member Created Files” on the
forum, and then if you like what it does and want a
whole lot more, you can purchase the “Pro” version.

3. Set the “x” zoom value to 0 for key
frame 1 and key frame 3
4. Set the “x” zoom value to 100 for key
frame 2
5. Copy this slide to the next slide

Morph a Face
6. Set the transition between the two slides
to 0 seconds.

Most commonly used for a series of pictures
taken through the years of one person

7. In Editing Options for the second slide,
click the “flip horizontal” box.

Method #1
1. First, insert all of the pictures you want
to use in the progression.

Handwriting Effect

2. Go to Captions for the first slide.

1. In an image editor, start with either a
scanned image of handwriting or something done with one of the many fonts that
simulate handwriting.

3. Type two O’s (upper or lower case depending on size needed), putting a space
between them.

2. Erase little bits of the text at a time,
going from the end to the beginning and
saving each tiny increment as a separately
named file.

4. Click on Captions Motion and move the
O’s until each is in the center of an eye.
5. You may need to change the size of the
picture or the font a bit.

3. To make sure the files are organized in
a series, give each a number such as Writing001, Writing002, etc.
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3. Save as a PNG to preserve transparency.

Method #2
1. Insert all pictures you plan to use in the
slides.

4. In ProShow, layer the cloud image over
the original.

2. Copy the first picture to the next slide.
5. Reduce the opacity of the cloud layer
until it looks realistic.

3. With “darken inactive layers” turned
on, click on the picture just beneath the
one you copied to the slide, and line up
the eyes.

6. Pan the cloud layer from left to right or
vice versa.
NOTE: You can use the same process to
create moving water.

4. Once the pictures are properly aligned,
delete layer 1, which is the image you copied to this slide.

Shake Effect

5. Repeat from Steps 2 through 4 for each
slide, getting the eyes in each image
aligned with the eyes in the image previous to it.

Using multiple slides of the same photo, move
every other photo to a very slightly different position. Use no transitions and a slide duration of about
.05 seconds.

6. Try a slide time of 1 second with a fade
of 1 second.

Set Same Zoom to All Slides
Moving Clouds

1. Add all the photos first.

1. Using a picture of clouds and in your
image editor, erase everything but the
clouds, giving the edges of the clouds a
slight feathering so they won’t look pasted
on.

2. Choosing any slide, and in Layers, select one of the layers, setting it to the zoom
you want.
3. Right-click the zoom number and
choose “Copy zoom to all layers on all
slides.”

2. Make sure the clouds are on a transparent background. (The method for doing this depends on the image editor you
use, so the process isn’t described here.)
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Section V
Captions
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Type Basics
by Barbara Coultry

Unjustified – flush left, ragged right: Perhaps the
easiest to read, though do watch that the right side
doesn’t become so ragged that it creates a distracting
visual design:

Most important to keep in mind when using
type is that it’s not there to be admired. It should be
easy to read and should never draw undue attention
to itself.

If you’re not careful, the ragged right can
end up making unfortunate
shapes that distract
people from your
sentences.

Caps vs. Lowercase: All caps should be reserved
for titles, but use lowercase for lines of text
because it’s much easier to read.
Serif vs. Sans Serif: Sans serif is good for titles, but
be careful using it for anything more than a small
amount of text. People read serif fonts with far more
ease.

Unjustified – flush right, ragged left: Reserve this
for very short bits of text or avoid it altogether.
Though interesting to look at, it puts high demand
on the reader because it’s unnatural. For example…

Black-on-White vs. White-on-Black: The greater the
amount of text, the better off you are with dark
lettering on a light background. A large amount of
white text on a black background strains the eyes.

How easy is it to read ragged-left text with
the left side jutting out over there and poking
in here?
Centered: Good only for small amounts of text
because it can be difficult to read. It’s perfect for
titles and invitations such as you might find in a
wedding show, and can work with poetry.

Bold vs. Regular: Bold is fine for titles but not so
fine for lines of text. This is because bolding fills in
the spaces between the letters, crowding them and
reducing readability.

Asymmetrical: This is text with no consistent
positioning and is used when the text works as if it
were an image such as seen below.

I hate Arial, but this will show what
happens when it’s bold.
I hate Arial, but this will show
what happens when it’s bold.
Justified: This is most often reserved for large blocks
of text such as you find in books.
This is justified text, which is what you’ll
commonly encounter in full-length books.
Though very readable in that context, the
odd spacing that can occur in short
amounts of text can drive you nuts.
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Decorative Fonts: They tend to be difficult to read
and can quickly draw attention away from an
image. For these two reasons, reserve them for
emphasis in titles, which is what they were really
designed for in the first place.

nor would you use an elegant font such as Trajan
Pro for a child’s birthday. Look at a font. What
does it remind you of? How does it feel? Is it
friendly? Authoritative? Classy? Silly? Loud? You
want the font to say the same thing your show is
saying.

Choosing a Font: Ask yourself what you’re trying
to say in your show and then choose a font that
reflects the idea. You wouldn’t use the very casual
Comic Sans for a show about a gothic cathedral,

Color: Tread carefully with bold colors. If the color
isn’t repeated elsewhere in the slide such as in a
frame, it can draw attention to how the text looks
rather than to what the text says.
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The Caption Screen
by Anna

A. Type your caption and
choose all settings
such as color, font,
size, fly-ins, texture,
etc.
B. Click on the word
“Styles” to the right
of the Style menu.
You’ll see an option
to add a new style
based on the current
caption.
C. Click “Add” and
select the caption
features you want
included in the
template.

(The above illustration is numbered to identify
the areas of the screen described below.)
1. Selected Caption: Type captions here.

3. Caption Color: Set colors for the font,
outline, and drop shadow.

2. Caption Format: Here you can choose
multiple settings for your caption such as
font, size, and bold/italics.

4. Caption Interactivity: These options
are only available for shows played on a
PC. Consult the Photodex manual or the
Help menu for more information.

• Select a font size from one of the presets or type in the size you want.

5. Caption Placement:
• Insert Macros: Macros allow you to
insert specific information (i.e. slide
number) into your slide.

• Alignment: align text to the left, center, right, or justified

• The Style menu offers several pre-set
caption/font options you can apply to
your caption once it’s typed.

• Position: sets the starting point on the
screen for the caption. This position can
be changed by typing in new numbers
or by clicking and dragging the caption
on the preview screen. Position points
set here can be over-ridden by position
points set on the Caption Motion

The Style menu also provides a place to save
templates for special captions you’ve created. To
create a caption template:
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screen. (To reset positions to default,
click the curved arrow to the right of
the position bar.)

• Gradient will fill the font characters
with gradient color. Click Edit Gradient
to change the type of gradient and the
colors.

• Rotate: Rotates the entire caption up
to 360%.

• Zoom increases or decreases the size
of the image or gradient being used to
fill the caption. To discard changes you
don’t want, click the curved arrow to go
back to the default size.

• Character rotation: Rotates the individual characters in the caption.
• Skew: Slants all characters in the caption to the left or right.

• Scaling offers three options for sizing
the image or gradient: Fill character is
the lowest zoom and will show the most
pattern. Fill caption is the middle zoom,
followed by Fill Frame, the largest
zoom.

• Opacity: Can be set from 0% to 100%.
• Character Spacing: Sets the amount
of space between the individual characters in a caption.

8. Caption List: Displays all your captions. Clicking once on a caption will select the caption for editing.

• Line Spacing: Sets the amount of
space between the individual lines in a
multi-line caption.

To the left of each caption on the Caption List
are three square toggle buttons:

All settings are over-ridden by any adjustments
made in the Caption Motion screen. Right-click on
any setting to see options for applying these settings
to the captions on this or other slides.

• Far-left box: This is for “Global” captions. This is off by default, displaying
one square in the box. When clicked to
turn it on, 3 overlapping squares are displayed indicating that caption will appear on all slides.

6. Text Effects: Determines how the caption will enter the slide, behave while
onscreen, and exit the slide. Click the
down arrow at the end of the selection bar
to see a list of pre-set motions. Click the
Browse bar to see a preview screen. Rightclick any setting to see options for applying these settings to the captions on this
or other slides.

If you want this caption to appear on every
slide, turn on global captions for it. Then, if you
want to remove the caption from any particular slide,
go to that slide’s Caption screen and click the middle
box, which is the “Hide/Show” option.

7. Use Texture on Caption: To activate
this feature, click the box to the left, then
click either “Image” or “Gradient.”

• Middle box: This is the “Hide/Show”
option, which is turned on by default and
shows a checkmark. The check mark
isn’t there in the OFF position.

• Image allows you to set an image as
the “color” of your caption. Fat fonts
work best for this option. Choose the
image by clicking the Browse button.
Clicking the Edit button will open up
your image editor if you want to edit the
image.

• Right-hand box: This is the “Caption
Above/Below Transition.” In the ON position (default), the complete “T” will is
visible, and the caption won’t display until the slide completely transitions in
from the previous slide. When turned
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OFF, only half the “T” is visible, and
the caption will display during the transition.

• Remove Caption will permanently delete the caption..
To the right of the Caption List are four buttons:

If you want your caption to serve as an introduction to the slide, set the toggle to off and set a
long transition-out time on the previous slide.
These choices and several more are available
by right-clicking the caption in the Caption List:

• Green “plus” button – add more captions to the slide.
• Red “minus” button – deletes the selected caption.

• Enable Caption - same as the Hide/
Show box.

• Blue up/down arrow buttons – move
the selected caption to a higher or lower
position in the Caption List.

• Above Slide Transition - same as the
Caption Above/Below Transition box.

The Preview area will display the captions as
you’ve designed them. You can reposition captions
in here by clicking and dragging them. Right-clicking in the Preview area will display a list of additional options.
Below the Preview area are buttons to enlarge
or reduce the preview screen, to preview the slide,
to jump to the previous or next slide, and to set the
slide time.
IMPORTANT NOTE: Right-clicking on
many settings gives you the option to copy that setting to all captions on selected slides, all slides, or
all captions on this slide.

• Global Show Caption. When in the
On position, a fly-out menu gives you
the option to display or hide the Global
caption on all slides or on just selected
slides.
• Copy To lets you copy this caption to
all slides or just selected slides.
• Duplicate Caption will make an exact duplicate of the caption on the slide.
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Notes

Macros

• If Macros are used to number slides,
you can move the slides around, and the
macros will automatically renumber.

For adding slide numbers or file names to all
or selected slides in a show.
1. Go to Show > Show Captions from the
menu at the top of the screen

• Macros are handy if you are presenting
a client with a slideshow. The client can
select pictures by file name.

2. On the “Show Options” screen, select
“Captions”

• You can use macros at both the slide
level and the show level. At show level,
the captions will appear on all slides.

3. Type the phrase you want to precede
the Macro (i.e. “Wedding #”)
4. In the lower right corner of the area for
entering text, selecting fonts etc, there is
a “Macro” button.

Global Captions on Selected Slides
1. Add your caption to the first slide,
choosing font, size, etc. and including any
effects.

5. Click on it, look at the “Predefined
Macros” from the pull-down list, and select the macro you want.

2. Position the caption on the slide.
6. Place the caption where you want it to
be on all slides. The macro will be inserted
automatically after your caption.

3. Click the little box at the far left of the
caption in the caption list to turn it into a
global caption and then click Done.

7. Each slide in the show will have the
word or phrase you’ve typed along with
the selected macro.

4. Select all the slides where you don’t
want the caption to appear.
5. Go back to the Captions screen and
right-click the Global State icon.

If there is a particular slide on which you don’t
want the caption displayed:

6. Choose Hide Global Caption on Selected Slides.

1. Choose to “Show Macro” so it is visible on all slides.
2. Open the slide where you don’t want
the macro caption.

Vertical Captions

3. Click on Captions.

If you want to line up captions as in this example…
V
E
R
T
I
C
A
L

4. You will see the show caption you
specified listed in the captions list for that
slide.
5. Uncheck the box for that caption so it
won’t show when the slide is played.
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1. Type the caption as usual.

the first letter of the first word.

2. Change settings to rotate the characters
-90 degrees.

2. Set that single letter to the font, size,
and color you want.

3. Rotate the caption 90 degrees.

3. The second caption is the rest of the
word plus any additional words

If you want three such vertical captions on the
screen side-by-side and at the same height…

4. Line the two captions up side-by-side
on the Caption Motion screen.

1. Type in the three captions.
2. Specify the exact placement with the
position settings just as you would with
an image.

5. Make sure all movement—fly-in/flyout, etc.—is the same for both captions

Backward Fold In/Out Effect
3. Make sure all the captions have identical settings in the “Y” position so they’ll
all start at the same height.

1. For example purposes, use a 6-second
slide with 3-second transitions in and out.

For instance and in the case of three vertical
captions, if you have them positioned at 40/50 , 50/
50 and 60/50, they will have space between them.

2. Construct a caption.
3. Set the fly-in to “Fade Fold In”

Caption On Just One of Multiple Layers

4. Set Normal to “None”

You can make a caption display on only one
particular layer by using the caption key frames. Set
the caption’s transition in and transition out key
frame times to coincide with the transition in and
out of the layer you want the caption to display on.

6. Right-click this caption in the Slide List
and click Duplicate to get two identical
captions

Fly-in, Fly-out Captions for ProShow
Gold

8. Set the caption rotation to -180

Make the text an image with a transparent background in any editor, then handle it as you would
any other image where you’ve got all the transitions
and motion available to you.

10. Go to Caption Motion and for caption #1:

5. Set the fly-out to “Fade Fold Out”

7. Click to select caption #1. This will be
the “backward” caption.

9. Set the character rotation to +180.

a. Set start point to 2.250 seconds
b. Set end point to 6.0 seconds

Initial Letter Different from Rest

11. Select caption #2. This will be the
“normal” caption.

1. Divide the caption word into two separate captions, the first caption being just

12. Set the caption rotation to 0
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13. Set the character rotation to 0

Multiple Lines Fade in One at a Time

14. For caption #2:

1. Choose a slide time more than long
enough to read every line—at least 1 to 2
seconds per line.

a. Set start point to 4.500 seconds
b. Set end point to 9.75 seconds

2. Choose “Fade Down” for the fly-in

Notes:
3. Pull the fly-in transition bar well over
to the right, leaving about 3 or 4 seconds
at the end of the keyframe for the entire
caption to remain on screen.

• You might find that, though the second
caption was created by duplicating the
first, they appear out of alignment. Make
adjustments to caption positioning to remedy this.

4. Choose a simple fade for the fly-out.

• The length of your caption might require
altering the start and end points of each
caption to give the desired effect.

Multi-colored Letters in Single Caption
(Thanks to Joe aka “Heckydog”)

• You can play with the length of the flyin and fly-out settings by clicking and
dragging the double-headed arrow that
appears when you hover over it with the
mouse.

Applying a separate color to each letter in a
caption usually involves placing each of those letters in a separate caption, but the advantage to doing it this way is that it allows the caption to remain
whole, thus making it much easier to manipulate. If
you move the caption, it moves as a single unit where
no tedious fiddling is required, particularly when
using key framing.

Color Changes as Caption Moves
1. Type in the caption.

1. Type in the caption.

2. Go to Caption Motion screen.

2. Choose a gradient with the desired colors.

3. Add two key frames.

3. Add extra markers to the gradient where
each color meets to turn the gradient into
color bars.

4. In the middle of the Caption Motion
screen, you will see two boxes: “Color
Start” and “Color End.”

4. Adjust the added markers so they’re a
portion of 100% using this formula: 100%
divided by the number of letters in the
caption. Thus, if it’s 3 letters, the extra
markers are placed at the 33% and 67%
points, resulting in 3 colored bars. If it’s 4
letters, the markers are at 25%, 50%, and
75%, resulting in 4 colored bars.

5. Select key frame 1 and set both the color
start and color end to white.
6. Select key frame 2 and set both the color
start and color end to yellow.
7. Select key frame 3 and set both the color
start and color end to white.
The color of the caption will change in conjunction with the movement you have assigned to
each key frame.

5. Adjust the angle to 0° to get vertical
stripes.
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6. Adjust the zoom.

7. Drag the newly made file into a new
slide.

7. Set the Scaling to “Fill Caption.”
8. Go to Layers in the Options screen.
Just the First Letter
9. Select the text picture and choose to
make it a mask (Grayscale).

If you want only the first letter a different color,
count the number of letters, use the same formula,
and then place just the first extra marker in the gradient. For instance, if the title is “The Rockies,”
there’s a total of 10 letters plus one space, bringing
the count to 11. Dividing 100% by 11 results in approximately 9%, which is where you should place
the marker.

10. Add a photograph as a second layer
beneath the mask.

Rolling Credits
1. Read the text out loud while timing
yourself to see how long the slide should
run.

Picture Inside Text
Easy way:

2. Type the caption to fit on the screen,
using the return key to control the length
of each line. (Pay attention to the safe zone
if it’s to be shown on TV.)

1. Create caption.
2. Choose “Use Texture on Caption” and
select “Image.”
3. Browse for the image you want to show
through the letters.

3. In the Caption Motion window, start the
caption at the bottom of the screen and
end it at the top. (You can also start it just
below the screen and end it just above.)

4. You have a choice to Fill Character,
Caption, or Frame. Try each to see which
you like.

4. Use a fade-in and fade-out.

1. Add a blank slide.

5. Use the slider to adjust the space between each line. It’s possible that a setting of 125 or more will make the text
easier to read.

2. Go to Captions screen.

6. Speed is controlled with slide duration.

More involved but has more possibilities:

3. Add the word(s) in a large, fat white
font and exit the screen.

Caption Changes Color While Scrolling:
Example:

4. Select the caption slide, and if necessary, manually play the slide until the caption is on the preview screen.

1. In the Captions window, type your caption.

5. Right-click the preview screen.

2. In the Caption Motion window, add two
more key frames, spacing all key frames
equally.

6. Choose to Capture Frame and save it
as a file.
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3. Key frames #1 to #2: Set the color on
the left to blue and the color on the right
to green.

7. Go to the Effects screen and set the
opacity for each set of key frames as follows:
• Key frames 1 and 2 = 100%
• Key frame 3 = 18%
• Key frames 4 and 5 = 0%

4. In the screen on the right, move the caption up.
5. Key frames #2 to #3: Set the color on
the right to yellow.

8. Go to the Caption screen and choose
texture for the Caption > Image, selecting
the same image that was used for layer 2.
Choose to “fill frame.”

6. In the screen on the right, move the caption farther up than it is on the left.
7. Key frames #3 to #4: Set the color on
the right to orange.

9. In Caption Motion, set the caption to
pan from the right side of the screen to
the left.

8. In the screen on the right, move the caption up off the screen.

All timing and panning can be changed to suit.

Timing for a slide with scrolling captions is
very dependent on the amount of text. You should
err on the side of too much time allowed rather than
too little.

Slow Curling Effect
Captions appear as letters scattered randomly
across the screen, and then they slowly twirl and
drift until they settle into place so the captions are
readable.

Transparent Caption Pans & Fades
Example setup:

1. Allot a relatively large amount of time
for the slide (at least 20 seconds.)

1. Add a photo plus a solid black image
to a slide.

2. Type up your caption lines (the more
the merrier.)

2. Set the solid black image as layer 1 and
the photo as layer 2.

3. Use the “Curling” fly-in for each caption, sliding the timing bar over close to
the end of the keyframe but leaving a few
seconds for the captions to remain in position so they can be read before fading
out.

3. Insert the caption using a large, thick
font.
4. Set slide time to 18 seconds.
5. Set transitions in and out to 1 second
each.

4. If you like, use any of your favorite text
effects such as a gradient or picture background.

6. For layer 1 (solid black layer) create 5
key frames:
• Key frame 1 = 0
• Key frame 2 = 5
• Key frame 3 = 12
• Key frame 4 = 17
• Key frame 5 = 20

Example for a More Complicated Setup
1. Open a blank slide.
2. Set slide time to 38 seconds and a fadein transtion if desired.
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5. Select “Curling” for fly-in and a .5 fade
for fly-out.

12. At key frame 1, position the first caption to begin in the upper left-hand corner
of the screen and the second caption to
begin in the lower right-hand corner of the
screen. Set key frame 2 for both captions
at position 50 x 50.

6. Duplicate this caption by right clicking on it.

13. Set key frame 3 for both captions at
position 50 x 50.

3. Go to Caption screen.
4. Type a 3-line caption.

7. Go to Caption Motion screen.

Wingding as a Picture

8. Set opacity for caption 1 at 100% from
start to finish.

Insert a shape from the Wingding font (or any
other picture font), increase its point size, fill it with
an image or gradient, and add any other text effects
you like including fly-in and fly-out. For instance,
you can use a circle to insert the photo of a daisy, a
diamond for a violet, and a square for a tulip. Each
flies in separately. This is only a simple example,
but with a little thought, some interesting effects can
be accomplished.
Alternatively and once the shape and its fill
have been inserted, the frame can be captured, saved,
and then used as an ordinary image layer.

9. Set opacity for caption 2 to go from
100% to 0% start to finish.
10. Set three key frames for each caption:
• Key frame 1 = 0.00
• Key frame 2 = 35
• Key frame 3 = 38
11. Set fly-in time for both captions to
about 35 seconds.
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Section VI
Masks
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Elementary Masking
by Barbara Coultry

3. Save this picture and go into Producer.

The masks we use in Producer do what a reallife mask does: hide some things while revealing
others. A Halloween mask might hide a person’s
nose, cheeks, and forehead while revealing the eyes
and mouth. A mask in Producer can be used to do
exactly the same thing. And more.
Frames and masks are often confused at first.
A frame will, in its most common form, be a picture
with a transparent area that we can see through to
the layer beneath (see Figure 01).

4. Drag any photo of your choosing
onto a slide.
5. Now drag the black-and-white picture you created on top of that photo.
(Ctrl-click while dragging.)
6. Go into Layer Options, and with the
b&w image selected (it should be layer
one), put a checkmark into the box to
indicate that this layer is a mask.
7. Make sure the drop-down box says
“Grayscale (Intensity)”
8. Look at the preview pane.
You’ve just created a mask. Wherever the mask
is white, the picture immediately below shows
through, and wherever it’s black, the third layer
shows through. Because there’s no actual third layer,
the background (working essentially as if it were a
layer) shows where the mask is black (see Figure
02).

Figure 01.

A mask is fancier than a frame, can do quite a
bit more, and it can do it without ever being visible.

Grayscale Masking
Basic Mask #1
1. In your image editor, create a
picture that’s totally black.
2. In the middle of all that blackness,
place a circle, square, or anything else
of your choosing, filling this shape
with white.

Figure 02.
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Basic Mask #2

2. Using the “down” button, move that
photograph until it’s positioned as
layer 3.

1. Go to Background Options and
choose to “Override background
color.”

3. Click the right-arrow button, which
will add it as one of the masked layers.

2. Pick any color other than black—
say, red.

4. Now look at the preview.

3. Look at the preview. What was
black is now red (see Figure 03).

As shown in Figure 05, nothing has happened
because Layer 2 is covering up Layer 3. You can
remedy this with a single change in keyframing.

Figure 03.

Basic Mask #3
1. Bring another photo into the slide.
2. In Layer Options, select this new
photo, and using the down-arrow button, place it in the Layer 3 position.

Figure 05.

3. Look at the preview. You should see
the third layer appearing wherever the
mask is black (see Figure 04).

In Motion Options with Layer 2 selected, slide
the second (last) marker to the left so it’s positioned
at approximately the halfway point in the timeline.
Figure 6 shows what happens in a six-second slide
(see Figure 06).

Figure 06.

Figure 04.

Basic Mask #4:
1. Using the same setup as in Basic
Mask #3, add one more photograph.
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Alpha Masking Practice

When gray is used—Gray is neither black nor
white, but a mixture of the two. This means there
will also be a mixture of the masked layer and the
first layer outside the mask. A lighter gray shows
more of the masked layer, and a darker gray shows
less of the masked layer and more of the first layer
outside the mask. Thus, if the circle used in the above
examples doesn’t have a hard, well-defined edge but
instead has a feathered edge where the white blends
slowly down into black, the masked layer along that
edge will slowly blend down into the first layer outside the mask, creating a much softer edge.

(suggested by Dale)
Create a four-paned “window” using 8 layers
and 4 masks.
1. Take any image and duplicate it
seven times for a total of 8 layers.
2. Set all odd-numbered layers as alpha masks.
3. Change all masks (layers 1,3,5, and
7) to 25% zoom (beginning and end)
4. Set the pan coordinates of mask 1
to 25, 25

Alpha Masking

5. Set the pan coordinates of mask 2
to -25,-25

An alpha mask works exactly the same way as
a grayscale mask except that where the alpha mask
is opaque (color doesn’t matter), the layer being
masked shows through, and where the alpha mask
is transparent, the first layer outside the mask shows
through. In other words:

6. Set the pan coordinates of mask 3
to -25, 25
7. Set the pan coordinates of mask 4
to 25, -25
8. Set the slide time to 3 seconds with
a crossfade transition at the end.

Grayscale

Alpha

White
Black
Gray

Opaque
Transparent
Translucent

Try changing the ending zoom from 25 to 50%
on all four mask layers so they’ll expand until the
entire photo is revealed. If you increase the ending
zoom to 100% on all four mask layers, the windows will close faster.
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Four Ways to Create Masks Inside
Producer

NOTE: Any mask created as above can be
saved to your masks folder by previewing the mask
full-screen, right-clicking, and choosing to capture
the screen. Alternatively, use the Print Screen key
to copy the image to the Clipboard. Open your image editor, create a new document, paste the picture, flatten the layers, and then save it in whatever
resolution and file format you wish.

1. In Editing Options use “colorize”
to convert a picture to grayscale. Adjust white and black points along with
contrast to get the proportions and intensity desired in the mask. Set as a
grayscale mask.
2. Add a “Solid Color” layer, sizing it
by using the x/y coordinates, and then
turn it into an alpha mask.

Circle Spotlight
A spotlight moves over a picture, lighting parts
of the picture as it moves. What isn’t in the spotlight is dimmed.

3. Add a gradient layer with transparency, choosing its style and adjusting
the sliders to get the shape and transparency desired. Use as an alpha mask.

Setup
Layer 1 – The mask, which is a white
circle with soft edges on black. Set to
grayscale.

4. Do the same as above with the gradient layer, but choose one without
transparency, and set as a grayscale
mask. (It might be easier to visualize
if just black and white components are
used.)

Layer 2 – A photo set at 100% opacity
and masked by Layer 1.
Layer 3 – Duplicate of the above
photo, set to 40% opacity, and placed
outside the mask.
Set movements as desired to spotlight different areas of the photograph.

82

Word Masks

4. Click “Add Another Layer” and select “Add Solid Color” (black).

1. Add a blank slide.
2 . Double-click on the blank slide and
go to Captions.

5. Go to Captions and create a caption
using a large, thick font.

3. Add your word in a large and fat
white font. Click Done.

6. Set “Text Effects” to None in all
three options.

4. Click on the newly made word slide
and then manually play the slide in the
timeline until you see the word show
up.

7. Go to Effects.
8. For Layer One (the black layer), set
5 key frames:

5. Right-click in the preview area.

Key frame 1 = 0.00

6 . Choose “capture frame” and save it
to a file (remembering where you
placed it).

Key frame 2 = 5.00

7. Go back to the folders list, find the
file you just saved, and pull it into your
show as a new slide.

Key frame 4 = 17.00

Key frame 3 = 12.00

Key frame 5 = 20.00
11. Set the beginning and ending opacity for Layer One as follows:

8. Double-click the new slide and
choose Layers.

Key frame 1-2 = 100/100

9. Highlight the layer with your caption and set it as a mask.

Key frame 2-3 = 100/18

10. Add your photograph behind it to
show through.

Key frame 3-4 =18/0
Key frame 4-5 = 0/0

Example #1

12. Go to Captions and click “Use Texture on Caption.”

These instructions demonstrate how to achieve
a foreground with a see-through caption that slowly
changes opacity to reveal the underlying image.

14. Select “Image” and insert the same
image file as used in Layer 2.
15. Select “Fill Frame” and click Done.

1. Drag an image into a slide.
2. Set the slide time to 18 seconds with
a 1-second transition in and out.

Example #2 (Moving Word Mask Using 2 Images)
1. Use the method above or an image
editor to create a word mask with a
transparent background.

3. Double-click to open Slide Options
and go to Layers.
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2. Put 3 layers on a slide:

Example #3 (Captions can normally display only
on top of all layers, but...)

a. Layer 1 = the word mask

1. Create a caption in the center of a
blank black slide and then save it as a
JPG.

b. Layer 2 = image A
c. Layer 3 = image B

2. Drag the JPG caption image into a
new slide. (This will end up as Layer
3.)

3. On Layer 1, check “This Layer Is A
Mask,” choosing Alpha Transparency.
4. Go to the Motion screen and set any
movement you like for Layer 1. In this
effect, Layer 2 will display as the wordfill against the backdrop of Layer 3.

3. Go to Layers and add an image. (This
will end up as Layer 2.)
4. Add a gradient linear mask, which
will be Layer 1.

[or]

Once the layers are in place, add desired moFollow the same steps as in Example #1 but tion to Layer 3.
check the Invert box. This time, Layer 3 will display as the word fill against the backdrop of Layer 2.
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6.To create the shadowed area, use a gradient—

Rolling Ball with Shading

a. Select the white area with a feather
setting of at least 50.

If a ball rolls in front of you from left to right,
the shading on the lower part of the ball remains the
same because the light hasn’t changed. To create
this same effect in Producer, a mask with the proper
shading is used. Because the ball image rotates but
the mask doesn’t, the shadowed area remains as it
should at the bottom of the ball (see Figure 01).

b. Invert the selection and move it so
the area of the ball you want shaded is
inside the selection.
C. It’s best to build up the gradient, so
set it at around 40% opacity, then do a
number of passes with it from different
angles.

7. Save (see Figure 03).
The ball (Figure 02):

Figure 01.
Figure 02.

In Image Editor
The mask (Figure 03):

1. Either do a cutout of a real ball (no
shading) or create a simple ball shape on
a transparent background, adding any
decoration you wish to the ball. Save. (See
Figure 02.)
2. Do a “Save As” on the same image,
adding the word “Mask” to its name.
3. Paint or fill the ball with white.
4. Fill the transparent area with black.
5. Flatten.

Figure 03.
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In Producer

3. Duplicate the ball.

1. Add the ball image to a slide.

4. Remove the rotation for Layer 1.

2. Set up the ball’s rotation and its pan
across the screen.

5. Replace Layer 1 with the mask image.
6. Set Layer 1 as a grayscale mask.

• Rotation: If moving from left to right,
start with a rotation of –360 degrees at
keyframe 1. If moving from right to left,
start with a rotation of +360 degrees.

Set the duration of the slide according to how
fast you want the ball to roll. A few tests with various durations will help you figure it out.

• Pan: Keep the vertical pan (right-side
box in settings) identical in the first and
second key frames.

Motion screen (see Figure 04):

Figure 04.
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Magnifying Glass Effect
(demystified by Iris and Barbara)

1. Find or take a photo of a magnifying
glass.

d. Flatten the image and convert it to
grayscale (smaller file size).

a. To photograph it, make sure it’s on a
background of strongly contrasting color.

e. Do not crop this image! It needs to be
the same dimensions as those of the
magnifying glass image.

b. In your image editor, create a cutout
of the magnifying glass, leaving just the
framework. Even the glass portion should
be removed.

f. Save as a PNG file (see Figure 02).

c. Leaving the cutout on a transparent
background, save it as a PNG file (see
Figure 01).

Figure 02.

3. In Producer, drag the photo you want to
magnify into a slide that’s at least 20 seconds long.

Figure 01.

4. Duplicate the image and zoom this duplicate to approximately 200%.

2. Still in your image editor, create a mask
that’s just the circular glass portion of the
magnifying glass.

5. Add the mask you created.

a. Before you do this, choose to “Save
As” so you don’t inadvertently save
what you’re about to do over your cutout image.

6. Current layer order:
a. Layer 1 – Mask
b. Layer 2 – Enlarged image

b. Select just the circular area where the
glass was and fill it with white.

c. Layer 3 – Original image
7. Select Layer 1 and make it a grayscale
mask.

c. Invert the selection and paint all that
area with black.
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8. Using however many key frames are
required, move the mask around the image just as you’ll want it to move in the
final slide, remembering to pause it whenever you want the magnified image to remain for a moment onscreen.

Example image used (Figure 04):

9. Once you have all the movement set,
right-click the mask layer and choose to
duplicate it.
10. Right-click the duplicate (Layer 1) and
use “Select” to replace it with the cutout
image of the magnifying glass. This does
two things:
a. It places the cutout in the Layer 1 position where it needs to be.
b. It contains the exact key-framed mo
tions you set for the mask so you don’t
have to manually set everything.

Figure 04.

11. Preview the slide and tweak timing
and fades if necessary.
The image below shows the setup (see Figure Result with applied effect (Figure.05):
03). (The preview does not represent the final effect.)

Figure 05.

Figure 03.

Variations: You don’t have to use a magnifying glass. It could just as well be a picture frame,
eyeglasses, a monocle, or whatever else you care to
dream up.
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Notes

• You may find you have to add small
amounts of motion to the magnified layer,
particularly when using the photograph of
a group of people such as a school class
picture. This is because you need the
blowup of a face positioned exactly as it
would appear if a real magnifying glass
were used to view the image.

• No two images are alike, which means
you’ll have to make adjustments in magnification and motion. For this reason, the
instructions can be no more than a general
guideline.

• You can add a shadow beneath the magnifying glass that travels along with it.

89

Section VII
Transitions
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Survey of Transitions
By Barbara Coultry

Standards

20 seconds, less of the incoming slide will have
faded in by the 5-second mark using Crossfade
(Blend) than when using the Linear version. For
short transitions, the difference is negligible. It may
come in handy, however, if the fade is part of a special effect where a monumentally long transition is
required.
It’s easier to say how not to use a crossfade
than how to use it. In film, the crossfade indicates
either a distinct shift in time or place, and it’s sometimes used to open the first scene and close the last,
but where does that leave us? Below are a few things
to consider:

Figure 01. Cut, crossfade, and random.

Cut
Is there a strong beat?
If so, we might want to use
the cut, which forces a
photo to pop onto the
screen in perfect sync with
the beat. The cut is good for
cheerful shows, for making
strong statements with specific pictures, and for creating a sense of activity.
The cut is often ignored, perhaps because
ProShow installs with one of the crossfades as the
default or because we think transitions are the rule.
The software shouldn’t make decisions for us, and
there are no rules.

• Shorten the transition time. Slow fades
serve no purpose when simply going from
one picture to the next.
• If the outgoing and incoming slides have
motion, stop the motion just prior to and
just after the transition. The reason is that
a transition is itself a type of motion. When
you blend two slides in motion, you can
easily end up with a swirling mess. (Gold
users: try static duplicates of the two slides
in between the two in motion—Motion
Slide A to Static Slide A to Static Slide B
to Motion Slide B.)

Crossfade
• Because music has its own transitions—
most noticeable when going from verse
to chorus—a longer fade matching the
musical transition’s length can be effective.

It comes in two flavors…
Crossfade
(Blend): The transition
begins slowly, picks up
speed, and then slows
back down.
Crossfade (Blend) – Linear: The transition
goes at a constant rate of speed.
…which means that, if the transition is set to

• Even if you’ve decided to use the
crossfade exclusively in your show, watch
out for using identical timing throughout.
A consistent two-second crossfade
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throughout a show coupled with five-second slides can turn hypnotic, which results
in a sleeping audience.

Door

Choosing to randomize transitions means
you’re relying on ProShow’s
artistic abilities, of which it has
none. A chisel can’t create a
marble sculpture, and ProShow
can’t create slideshows. Only
you can do that.

After the top two rows in
this set, ProShow has uses names
other than “door,” calling them
double wipes, but they’re really
still just doors. The door wipes,
particularly those in the first four
rows, are an excellent way to go
between photos because they
have a natural feel rather like
opening a door or a window onto
a scene.

Basic Wipes

Fan

Random

This transition is
another with a natural
feel to it, perhaps because it’s reminiscent of
curtains being drawn
back manually or of a
spotlight expanding.

The basic wipe is… Well, it’s basic. One thing
to pay attention to is the direction of movement. For
instance, if you have a portrait of Granny whose head is
slowly lopped off by a wipe
going from the top to bottom,
she’ll be less than pleased.
Choosing a soft-edged wipe
that goes left or right might
be less traumatic. Save the
diagonal wipes for photographs where the composition is diagonal such as a
coastline that’s running from the bottom left of the
photo to the top right. Go with the flow of the picture, not against it.

Circular Wipes
Though you may
gravitate toward the softedged variants of the circular wipe, test the hardedged style because it has
a strong graphic quality to
it that might work better in
your situation.

Double Wipe
It goes in two directions at once. It
splits the incoming slide in
half, then has those halves
come at each other from opposite sides of the screen. Because it has the potential to
split photographs at peculiar
points, watch the effect it has
on a set of pictures very closely.

Center Wipes
Though all the
above transitions have
names specific to their
shapes, we can group
them according to their
direction of movement,
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Push Wipes

which is to either spread out from or go in toward
the center. The top three rows use sedate shapes—
rectangle, circle, diamond—and are, perhaps, the
better choices when doing a serious show. Once you
get down to stars and hearts, use caution. Their
shapes should match the both photo content and
overall flavor of the show.

The incoming slide appears to push the outgoing slide off the screen. The
top two behave like a slide
projector does and are,
therefore, natural-feeling
transitions. The two immediately beneath aren’t quite
as natural, but they do work
well for landscape-mode
pictures. The bottom four
split the outgoing and incoming slides, and should
be used with caution, paying close attention to how
they’re splitting the pictures. Some photos can be
split at unfortunate points.

Pattern Wipes
Like the
center wipe, these
transitions go by
various descriptive names, but
they all have one
thing in common—patterns.
Often, they don’t
work well for
deeply serious
shows because they draw so much attention
to themselves with their dots and stripes and swirls.
They’re happy little transitions, and so they’ve no
place in a memorial show, for instance, but a birthday or vacation show might welcome them.

Radar Wipes
This is an interesting
transition if not overused, and ought to be
matched with the idea of
the image (a clock, for
instance), or with the
idea of the show. It has
a special use in making
a border travel around a
picture. (See “Moving Border” pgs. 97–98.)

Block Wipes
Again, each of these
transitions bears a descriptive name, but what
they all have in common is
rectangles or blocks. More
than any of the other transitions, good judgement is
required for their use.
They’re best for an upbeat,
quick-moving show with
equally upbeat, quickmoving music. That said,
if the transition time is
stretched way out, watch
for interesting effects!

Slide Wipes
The second slide
comes in over the first
(as opposed to the
push wipe where the
second slide pushes
the first slide out of the
way). For those who
use Producer and have
key frames, this transition can create the effect of one picture sliding out from within another. (See “Picture Emerges
from Another” pg. 95.)
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A Few Transitional Thoughts
by Barbara Coultry

• Transitions add motion to a show. It’s
possible to never rotate, pan, or zoom a
single photo but still have a dynamic show
because of transition. Imagine three photos on three separate slides. Photo A is
placed to the left of the screen, Photo B in
the center, and Photo C at the right of the
screen. Using a cut between the photos,
you can make the photos blink on and off,
thus creating a sense of motion without
ever literally applying motion. By having
a long series of such photos with cuts, you
can easily synchronize the quickly appearing pictures to upbeat music.

• Keep the variety of transitions down to
a minimum. Constantly changing transitions can distract the audience, leading
them to wonder what special effect will
come next instead of wondering what picture will come next.
• Try to match the transition style to the
show: sedate transitions for sedate shows,
funky transitions for funky shows.
• Match the motion and idea of the transition to the picture. For instance, a photo
of the sun is amenable to the starburst transition. That same sun followed by a setting sun and combined with horizontal
window blinds could be like watching
through a window as the sun sets. Think
of the connotation of the transition, what
it looks like, what it reminds you of. Have
a solid reason for choosing one transition
over another.

• Suggestion: In Preferences, change the
default transition to a cut. When you’ve
added the soundtrack, watch and listen.
The cut gives you a clean slate, allowing
you to consider if you even want a transition, and then if you do, what sort of transition you should use. Otherwise, the standard crossfade is pushed onto you.

• Fades can create extremely unfortunate
mixtures. Think about the effect of a photograph of your mother-in-law fading into
one of the family dog. Probably not a good
idea.

• Those who use Producer have the ability design their own transitions with masks
and key frames. If the transition doesn’t
exist, design it.
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The Cut – What It Can Accomplish

There are two layers—Image One and Image
Two.

• Create a sense of motion in a series of
nearly identical pictures.

1. Layer 1: Image One, which slides out
from the “slot”

• Create motion by “popping” a series of
pictures onto various parts of the screen.

• Reduce size to 50% or less

• Surprise the viewer.

• Add an outline and drop shadow
if desired to give it a look of depth

• Emphasize an image, particularly when
coupled with a hard beat in the music.

2. Layer 2: Image Two, kept full-sized
3. For layer 1, move key frame 1 to the
point where you want the picture to start
sliding out of the cut and into view.

Picture Emerges from “Slot” in Another
Image

4. Again for layer 1, choose one of the four
transitions listed above. The choice depends on the direction in which you want
the image to move.

This is a simple trick using one of four similar
transitions: Slide Left to Right, Slide Right to Left,
Slide Top to Bottom, or Slide Bottom to Top.

Figure 01. Slide begins.

Figure 02. Slide continues.
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3. Override the background color on the
blank slide, making it white (on the Background tab)

Coming-into-focus Effect
A blurred photo is brought into focus, simulating the way a camera focuses.
(These directions are for Photoshop, but
equivalents should be available in a number of image editors.)

4. Set the duration of the white slide to
0.1 second and the transition to Cut
5. Add the flash sound effect to the white
slide.

1. Using a sharp photo, apply a Gaussian
Blur of 40.

6. Locate the image that you want to appear after the “flash” occurs, and drag it
into a new slide immediately following the
blank white slide.

2. Make sure to use “Save As” when saving the file so you don’t overwrite the
original.

7. The easiest way to set up a series of
such flashes is to copy the white slide and
the image slide, then paste them immediately following the previous set, replacing the image with the one you actually
want.

3. Place the blurred image in the first slide
and set its timing to .6 seconds.
4. Place the sharp image in the second
slide, setting its timing to 2 seconds or for
however long you want it to remain
onscreen.

Lightning
5. Between the two slides, use the
Crossfade (Blend) transition with a timing of 5 seconds.

1. Insert a white slide between two copies of the slide where you want the effect.
Alternatively, use another copy of the
photo processed so it’s extremely light and
faded.

Camera/Lightning Flash

2. Use a fade transition of extremely short
duration (fraction of a second) on both
sides of the white slide.

Camera
1. Selecting the slide where you want the
effect to begin, give it a starburst-out transition of 0.1 second. (The actual effect
begins following this slide.)

3. By duplicating the second two slides,
you can create a double-lightning effect.

2. Insert a blank slide immediately after
the above slide.

Figure 01. Camera flash.
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4. Add a border to the image in slide 2.

Moving Border Effect for Gold

5. Use the Radar-Clockwise transition.
Method One:
6. Set the slide time to 0 seconds and transition time to around 6 seconds.

1. Drag your selected photo into a slide.
2. Double-click the slide and go to the
Motions tab, setting the zoom to 50%.

Note: Border width isn’t adjustable in Gold,
so if you want a different width, use your image
editor to add a border, using a copy of the image.
Put the border inside the photo to avoid a mismatch
of sizes and thus having to adjust the zoom in PSG.

3. Click on “Copy All to Next” to place
an exact copy in the next slide. Click
“Done.”

Method Three:

4. Drag the same photo to the second slide
while holding down the control key as you
drag.

1. In the second slide, add a solid color as
the second layer.

5. Double-click this second slide and go
to the Layers tab.

2. Adjust the zoom of the color layer to
get the desired border size.

6. Select Layer One and click on the
down-arrow to change its position to
Layer 2.

3. Use a radar transition.
NOTE: Try other transitions to alter the effect.

7. Go to the Motions tab, select Layer 2,
and set the zoom at 51%.

Moving Border Effect for Producer

8. Click on Copy to End.

1. Add an image to a slide.

9. Click on the Edit tab, select the outline
box, and then click on Select Color.

2. Set the slide time to about 5 seconds.

10. Choose white or any other color you
want and then click “Done.”

3. In Layer Options, reduce the image size
to about 60 or 70%.

11. For the transition, choose RadarClockwise.

4. Duplicate the layer.
5. In Editing Options, add an outline in
the color of your choice, setting the
outline’s size from a fine line up to a thick
one. (The maximum size is 5.)

12. Set the timing for whatever speed you
like.
Method Two:

6. In Motion Options and with Layer 1
selected, change the transition-in to “Circular Wipe - Right to Left - Soft edge”

1. Place the chosen image in slide 1.
2. Adjust the zoom to what pleases you.

7. Drag the transition time all the way to
the end of the timeline.

3. Using “Copy All to Next,” place the
same image in slide 2.
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Variations:

2. Open the blank slide and click on
“Background.”

• Instead of the circular wipe, try…
3. Change the background to the color you
want your transition to be.

• Radar-Clockwise-Soft edge
• Wipe-Top to Bottom-Soft edge

4. Set the transition time for the first image slide to 0.

• Doors-Open-Soft edge
5. Set the blank slide’s duration to 0.
• Fan-Close from Top-Soft edge
6. Select a transition for the blank slide.
You can set this transition to last as long
as you want, but short times of .5 to 1.0
may look best.

• Wipe-Upper Left to Lower
Right-Soft edge
• To lower the opacity of the outline, lower
the opacity of layer 1 in Editing Options.

Variation:

• Colorize layer 2 in keyframe 1 so it starts
out as black-and-white and turns into full
color as the outline develops.

Instead of setting the background to a flat
color, use a gradient or an image.

• Vary the slide time and the image size
to suit you.

Transition Through Black
One image fades out to black and the next
comes up through black.

Custom-colored Transitions
ProShow does not offer the ability to change
the color of transitions, but this workaround enables
you to change their color.

1. Insert a blank black slide between the
two images
2. Set the blank slide’s time to zero.

1. Insert a blank slide between two image
slides.

3. Pick transitions on either side, using
duration to control the length of the entire
transition.
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Section VIII
Templates
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Template Tutorial
by Iris Cooper

What a Template is
A template is a detailed outline of all the settings and effects in a particular show. By default, it
contains none of the media (images, videos,
soundtracks) from the original show.
A Template’s Purpose
1. A template saves time. Simply add pictures, and they’ll automatically take on the
movement, key framing, rotation, opacity, size, etc. that were applied in the original show from which the template was
made.

• In place of the images, there are gray
placeholders ready to accept new images.
• If you choose “Show > Show Templates
> Save” to turn a show into a template,
you must manually choose to save images
from the original show for them to become
part of the template.
• A show’s sounds are automatically saved
in the template.

2. A template aids learning. Shared templates give people the opportunity to study
intricate settings or movements such as
key framing attached to images and captions.
What a Template isn’t
Sometimes people share their actual slide
shows—the .PSH files—and call them template,
which they aren’t. They are regular show files and
nothing more.
Template facts:
• It has a .PST extension added to the file
name
• It can only be opened via the “Show>
Show Templates” menu.
• Once opened, it immediately becomes a
new show in its own right but without
images unless those images were deliberately saved as part of the template.

• If you choose “Show > Show Templates > Export” to save a show as a
template (usually done for the purpose
of sharing a template with others), all
images and all sounds from the original show are removed. The end user
will be presented with a “File Not
Found” warning, and prompted to
search for the files.· To share music
and images along with a template
made by the Export method, you must
collect them separately, uploading
them along with the template.
• When you Import a template created
on another machine (by you or someone else), even if sounds or images
were originally attached, they won’t be
included in the import. You’ll get a
“File not Found” warning with a
prompt to search for the files. If you
happen to have the files available, you
can opt to search, pointing Producer
to the correct location.
• Producer’s ready-made templates are
stored in the following directory:
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• Program Files/Photodex/Producer/templates

Templates> Open Template”
• Select the template named 3_Minute
Show and click “Load”

• Templates you’ve created are stored
in the following directory: Documents and
Settings/<username>/Application Data/
Photodex/Proshow Producer/Templates

• Working in Slide List view with the
Folders List visible on your workspace,
select the folder containing the pictures
you want to use.

Opening a Ready-Made Producer Template

• When learning, it can be easier if you
set the folder list to display as thumbnails.

Producer comes with a few packaged templates. For instance, there are “3_Minute Show,”
“5_Minute Show,” and “10_Minute Show.” To access them…
• Open Producer

• Click the first image you want to use,
and drag it to the placeholder visible in
slide #2. When the picture appears inside
the placeholder, release the mouse button
(Drag-and-Drop Method).

• Go to “Show > Show Templates > Open
Template”

• Slide #3 has two placeholders. Doubleclick the slide to bring up “Slide Options.”

• The “Load Show Template” dialogue
box appears

• Go to the Layers tab and look at the Contents of Slide section

• Available templates are listed to the left
of the dialogue box

• Click to select layer 2 <No Image>

• Click to highlight a template in the list

• To the right of the screen you’ll see the
Selected Layer controls. Click “Select
File” and navigate to the file you want.

• The show name and description will display to the right of the box

• Repeat for layer 3 on this slide

• Click “Load” to open the template

• Double-click slide #6 in the timeline to
open Slide Options.

• Add your images to the gray placeholders, the method for doing so described in
“Placing Images in a Template.”

• Select a blank image layer.
• Right-click the blank image layer and
choose “Select File” from the menu that
appears (Right-Click Method).

Placing Images in a Template
Depending upon the complexity of the template, getting your own pictures inside the correct
placeholders can, at times, be difficult. Learn by
using one of Photodex’s simple templates such as
“3_Minute Show.” Proceed as follows:
• Open Producer and go to “Show> Show

• Navigate to the image file you want to
use.
As shown above, there are two ways to get your
own images into a template’s placeholders. When
trying to populate a busy template with your own
images, it’s easier to use the right-click method,

101

particularly in a multi-layered slide where the dragand-drop method is tedious because of overlapping
placeholders.
NOTE: Not all templates are created equal.
Some templates are easier to use than others. In a
few, you may even find that inserting an image at
the start of a sequence results in the image being
magically copied over to other slides. It means a lot
of the hard work has been done for you, and you
can rejoice.
However, you can also find templates with
particularly fascinating sequences demonstrated in
a sample show, but you’ll end up having no idea
what image goes where in the template. No rejoicing here. It’s up to you to figure it all out.

Create and Save Your Own Templates
• Open or create the show you want to
base your template on. If you’ve just created a show from scratch, make sure you
save it first; otherwise, you risk losing the
original show.

box appears, type a name for your template in the box provided.
• Add a description to remind you and anyone else of what the template contains.
• Click Save.
• The template retains the images you
specified along with any music that was
part of the original show.
• When the dialogue box disappears,
you’ll immediately see a difference. Any
images you didn’t choose to retain will
have been replaced by gray placeholders
in the show. Your original show will have
been closed when the template was saved.
The current show you are viewing is a new
show. (Check the title bar at the top of the
screen where you’ll see “Untitled
Proshow.”)
• Trying to close Producer at this point
will bring up a prompt for you to Save or
Don’t Save this New Show. If you haven’t
made any additions or changes since you
opened the template, it’s safe to close
without saving. However, if you’ve added
any images to the Slide List or made any
other changes, this new show must be
saved in the usual way or you’ll lose it.

• If you want to retain some of the images
such as a title slide or frames, go to “Slide
Options > Layers” and locate the “Show
Template Settings” box for the image
layer you want to keep. By default, the box
is checked, indicating that the image will
be removed if the show is saved as a template.
• Uncheck the Template/Replaceable image box for each and every image you
want to retain.

Template File Directories
Though you may have read instructions about
copying and pasting downloaded template files into
a specific location so they’ll appear in your available templates list, this isn’t necessary. Producer’s
Import and Export features are simple to use and
get the job done. If you use the Import feature effectively, the list of available templates you see whenever you access the “Show> Show Templates” menu
will display in a relatively organized manner.
Photodex’s own templates will always appear at the

• When you’re done, go to “Show > Show
Templates > Save as Template.”
• A dialogue box appears reminding you
that all content (apart from what you have
chosen to retain) will be removed. Click
OK.
• When the “Save as Template” dialogue
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if the template is on your Desktop, then
the word Desktop needs to be showing in
the “Look in:” window, or if it’s on a removable disk, then the appropriate drive
letter and/or folder must be displayed in
the window.

top of the list, and then any templates you’ve saved
or imported will be beneath and in alphabetical order.
The Two Directories for Templates:
• Templates that are built-in to the software and those that are inserted by way
of downloading extras from the Photodex
site are placed here: Local
Disk(C:)Program Files/Photodex/Producer/templates

• With the correct location specified, locate the template name in the main window, click it to select it, and then click
“Open.” You can also simply double-click
the template name.

• Templates you’ve created (on your machine) or those created on another machine
and imported using Producer’s Import feature are placed here: Local
Disk(C:)Documents and Settings/
*username*/Application Data/Photodex/
Proshow Producer/Templates

• Producer confirms the template has been
imported by way of a small dialogue box.
Click OK when you see it.

Photodex’s stated reason for having two separate directories is that a user’s own templates are
saved to the Windows Profile so that, if you back
up your system, the settings will “probably be included,” depending on which version of Windows
you use and the kind of backup method you employ.

How to Use the Import Feature Effectively
Producer will accept a show template created
and saved on a different machine. You may have
downloaded a zipped file from the Forum that contains the template (and any images, etc) that you
extracted to a convenient location such as your Desktop, or you might have your own template that you
perhaps created on a 2nd machine and saved to removable media. In either case, proceed as follows:
• Open Producer and go to “Show > Show
Templates > Import Template”
• The “Template File Name” dialogue box
appears
• Navigate to the location or drive where
you have the template file. For instance,

• With the template imported to its default location, you can now open it by
going to “Show > Show Templates >
Open Template.” As you can see, there’s
really no need to go poking around in the
system folders at all.
Important Reminders on Opening Imported
Templates
Templates from others come from shows originally containing images and music on other machines. More often than not when opening a template, Producer will announce that some files are
missing. Unless you’ve downloaded a corresponding batch of files to use with the template, just select NO when prompted to locate
them. The template will load and the empty placeholders will display the following text: FILE NOT
FOUND. On the other hand, if you have the accompanying image/music files saved to your PC, select
YES and point Producer to their location.
Of course, if you do have the accompanying
image/music files saved to your PC, then select YES
and just point Producer to their location, but note
that the next time you open the imported template,
you may be again prompted to search for the files
even though the source files are in exactly the same
location you last pointed Producer toward. If this
happens, save the template again, overwriting the
template as follows:
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1. Open the template, follow the prompt
and locate the files.

• When the file-removal reminder appears, click OK

2. When the template/show fully opens
in the Slide List view, go to Show > Template > Save as Template.

• Give your template a name, add a description, then click Save
• The template appears as a new show in
the Slide List, replacing your original
show. Your original show remains safe.
It is not altered by the steps you took to
create the template.

3. Enter the existing name for the template and click Save.
4. When Producer asks if you want to
overwrite the existing file, click OK.

• You can now go straight on to Export
the template: Show > Show Templates >
Export Template

5. Producer will open the full template
from then on, but as with any show, you
must not move or delete the source files
or you will be back to square one.
As soon as a template is opened it becomes a
new show. It displays in the Slide List view and is
ready to accept your images. When you next close
the software, you’ll be prompted to save the show.
Proceed as you would with any show. The template
itself will not be altered.

• Locate the template in your available list
and click Export.
• Choose a convenient location to export
it to, for instance the Desktop or perhaps
a folder you’ve created just for this purpose.
• Click Save, and you will receive confirmation from Producer that the file has
been exported.

How to Use the Export Feature Effectively
You’ve created a show containing movement
and sequences you’re proud of, and you want to
export it to use on your 2nd machine, or your fellow
Enthusiasts are keen to have it as a template. First,
here’s how to create a basic template, meaning it
has no retained music or images. This basic template is user-friendly—it won’t display those irritating File Not Found labels at the other end of the
user chain:
• Open the show, go to Show >
Soundtrack, and remove any music

• The exported template file is now safe
in its exported location until you are ready
zip it and upload it to the Forum or friends.
The original template will remain in your
list of available templates.
NOTE: You can use Producer’s export feature
any time you want. You don’t need to have a show
open; you just need to have the software itself open.
You can even export a template while you’re working on another show. It’s a quick and simple process.

• Next, remove any sounds you may have
attached to individual slides using Slide
Options> Sounds

How to Make ProShow Enthusiasts
Love You

• Save the show as a template (Show>
Show Templates> Save as Template)

Following is the process for creating and exporting a template along with accompanying images
and soundtracks. The process is more detailed and
methodical, but your fellow Enthusiasts will love
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machine, you should go to “File > Collect Show Files” and collect the files to a
convenient location. To aid the collection
and export process further, create a folder
clearly labelled with the name of the template where the resulting audio, image, and
video folders from the collection process
can go.

you for it. Just make sure you don’t break any copyrights laws while doing so.
1. Create or open a full show on which to
base the template.
2. For each layer/image that you wish to
retain, open “Slide Options> Layers” and
uncheck the Templates box in the Show
Template Settings section.

7. Go to “Show > Show Templates > Export Template,” and select the template
from the available list, and then export it
to the folder you created in the previous
step.

3. Save and name your template.
4. The template immediately appears in
the Slide List as a new show. It will be
displaying only the specific images you
opted to retain along with any music or
sounds attached to the original show.
5. Save this bare-bones version of the
show: Yes, that’s right. Saving it at this
point is necessary to the next stage, which
involves collecting the files it contains.
Click the Save icon or go to “File > Save”
and save it anywhere you like—it can be
deleted once the template has been exported successfully.
6. To isolate the files needed to successfully open/display the template on a 2nd

8. The template and all its necessary accompanying files are now in one place and
ready for you to upload to the forum or
send to another machine. On opening the
template on a new machine, Producer just
needs to be pointed to the relevant, accompanying folder location to extract everything it needs.
Last word: If you’ve built a show as if it were
a template—a pattern you can use again and again—
you’re best off saving it as a template if for no other
reason than your habit of saving often as you work.
It’s the easiest thing in the world to mistakenly save
over your file, altering what you never intended to
alter.
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Insert Part/All of Template in Show
If you while creating a show you want to add a
template sequence (or sequences) you either created
yourself or downloaded from the forum, bear in mind
that Producer can display only one show at a time
unless you’re working in a Project, so to make cutting and pasting between templates and your show
easier, you should work in project mode. To do this:
1. Open the show into which you want to
insert one or more templates (or parts of
templates).

2. Right-click on any slide and choose
Select All if you intend to use the entire
template, or if you want to lift out just a
particular sequence in a template, select
the first slide in the sequence, hold down
the Shift key and select the last slide in
the sequence.
3. To add to a selection, press and hold
Ctrl as you select further slides.
4. With the correct number of slides selected, right-click one of the selected
slides and choose Copy.

2. Go to Project > Save Project.

5. Click on the tab for your current show
to bring it into view on the Slide List.

3. The “Create Project” dialogue box appears.

6. Determine where you want to paste the
template. For example, if you want the
template sequence to begin at slide position #5, you must right-click on the slide
already in position #5 and then choose
Paste.

4. Click “Create Project.”
5. The “Save Project” file dialogue box
appears.
6. Choose a name and location for the
project and click Save.

When you’ve finished working with a particular template, you can remove it by right-clicking on
the named tab and select Remove Show. A box will
appear prompting you to save the show. Since you
haven’t altered the template by copying slides from
it, it’s safe to choose No.
Once you’ve inserted a template or templates
into your show, you can put your own pictures into
the placeholders, using whatever method you prefer.

7. Now go to Show > Show Templates >
Open Template.
8. Select the template you want to use and
click Load.
9. The template is now visible as a 2nd
show in your project.
10.Open further templates in the same
way if required.

A Template of Templates

(Your original show and any template you have
open will have individually named tabs. If you can’t
see the tabs, right-click on the toolbar or on the title
area of any panes visible in the workspace and select Show > Show info.)
To insert the template or templates into your
show:
1. Select the required template tab so the
template show is visible in the Slide List.
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If you’ve created effects you’d like to reuse,
build a single show that includes each of the effects,
separating the effects by inserting an odd-colored
slide or an introductory slide describing or explaining the effect. Save it as a template, and then when
you start a new show, create a Project, bringing in
the template and then creating the new show. You’ll
have two tabs, one being the template and the other
your show. You’ll now be able to copy and paste
parts of the template into your show.

2. Open the newly named show and substitute the pictures with new ones.

Templates for Gold
1. Use an actual show as a template by
choosing “Save As” to save it under a
new name.
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Section IX
Output
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Menus

4. You’ll be prompted to create a project.
Do so.

Create Plain Background Inside
ProShow

5. Drag the thumbnails to where you want
them.

1. Choose a menu background pattern.
2. Select a menu background color.

6. Using the zoom slider, you can change
the thumbnail size.

3. Reduce the opacity of the background
layer to 0 so only the background color
shows.

7. Go to “Captions” where you can change
the title and thumbnail captions’ font,
color, size, opacity, and position.

4. For a little texture in the plain background, increase opacity.

8. If there’s any default text you don’t
want to appear, uncheck the box next to it
at the top of the screen or delete it.

Save Custom Menu Layouts

9. When everything is precisely as you
want it, choose “Save Layout.”

1. When creating output, choose Menus,
and then choose the layout closest to what
you want.

10. Name the new layout and click
“Save.” It will be saved to the Menu folder
within the ProShow program folder and
will appear in the list of layouts along with
the default layouts.

2. Click “Customize Menu.”
3. In “Shows,” add your shows.
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DVD Creation

The Screens
Menus is where you design your menu (see
Figure 01). Choose a background from the thumbnails at the top of the screen, select the format (4:3
or 16:9), pick the number of thumbnails and their
layout for a single show or multiple shows, and replace the default title (“Photodex ProShow”) with
your own. If you click “Customize Menu,” you’re
presented with a further series of sub-screens.
Figure 02

Shows is where you can add more shows to
the menu, change the titles and thumbnails for the
shows, and alter the position and size of the thumbnails. You can change thumbnail behavior, too, but
take note that this applies only to .exe (computer)
and .px (Web) shows. For these last two, you can
change the Highlight Colors or even eliminate them
entirely. As on the “Pages” screen, the “Shows”
screen gives you the opportunity to save both theme
and layout (see Figure 03).
Figure 01.

Pages is where you can change the default title
to a descriptive one, choose whether to loop all
shows, change the background color and image, and
pick from “Fit to frame,” “Fill frame,” or “Stretch
to frame” for the background. At the bottom of the
screen are buttons to save the complete design as a
Theme or just the placement of items as a Layout
(see Figure 02).
Figure 03.
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Layers is where you can alter the position and
zoom of backgrounds and thumbnails. You can also
select replacement images for any of the layers. If
there’s a video clip, you can trim it and change the
volume if sound accompanies the clip. For DVD’s,
your only options in the Destination drop-down box
are shows (see Figure 04).

Captions allows you to change the font, font
style, color, opacity, size, alignment, and position
of any of the captions. Additionally, you can add a
drop shadow and an outline to the letters (see Figure 06).

Figure 06.

Figure 04.

Editing is for altering the appearance of each
of the layers by using sliders for opacity, brightness,
contrast, etc. You can create outlines for the layers
as well as “colorize” images by clicking on Colorize,
then choosing a color to replace all the blacks and
grays in the image. Additionally, you can add a drop
shadow to an image, including a show’s thumbnail
(see Figure 05).

Music is for adding a soundtrack that plays only
while the menu is onscreen. Use the Fade In/Out
sliders to control the volume at the beginning and
end of the clip. “Custom Music for This Page” allows you to choose a separate music file for a second menu page (see Figure 07).

Figure 07.

Figure 05.

If you’re using part of a longer piece of music
and you want more control, click on “Edit Fades
and Timing” to bring up the sound-editing screen
where you can choose what portion of the music
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you want to play along with adding fades. The Zoom
slider enlarges the waveform so you can fine-tune
cuts and fades (see Figure 08).

are causing flicker and add a slight blur to
those areas in an image editor.
• “Desaturation” is there to prevent the
garish colors that can result when a TV is
not properly adjusted. You’re better off
getting people to adjust their sets because,
if this option is chosen, all images appear
washed out on properly tuned sets.
• Encoding Quality refers to the quality
of the final video image. Choose “High
Quality” unless you have problems with
file size.

Figure 08.

Once you’re done with menu design, click OK
to go back to the “Create DVD Disc” menu.
Output Options is the more technical side (see
Figure 09):
• The two recommended DVD types are
HQ Maximum and HQ Safe. The other
settings are there to accommodate the rare
show that’s a bit too large to fit on a DVD.

Figure 09.

Color Profiles allows you to accept ProShow’s
default color profile or another profile that’s on your
computer. Pay attention to the “NOTE” toward the
bottom of the screen and the explanation given about
selecting color profiles (see Figure 10).

• In “TV System,” choose either NTSC
and PAL. The U.S. uses NTSC while
much of Europe uses PAL. To know for
sure which system your country uses, look
it up in the ProShow manual.
• In audio type, choose PCM.
• “Anti-Flicker” is used to help reduce the
sparkling effect that happens at its worst
during diagonal motion across the screen.
Choosing this will reduce flicker, but it
also applies a slight blur indiscriminately
throughout the images. Another way to
handle flicker is to choose those areas that

Figure 10.
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PC Autorun directs ProShow to build a separate executable file that will run automatically when
inserted in a computer’s DVD drive. By default, this
option is turned on, but if you’re creating the disc
purely for playback on TV, you can turn off this
option. The various settings are a match to those
where you’re creating a straight executable for computer viewing only (see Figure 11).
Branding options are exclusive to PC Autorun
where there’s always a progress bar showing how
much of the slide show has been loaded. You can
select a background image, type in text that you want
to appear while the progress bar is active, change
the title that shows up on the Window bar when
the show is playing, change the Photodex icon
to a custom icon, create an “About Show” that can

be accessed during PC playback via a right-click,
and when you’re all done with the above, you can
save your branding settings (see Figure 12).
Disc Burning is where you choose to burn the
disc directly from within ProShow or to create an
ISO image file, which can be used to burn the DVD
with separate, dedicated disc-burning software. If
you choose to burn from within ProShow, don’t
choose “Max” speed. The recommended burning
speed is 8X. Leave “Simulate” unchecked—it’s only
for when you’ve chosen the CD (MiniDVD) disc
type. The option to “Include original files on DVD”
allows you to add the original image files as extra
content on the disc. “Include Additional Content”
allows you to browse for a folder containing even
more files to include on the disc (see Figure 13).

Figure 11.

Figure 12.

Figure 13.
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Etcetera

Sound

make the common mistake of trying to burn the ISO
to a data DVD, which won’t play in a DVD player.

Leave at PCM, which is the standard. MPEG2
isn’t compatible with 100% of the DVD players.

Rendering Speed of Previously Burned
Shows
When you render a show, a folder is created
that’s called <NameOfShow>_psdata, which contains the files necessary to burn the DVD. If you
make no changes after burning a DVD, ProShow
will re-use the data in that folder. The show won’t
have to be re-rendered, thus reducing the time required to burn a second DVD. If, however, you make
changes, the show will have to be rendered all over
again before burning.

True Size of a Widescreen
To check, measure the width of the picture on
your screen and divide by the height. If the answer
is 1.7777, it is 16:9. If it’s 1.5555 it is 14:9.

ISO
To create an ISO image, on ProShow’s burn
menu where you select your drive, one of the options is for the “ISO burner” or words to that effect.
Select this, and when prompted, enter a location and
file name of your choice. Once the ISO has been
built, you can use a number of different third-party
programs to do the actual burning to DVD. Many
on the forum use ImgBurn (free), but if you have
Nero or Roxio, these will work too. Just make sure
you choose to burn the DVD from the ISO. Don’t
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Add Extra Content to DVD
In output options, click on the Disc Burning
tab and place a checkmark in the box to “Include
Original Files on DVD.” You can then either burn
the DVD in ProShow or create an ISO to burn with
a third-party application. Photos used in the show
will be inside a folder on the DVD.

Media
Type—There’s no single answer to which
brand and type of DVD to use, though there’s a consensus of forum opinion that points to –R, not +R.
Brand—It’s worth spending extra for reliable
brand names rather than going the cheaper route of
brandless or house-brand DVD’s. Two in particular
are highly rated amongst members, one being Taiyo
Yuden (online purchase) and Verbatim (online and
at computer and stationery stores).
Speed—No matter the type or brand, it’s best
to burn at a slower rate, most people recommending 8X.
Labeling—There’ve been reports that adhesive
labeling causes problems. The best way to avoid this
possibility is to use other methods, which include…
• LightScribe (requires special disks plus
a LightScribe burner)
• Printable disks (requires white-surfaced
disks plus an inkjet capable of printing on
them)

• Thermal printing (requires a dedicated
thermal disk printer plus blank disks designed for this type of printing)

• Professional duplication, which is more
expensive but is an excellent option if you
need a large number of copies
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.EXE Settings

Playback: Display

Quality

The size of the window when playback is on
your computer.
Window Size is the size of the window that
the show opens in. For example, if your monitor is
1680x1050 and you set the Window Size to
640x480, your EXE show will open within a
640x480 window. If you choose Start Maximized,
the show will open full-screen.

Rendering

Playback: Image Size
Maximum image dimensions. If you set this to
320 x 240, the pictures will be tiny; if set to your
monitor’s resolution, the screen will be filled.
Image Size should be set to the monitor’s resolution. For example, if the monitor is 1600 x 1200,
set it to that; if it’s 1680x1050, set it to that.)
Rendering/Limit Rendering Size should be
set equal to your monitor’s native resolution so that,
even if you watch it in windowed mode, if you go
full-screen mode, it will still look good.

116

The lower you make these numbers, the lower
the quality of the show. Best left unchecked.
Resizing
As with rendering, the lower you make these
numbers, the lower the quality of the show. Best
left unchecked.
If you have high resolution and like to view
full-screen, Playback: Image Size should be set to
your screen’s maximum. The same is true for Quality > Resizing and Rendering settings, either leaving it unchecked or set to the highest resolution you
anticipate a user might have, keeping in mind that
monitors are getting larger and resolutions higher
these days. Unless you have good reason not to, it
should be set high.
Progressive vs. Interlaced: Choose Progressive.

Build Flash Files in Producer
by Dave Fitzpatrick

The instructions that follow are from my own
experiences building Flash videos inside Producer.

General Procedure
After loading a show and adjusting the durations, motions, and transitions to your liking (suggestions for this to come later), choose Create >
Flash Show and select the settings for your flash
show.
Producer will build the show and, optionally,
create an HTML page to host it. Even if you plan to
host it on a different page, I find it convenient to let
Producer build the page since it’s then easy to copy
the HTML code from here and then paste into another HTML document.
If you plan to use the HTML page Producer
creates, you might want to change the page title and
the footer link that Producer generates. Rather than
having it boast that the page was “Created with
ProShow Producer from Photodex Corporation” and
link to the Photodex main page, you can change the
text and the link tag so it links your viewers to a
page of your choice. Also, you may wish to include
a “Back” or “Home” link to return your viewers to
an appropriate page. These changes to the HTML
code can be made in an HTML editor
(Dreamweaver, FrontPage, or any other editor of
your choice). You can also make these changes in
NotePad or WordPad.
To get your video on the Internet for viewing,
you need a domain and a web host to provide the
storage and Internet bandwidth for video stream
download by your viewers. Often, your ISP will
provide limited storage and transfer bandwidth as
part of their service. If you will be doing a lot of
Flash videos for Web distribution, you might want

to purchase your own domain name and secure Web
hosting services through any of the many Web hosts
who provide virtually unlimited storage and bandwidth for just a few dollars a month.
When Producer builds a Flash video, it creates
4 separate files:
<YourFlashName>.html
<YourFlashName>.swf
<YourFlashName>-intro.flv
<YourFlashName>-show0.flv
To give people access to your Flash video, all
you need to do is upload these files to your Web
host and link your viewers to the file:
<YourFlashName>.html

Settings in Producer
In general, single pass, constant bit rate Flash
videos such as Producer creates don’t like a lot of
motion. In broad terms, all video compression
schemes write a “key frame” at a specified interval
and fill in the missing frames with difference frames.
That is, they only store those areas of the frame that
are different from the key frame, copying those that
aren’t from the key frame to the new frame. (It’s
actually much more complex than that, but in general this is what’s going on.)
If there are large differences between the key
frames and the in-between frames, the video needs
a very high bit rate to store the differences to keep
from irrecoverably losing resolution.
So, the trick to getting good Flash videos in
Producer is to limit the frame-to-frame differences
as much as possible.
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In my experience, cuts work better than other
transitions. A 2- or 3- second crossfade, for example,
even if it’s a fade to black, shows a lot of compression artifacts. Zooms and rotations don’t work well
either. I find that step zooms (a sequence of slides,
each tightening in on the subject) with a duration of
0.3 sec or so with cut transitions works better than a
continuous zoom, which often shows a continuous
parade of very noticeable artifacts for the 2 or 3 seconds of the zoom duration.
Finally, there is the video format size. Any
flash videos above a 480 X 360 are virtually useless
unless there is very little motion. The only place
I’ve ever found 640 X 480 Flash videos to be useful
is in screen-capture tutorials where the only motion
is a mouse pointer moving around the screen. For a

typical show, however, the compression artifacts are
so severe as to render a show unwatchable. The
best results from Producer are achieved with a format size of 320 X 240. At this size, however, the
image is too small to showcase photographic excellence, animations, and transitions.
Superior Flash video results can be achieved
using 3rd party compression methods such as On2
VP6 or the H.264 video standard. To employ these,
you must build your video uncompressed from
within Producer and then compress it via a thirdparty commercial package.
A short Flash video that features a number of
different transitions, zooms, pans, etc for comparisons of the resulting quality of each can be found at
the link below:

http://www.visisketchpro.com/FlashVidExample/FlashExample4_480X360_30fps.html
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Increasing the Bit Rate

Flash Settings Used by a Forum Member

Increasing the bit rate can increase the quality.
Try 16000 kBit, being aware that this will also increase file size. For a web show, this isn’t such a
good idea.

Type: Custom
Format: Flash Video
Compression: Video for 768k Broadband

Flash with No Menus
After selecting Flash as your output, click the
Menus icon on the left side of the window. At the
top are all the choices available. Move the slider all
the way to the left where you’ll find “No Menus.”
Select it and then create the Flash show.

Resolution: 420 x 280
Framerate: 23.98
Audio: Include Audio checked
Aspect Ratio: 16:9

Playback Controls

Encoding: High Quality
When outputting as Flash show, you must validate the option “Show playback controls” in Output Options to have access to the play/stop/pause
buttons when the show plays.

Desaturation: unchecked
Anti-Flicker: checked
The above is used only with simple panning
and zooming plus the A/B transition.
The first Producer product demo was set to 800
x 600 output and was 135 MB. They changed the
output dimensions to 510 x 410, bringing its weight
down to 44 MB.

Flash File Won’t Run on Site
Make sure you have the .SWF and.FLV files
in the same folder.
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iPod

1. Load desired show.

7. When you’re finished with the pop-up
window, click “Create”

2. Click on “Create” and scroll down to
select “Video For Device”

8. Another pop-up window will appear
where you select the location for your iPod
movie file. Create a folder specifically for
iPod files.

3. A pop-up window for device output
will appear, and to the left under “Media
Player” select “Apple”

9. Once the video is created, close Producer and open iTunes.

4. Highlight your IPod device from the list
provided

10. Launch iTunes.
5. The pop-up window features “Save Location” and “Profile.” Possibly, the only
option available under “Save Location”
will be “Choose A Specific Location...”

11. Drag and drop the video file into the
iTunes playlist.
12. Right-click on the video in the playlist
and select Convert Selection for iPod.

6. The “Profile” option lists High, Normal, and Low Quality. Select High.

13. Connect the iPod to the computer and
drag the converted video to it.
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YouTube

Quicktime

(thanks to Debbie Green)

Though YouTube quality is still not great,
they’ve increased the accepted maximum size to 1
gigabyte, which helps. Here’s my method:

1. Select Create > Video File.
2. From the Type drop-down menu,
choose Custom.

Create > Video File
Video format preset type: Custom

3. In Format Settings, choose Quicktime
from the Format drop-down menu.

Format settings: mpeg2, mpeg video,
640x480, 30 fps

4. Choose Apple MPEG4 Compressor
from the Compression drop-down menu.

Encoding: High Quality

5. For the Internet, change the resolution
to 320x240. Otherwise, leave it at
640x480.

Aspect ratio: 4:3
Register at YouTube and upload the
video.

6. Set the frame rate to 30.00.

You can force it to play in higher instead of
standard quality by adding this to the end of the URL
when you send the link to someone: &fmt=18
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7. Check the “Include Audio” box to include any audio in the show.
8. Click Create.

Custom Video File

First, choose “Custom” from the drop-down
list (see Figure 14):
In “Format,” choose the type of video file (see
Figure 15):
If compression is required, choose a codec (see
Figure 16):

A Few Standard Video Codecs
Cinepak: Early codec used by Apple
QuickTime.
Huffyuv: Very fast, lossless Win32 video
codec.
Intel Indeo Video: Older codecs.
Intel IYUV codec: (found no info on this
one)

Figure 14.

Lagarith: More up-to-date form of
Huffyuv. Runs slower than Huffy but
compresses a bit more.
Microsoft Video 1: Really old codec
MPEG-1 Part 2: Used for Video CD’s
and sometimes for online video. If the
source video quality is good and the bit
rate is high enough, VCD can look slightly
better than VHS.
MPEG-2 Part 2: Used for DVD, SVCD,
and in most digital video broadcasting and
cable systems. On DVD, it offers good
picture quality. Supports widescreen.
Used for SVCD, it’s not as good as with
DVD, but’s still better than VCD.

Figure 15.

MPEG-2: Old codec, but still used a lot.
MPEG-4 Part 10: (Often called AVC)
A new standard containing significant advances. Used by XBOX 360, PlayStation
Portable, iPod, iPhone, the Nero Digital
product suite, Mac OS X v10.4, and HD
DVD/Blu-ray Disc.

Figure 16.
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MPEG-4 Part 2: Used for Internet,
broadcast, and storage media. Offers improved quality relative to MPEG-2. Supports both progressive and interlaced.
DivX, Xvid, FFmpeg MPEG-4, and 3ivx
are implementations of MPEG-4 Part 2.
WMV: (Windows Media Video)
Microsoft’s family of video codecs which
includes WMV 7, WMV 8 and WMV 9:
It can do anything from low-resolution
video for dial-up Internet users to HDTV.
Choose the resolution. Shown below is a rather
low resolution. You might want to increase it to 720
x 480 for standard TV (4:3) or 800 x 450 for
widescreen (16:9). (See Figure 17.)
Leave the “Framerate” as is.
Assuming you have audio in the show, keep
“Include Audio” checked.

“Encoding” should be kept high unless for
reasons of size and space, you have to reduce the
quality of the video.
Choosing “Desaturation” works only for devices set to overly high saturation, so be cautious
with this one. If the neighbor’s TV picture makes
your eyes tear after a while, and if the show is for
that neighbor, choose desaturation…or teach your
neighbor to properly adjust his set.
If your show has a lot of moving elements that
are likely to cause flicker, you have the choice of
choosing “Anti-Flicker,” which applies a slight blur
to all photos, or you can take the much more timeconsuming route of editing individual photos in an
image editor, applying blur only to those parts that
are prone to flickering such as hard, straight lines.
The safest Color Profile to use is the basic
sRGB profile, though if you know the precise color
space of the device where the video will be played,
you can choose that instead.

Figure 17.
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Play Photodex Show From Own Web Site
by Mike Gregg

If you want to play your slideshows on your own web site but don’t have the storage space to actually
host the show, here’s a solution. The following instructions allow you to upload your show to Photodex
and then link to it from within your own web site to play the show.
Note: this looks more complicated than it actually is. Once you’ve done it, you’ll realize that it’s a
quick process.
First, copy the code below and place it in your web site code.
<script language=”javascript” src=”http://www.photodex.com/presenter.js”></script>
<script>PhotodexObject(“ProShow”,”objectname”,”http://www.photodex.com/shows/
59110_20050129021109.px”,640,480); PresenterControls(“objectname”,640);</script>
At Photodex’s sharing site, click on on the show you want to be displayed on your own web page.
Click on “View Page Source.” (It might be slightly different, depending on the browser you use, but it’s
usually under the “View” menu at the top.) This will display the HTML code for the page. Look down near
the bottom third of the page for a line that looks like the one below:
<script>PhotodexObject(“ProShow”,”ashow”,”http://www.photodex.com/shows/
59110_20050501185241.html”,”580",”435");</script>
Note the HTML file that’s a series of numbers: 59110_20050501185241.html. This is your slideshow’s
file location.
Next, copy just that the long-numbered HTML name, and paste it over the section of HTML code in
your web page shown in bold below.
Example:
Paste over the code highlighted below…
<script language=”javascript” src=”http://www.photodex.com/presenter.js”></script>
<script>PhotodexObject(“ProShow”,”objectname”,”http://www.photodex.com/shows/
59110_20050129021109.px”,640,480); PresenterControls(“objectname”,640);</script>
It should now look like this:
<script language=”javascript” src=”http://www.photodex.com/presenter.js”></script>
<script>PhotodexObject(“ProShow”,”objectname”,”http://www.photodex.com/shows/
59110_20050501185241.html”,640,480); PresenterControls(“objectname”,640);</script>
Change the HTML extension to PX. It should look like this:
<script language=”javascript” src=”http://www.photodex.com/presenter.js”></script>
<script>PhotodexObject(“ProShow”,”objectname”,”http://www.photodex.com/shows/
59110_20050501185241.px”,640,480); PresenterControls(“objectname”,640);</script>
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Save your page and upload it to your server. The slide show should work flawlessly.
Each time you create a new show, just follow the same instructions for each show, getting the file
location from the Photodex site.
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Host a Show on Your Web Site

Creating the Web show

When you checkmark the Create Web Page box
as described above, it generates a basic web page
that is saved in the same location where you saved
your web show file. You’ll recognize it immediately
because it’ll have the same file name.
You can edit the web page yourself by leaving
the box unchecked and clicking the View HTML
button next to Create at the bottom. This creates the
necessary code, which you can copy and paste into
your Web page editor.
When uploading to your site, make sure both
files are uploaded to the same directory. For example, if you’ve uploaded “greatshow.px” and
“greatshow.html” to www.MySite.com, placing
everything in the top-level directory, typing in the
URL “http://www.MySite.com/greatshow.html”
will run the show.

1. Select Create > Web Show.
2. Configure output settings and menu.
3. Click Output Options on the left and
check the box next to Create Web Page.
4. Click Create.
5. Enter a file name and a location to save
the file to. This is the actual file you will
need to upload to your web site.
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Image Size

There’s no final answer, no chart to look at to
find the correct size for an image, but enough people
have tested the options to come to a consensus:

Minimum for an EXE
Minimum size would be that of the computer
monitor. If the show will never be seen on any monitor other than what you currently own, then use your
screen’s dimensions. For instance, if your monitor
set at 1024 x 768 resolution, then your images should
be no narrower than 1024 if they’re in landscape
mode and their height should be a minimum of 768.
If your screen is 1600 x 1200, then use those figures.
However, things change in the digital world,
and a bit of forward thinking is in order. Best bet?
Keep the original size of the images, or at the very
least, reduce them to no smaller than several times
the screen resolution. This might cover future contingencies where you replace your monitor or you
want your friend to watch the show on his or her
higher screen resolution.
“Several times the screen resolution” is certainly a vague statement, but it depends on if you’re
going to zoom in on an image. If you use 200%, the
image has to be at least two times the size of your
screen. If the zoom is 400%, the image needs to be
at least four times the screen size.

Minimum for a DVD
Video has much lower resolution than our computer monitors, and the absolute bare minimum
would be to match the resolution of the television,
assuming you do no zooming or cropping. If you
zoom in on a photo by 200%, you’ll need at least
twice the resolution of the TV for your picture size.
If the video is 720 x 480, then your minimum will
be 1480 x 960.

The Bottom Line
It’s better to err on the side of too much than
too little. That said, when a photo weighs in at, say,
50 MB, you might want to reduce its size to keep
ProShow from bogging down beneath the collective weight of such big boys. Also, a lot of such
weighty images in an EXE can sometimes lead to
jerky motion (depending on the speed of the computer).
Start with images at full size unless that size is
consistently huge. When a show is rendered as video
for a DVD, it’s all going to get reduced anyway.
When it comes to EXE files, you should it assume
it may one be displayed on a much higher resolution monitor.
The Bottom of the Bottom Line
Don’t reduce size unless the picture is a photographic Godzilla.
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Miscellaneous

Create Intro Show

Full-screen Viewing Controls

1. Build an extremely short show that includes your logo and any other introductory material along with a soundtrack.

When viewing a show in Presenter, there are
controls below the screen that allow you to move
backwards and forward through the show. In fullscreen mode these controls are unavailable unless
you right-click, but you can also use the Page Up
key to go back a slide and the Page Down key to go
to the next slide. The space bar pauses and resumes
the show.

2. Save this show and all associated files
in a single, easily found folder.
3. When setting up a full show for output, click on Shows.
4. On the right-hand side is a box that you
can check for “Include Intro Show.”

Two Ways to Upload to Photodex

5. Browse for the intro show you saved,
select it, and it will be included in the rendering.

Click on the “Share Show Online” option in
“Create.” The .PX file will be created and uploaded
to your account.
Click on the “Web Show” option in “Create.”
The .PX file will be created and placeed on your
hard drive. Log into your Photodex account and then
upload the show from there.

For audio, you can use your sound editor to
pull a small part from a song, or you can download
sound effects from the Internet. You can even produce your own sound effects from within a sound
editor. Several movie production companies begin
their films with their logo in motion but with no
soundtrack, and it works well, so you might consider this too.
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Apply a Setting to Multiple Slides

1. In Word, go to Tools > Macro > Security.

Right-click on any setting on the slide options
screen and select Apply to All Slides.

2. Set the security level to MEDIUM.
3. Close the Word file and reopen it.

Copy Layer From One Slide to All
Slides

4. Word will issue a “Security Warning”
about macros.

1. Right-click the layer you want added
to all slides

5. Click the “Enable Macros” button.

2. Select “Copy to All Slides”

6. Now you’ll be able to run the self-explanatory macro.

3. Because the added layer will automatically be layer 1 on all the slides, if you
want it in a different position, you’ll have
to go into each slide individually to change
this.

Screenshots

Maximum Preview Rendering Resolution
This setting controls only the previewing of
shows from within ProShow. It does not affect the
size at which a show is rendered for final output.
In “Edit > Preferences > Miscellaneous > Max
Preview Rendering Resolution,” set the value to your
monitor’s native resolution. For example, if it’s 1024
to 768, set it to that; if it’s 1680 x 1050, set it to that.

List All Files Used in Show
Extract a list of image, font, and sound files
recorded in any .PSH file. (This assumes you use
MS Word.)
To download the macro that Vernon built, go here:
http://www.proshowenthusiasts.com/viewtopic.php?f=15&t=8118

Make sure to open “ProShow PSH Reader.doc”
for the instructions.
If Word’s security settings are too high, the program won’t run. To lower the settings without compromising security do the following:
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Press the Print Screen key (PrntScr, PrtSc, etc.)
to place an image of the entire screen on the Clipboard, then open a blank canvas in your image editor and use Paste or Ctr+V to insert the image. It’ll
be a layer, which you’ll eventually want to flatten.
The resolution will be the typically low resolution
of the monitor, usually 72 pixels per inch.
Hold down the Alt key while pressing Print
Screen to copy only the active window to the Clipboard.

Save Shared Show to Your Hard Drive
First, you need to be able to see the Local Settings folder, which is a hidden folder by default. It’s
found
in C:\Documents and Settings\YourName\Local
Settings\Temp, but if you can’t see it, go to
Tools>Folder Options>View>Show Hidden Files,
and make sure it’s selected with a dot in a circle.
Also under the same options, make sure that Hide
extensions to known file types is unselected because, otherwise, you won’t be able to see the file
extensions, .tmp and .px, which you must be able
to see to do this.
When you click on a shared show, Presenter
begins to download the show using a temporary
name to the following directory: C:\Documentsand
Settings\YourName\Local Settings\Temp

If you look in that directory and sort by size, most
often the shared shows will be near the bottom because they tend to be large. You don’t need to actually play the show to get it downloaded, but it’s
important to understand that when you exit Presenter, the temporary copy of the show will be deleted.
You must allow Presenter to download the entire show. The show will have a name like
psg???.tmp where the “???” will be 2 or 3 letters
or numbers and will end up roughly the same size
as what is shown near the bottom of the page where
you view the show. If, say, it says the show is 10
megs, that’s the final size you’ll be looking for on
your temporary copy on your hard drive.
To tell if a show has finished downloading, do
the following: Looking at the size of the temporary
file, make sure it’s close to the size you took note of
at the Photodex sharing site. Use “View -> Refresh”
to see if the size is still the same after refreshing. If
it is, the download is done. Also, until the download is complete, don’t touch anything. When downloading has finished, the displayed size will suddenly jump to the final value.

was downloaded to the temp directory and select
“Copy.” (You must use Copy. You can’t move the
file because Presenter is still “using” it). Now go to
the directory where you want to save the file and
select “Paste.” Rename it to something descriptive
and set the file type to .px. You can now safely exit
Presenter by clicking out of the online show.
Note: You can’t rename the temp show while
it’s still in the temp directory because Presenter is
controlling it while it’s there.
Save Shared Show in Vista
The temporary show file will be downloaded
to: C:\Users\YourName\AppData\Local\Temp
To see this folder, you have to:

Saving the File after Downloading
Now that the file is done downloading, DO
NOT EXIT PRESENTER. Right-click the file that
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1. Turn OFF UAC. (User Account Controls.)
2. Reboot.
3. In Folder options, go to Tools>Folder
Options>View>Show Hidden Files, and
make sure it is selected (dot in a circle).
Also under the same options, make sure
that “Hide extensions to known file types”
is unselected; otherwise, you won’t see the
the.tmp and .px file extensions.

Keyboard Shortcuts

MAIN MENUS

Slide Options: CTRL+L (or press enter w/
slide selected)
Move Slide: Left >
Move Slide: Right <
Go To Slide #: CTRL+G
Insert Blank Slide: ALT+I
Fill Frame: CTRL+SHIFT+F
Fit to Frame: CTRL+SHlFT+T
Fill Safe Zone: CTRL+SHIFT+N
Fit to Safe Zone: CTRL+ALT+N
Stretch to Frame: CTRL+SHIFT+R
Delete Slide: DEL
Slide List/Timeline Toggle: TAB
Change Layer (1 - 10): CTRL+1 - CTRL+O

File Menu: ALT+F
Edit Menu: ALT+E
Create Project: ALT+P
Show Menu: ALT+S
Slide Menu: ALT+L
Audio Menu: ALT+O
Create Menu: ALT+C
Window Menu: ALT+W
Help Menu: ALT+H

WORKING WITH SHOW FILES
New Show: CTRL+N
Open Show: CTRL+O
Save Show: CTRL+5
Save Show As...: CTRL+SHIFT+S
Close Show: CTRL+W

WORKING WITH AUDIO
Show Options: CTRL+H
Sync Selected Slides: CTRL+SHIFT+Y
Sync Selected Slides to Track:
CTRL+ALT+Y
Sync Show: ALT+Y
Record Slide Timing: CTRL+ALT+R
Move soundtrack manually (in Slide Timeline
view): CTRL+CLICK & DRAG

WORKING WITH SLIDES
Undo Last Change: CTRL+Z
Redo Last Undo: CTRL+Y
Cut: CTRL+X
Copy: CTRL+C
Paste: CTRL+V
Select All Slides: CTRL+A
Select None: CTRL+ALT+A
Select Inverse: CTRL+I

PREVIEW AND PLAYBACK
Resume and Pause: ENTER or SPACEBAR
Play: CTRL+P or SPACEBAR
Stop: CTRL+T or ESC
Full Screen Playback: ALT + ENTER
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CREATING OUTPUT
Create DVD: CTRL+D
Create Video CD: ALT+V
Create Video File: ALT+M
Share Show: ALT+U
Create Web Show: ALT+N
Email Show: CTRL+E
Create Autorun CD: ALT+D
Create Executable: ALT+T
Create Screen Saver: ALT+R
Create Flash Video: CTR+F

Hide/Show Toolbar: F9
Hide/Show Lightbox View: F11
Hide/Show Slide List: F12
Exit: ALT+X

FILE LIST (Input Focus must be in File
List)
Jump to File: lst Letter of Filename
Rename File: F2
Select All: CTRL+A
Select None: CTRL+ALT+A
Select Inverse: CTRL+I
Properties: ALT+ENTER

USER INTERFACE
Help: F1
Preferences: F3
Default Window Layout:
CTRL+SHIFT+ALT+O
Save Window Layout: CTRL+SHIFT+ALT+S
Apply Window Layout:
CTRL+SHIFT+ALT+L
Thumbnail File List View: ALT+5
Detail File List View: ALT+1
Hide/Show Favorites: F4
Hide/Show Menu Bar: F5
Hide/Show Preview: F6
Hide/Show Project Pane: F7
Hide/Show Task Monitor: F8

EXECUTABLE PLAYBACK
Select Show From Menu: # of Show
Return to Menu: ESC (from playback w/
menu)
Exit: ESC (from menu or playback w/o menu)
Toggle Full Screen Playback: ALT+ENTER
Next Slide: PAGE DOWN
Previous Slide: PAGE UP
Pause/Resume: PAUSE

KEY FRAMES
Move key frames in unison: ALT+CLICK &
DRAG
Move key frames proportionately:
CTRL+CLICK & DRAG
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ProShow Files
by Dick Knisely

All files associated with your show (here called
“showname”) will have the name of that show as
part of the file name.

This is a cache of show resources. It’s safe to
delete because it’ll be recreated the next time you
open the show for editing.

showname.PSH

File folder: showname_psdata

That’s your show. Do not delete it unless you’re
really sure of what you’re doing. You can open it in
Notepad because it’s just a text file with instructions to ProShow on where to find the show content
and what to do with that content. This is where all
those hours of work go: it’s the actual slide show
that can be loaded, edited, and output in several different forms.
showname.BAK
showname.Bnn (nn = 2 digit number)

This is a file folder (often quite large) containing temporary files created while rendering a video
output. It’s safe to delete because it’ll be recreated
if you render the video again.
showname.ISO
This is a file containing the DVD “image” of
your show. Make sure to keep it if you want to make
more DVDs without rendering again. It’s safe to
delete, but it’s also handy to have.

These are backup files for your show. You can
delete them, but it’s better to keep them around in
case of disaster. As with the PSH file, these can be
opened with Notepad.
showname.PXC

showname.EXE
showname.AVI (etc)
Like the ISO, these are outputs from
ProShow—each type has a corresponding file type.
Safe to delete if you don’t need it, but be sure you
won’t want it again.
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Troubleshooting How-to
by Dick Knisely

I have problems running ProShow. What can I
do?

I have a show that won’t open. What do I do?

Occasionally you ProShow won’t run at all or
it crashes when attempting to load a show. (If the
issue is with only one show, skip down to the next
question.) Many problems can be fixed with this
simple process:

Sometimes ProShow software works fine, but
there’s suddenly a show that won’t open. When this
happens, it’s normally fixed easily with one of the
following steps. Try them one at a time:

1. Close ProShow.
2. Click on Start > Search > For Files and
Folders.

• Delete showname.PXC (cache file) and
then see if it will open.
• Try deleting DEF.PHD and CPIC.OPT
in Programs\Photodex\ProShowProducer
(or ProShowGold).

3. Click on “All files and folders.”
• Try opening one of the show’s backup
files (showname.BAK or showname.Bnn).
Do this by going to the File menu and
choosing “Revert to Backup.”

4. In the top box that says “All or part of
the file name,” type in: “CPIC.OPT” and
click “Search.”
5. The search results will display this file
located in the C:\Program Files folders.
Click on the file and delete it.

• If the show opens partially but crashes
while loading, there’s a possibility that one
of the audio files (.WAV or .MP3) is corrupt, or at least ProShow thinks so. See
below.

6. Next, search for a file called
“DEF.PHD” and delete this file as well.
7. The next time you open ProShow it will
recreate these two files automatically.

Corrupt Audio File

Try deleting only DEF.PHD and then run the
program to see if that takes care of the issue. All
your preferences that you’ve set for ProShow will
be left intact. If removing DEF.PHD doesn’t fix the
issue, then delete CPIC.OPT also. Deleting one or
both these files will fix many issues. If all else fails,
then the best approach is to uninstall the software
and then reinstall it.
NOTE: Once you’ve learned the location of
these two files, it’s easier to just navigate directly to
them in Windows Explorer.
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Occasionally, ProShow will crash when you
attempt to use a particular MP3 audio file, or it may
crash while later attempting to load or play the show.
If you suspect this and you know which audio file is
the culprit, the fix is to either use a different MP3 or
to use an audio editor to recreate the MP3 by loading it and resaving it with another name. If you don’t
know which file is the culprit, move all the audio
files somewhere so ProShow will do the “locate
files” dialogue, but choose to have ProShow continue without the missing audio files. If the show

loads and previews, this confirms the show is intact
and it’s the audio causing the problem. Save the
show under a new name so you will at least retain
the video portion. Now, either manually add back
in each of the audio files one at a time to pinpoint

the bad one, or instead, go back through the “locate
files” process to locate each audio file in turn. Sometimes you can recreate the audio file, and sometimes
there’s nothing for it but to replace it in order to fix
the problem.

137

Crash When Opening PSH File

backward before you see results…assuming this is
the problem.

Right-click the .PSH file in Windows Explorer
and choose to open it in notepad. Find the “Sounds
entry,” and if it has a –number, not a +number,
change it to a + sign.

Files Not Found
The PSH file is a text file containing, among
other things, instructions for where ProShow can
find each file you’ve used. If you move a file, the
new location won’t be recorded in the PSH file,
which means ProShow won’t know where it’s gone.
As long as you know what you’ve done with
those missing files, when ProShow comes up telling you they’re missing, just answer “Yes” to its
question of whether or not you want to search for
the missing files. If even you don’t know where those
files went, first do a Windows search for them. Then,
after pointing out the files to ProShow, it can update the PSH file to reflect the new file locations.
To keep this bit of annoyance from happening,
it’s best to keep all of a show’s files in a single location.

Image Previews Not Completely Shown
If when clicking on images in the folder list,
the preview loads only partially, it may be a sign
that your hard drive is overly full and needs
defragging. Preview images need hard drive space
to be stored, and if there isn’t enough space, bad
behavior results.
If the above doesn’t solve the problem, try this:
In Windows XP, click Start > Settings > Control
Panel > Display > Settings > Troubleshoot. Then
slide the hardware acceleration selection back. Test
in ProShow Gold/Producer for each decrease in acceleration because it may require several positions
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Laptop Playback Stutters
If in Windows XP power management, the
CPU defaults to “Adaptive,” speed problems can
occur. This is a power efficient mode where the CPU
clock speed is reduced during periods of low CPU
activity and speeds up as CPU activity increases.
This can cause stuttering in USB audio playback,
and it can also cause frame loss in video streaming.
Furthermore, it can affect crossfades in ProShow.
Solution: Install a freeware utility called
SpeedswitchXP, which enables you to change the
CPU dynamic switching setting to “Max Performance,” thus forcing the CPU to run at its highest
speed. (Windows XP hides the CPU setting so that
you cannot see it in the control panel power options.)
On Sony laptops and possibly others, you may
find an installed utility where you can choose preset performance modes or set them manually.

Soundtrack Won’t Stop Playing
If you’re watching a shared show at Photodex
and stop a show before it’s finished but the
soundtrack continues playing, press Ctrl+Alt+Del
to bring up the Task Manager. Select pxplay.exe and
choose to End Task, assuring Windows this is what
you want to do. Silence will return.

In a Copy Operation, the Program
Crashes
(This is a bug in the software.) To solve, when
in the Motion Menu, turn on “Show Layer Outlines”
in the right-click menu.

Section XII
Copyright
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The Legal Side: Copyright
By Barbara Coultry

What Can Be Copyrighted
For our purposes, this includes original compositions, arrangements of public and non-public
domain works, video recordings, and audio recordings.

· Published by a corporation (think
“Disney”)—Protected for 95 years from
publication or 120 years from the date of
creation.
(Note: If you can work it out from the above
information, all the more power to you.)

Fair Use

What Can’t Be Copyrighted
You are allowed to make copies of small portions for criticism, commentary, news reporting, research, or teaching. The rule of thumb is not more
than 10% of the original. As you can see, it’s unlikely that anything we do could be construed as
falling under the heading of “fair use.” Even if the
show is being used for teaching, it may fall outside
the bounds. Give a copy of the show to students or
parents, and you’ve broken the law.

An idea, method, title, or short phrase.

Copyright Specifics
· Created in 1922 or before—It’s in the
public domain. (The composition is in the
public domain, not a performance of it.)
· Created between Jan. 1, 1923 and Dec.
31, 1977—Protection is based on renewal
dates as opposed to the creator’s death.
For instance, the creator may die, but the
family can renew the copyright.

Not True
When you purchase a CD, you’ve purchased
the music.
Because the CD is no longer for sale, it’s free
to be copied.
It’s legal to make your own arrangement of
copyrighted music.
Because you don’t plan on selling the show,
you’re within the law.

· Created between Jan. 1, 1964 and Dec.
31, 1977—Protected for 95 years from the
date of creation.
· Unpublished works created before
Jan. 1, 1978—Protected for the life of the
author plus 70 years, or until Dec. 31,
2002, whichever is later.

Very Important Point
Compositions in the public domain can be
copyrighted. If you have an arrangement of a Mozart
piece on CD, be assured that the arrangement is protected. You can’t legally copy it without permission.

· Published on or after Jan. 1, 1978—
Protected for 70 years after the creator’s
death. For joint works, it’s 70 years after
the last surviving author’s death.
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A Way to Look at Copyright

Something to Think About

If you park your car on a public street in view
of everyone who passes by, do any of those passersby have the right to climb into your car and drive
off with it? It’s no more complicated than that. You
may be able to hear the music, but this doesn’t mean
you own it.

Artists need to eat, to keep warm, and to provide for their families. Regardless of how it may
seem, most artists are either scraping up a living or
they’re producing their art while working elsewhere.
If an artist grows rich from his talent, this doesn’t
mean it’s fine to steal from him. Whether you steal
from the rich or the poor, you’re still a thief.
If we don’t support the arts, they will die.
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Free Resources
by Diana Lang

DISCLAIMER: Simply because a piece of software (or graphic/audio/video clip) is free, does not
necessarily mean it is “free for the taking” to use any way you want. Though full, unrestricted usage may be
granted for personal use, there may be restrictions against its use in commercial applications under any
circumstances (where you are selling your production). It is the responsibility of the end-user to Terms of
Usage or the Creative Commons Licensing Agreement to determine if the software is legal to use in your
production or the creation of the production. If in doubt, always contact the copyright owner.

AUDIO
Free sound editors, converters, recorders, sounds and music
Sound Tools and Editors
Atmosphere Lite - http://www.vectormediasoftware.com/atmdeluxedown.htm Create your own background atmospheric music (scroll down to download)
Audacity - http://audacity.sourceforge.net/ Sound editor (used by & highly recommended by many forum
members)
Audiograbber - http://www.audiograbber.com-us.net/ Grab digital audio from your audio CDs
Besweet - http://dspguru.doom9.net/ Audio transcoding tool supporting MP3, AC3, WAV, MP2, Ogg
Vorbis & others
DBpoweramp - http://www.dbpoweramp.com/ Audio CD Ripper and converter
Freebyte Music Zone - http://www.freebyte.com/music/ Links to free music software, midi files, sheet
music
Free codecs - http://free-codecs.com/ Free audio (and video) codecs
Freecorder Toolbar - http://applian.com/freecorder3/index.php A free audio recorder that works right
within your browser. Make MP3’s from anything you can hear on your PC, including sound tracks from
videos, music, and more
Lame MP3 Encoder - http://audacity.sourceforge.net/help/faq?s=install&item=lame-mp3 Audacity (link
above) needs this installed to export to MP3
MediaInfo - http://mediainfo.sourceforge.net/en Supplies technical and tag information about a video or
audio file
Mp3tag - http://www.mp3tag.de/en/ Tag editor - Rename files based on the tag information, replace
characters or words from tags and filenames, import/export tag information, create playlists, and more. It
supports online “freedb” database lookups for selected files, allowing you to automatically gather proper
tag information for select files or CDs.
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MusikCube - http://www.musikcube.com/page/main/download Music/Sound Organizer
Switch - http://nch.com.au/switch/index.html Convert audio files from many different file formats into
MP3, WAV or WMA
TrakAx - http://www.trakax.com/software Create your own music
Sounds & Loops
A1 Free Sound Effects - http://www.a1freesoundeffects.com/
Absolute Sound Effects Archive - http://www.grsites.com/sounds/
Accoustica Free Sound Effects - http://www.acoustica.com/sounds.htm
FindSounds - http://www.findsounds.com/
The Free Sound Project - http://www.freesound.org/index.php
Less Clicks - http://www.lessclicks.com/free_sounds.html
The Recordist - http://www.therecordist.com/pages/downloads.html
Sound Snap - http://www.soundsnap.com/
Taylor Hayward - http://taylorhayward.org/
Movie Sounds Central - http://www.moviesoundscentral.com/
Moviewavs - http://www.moviewavs.com/
Music For Video - http://music-for-video.com/free-sound-effects-for-video-makers.html
Music
Classical Music Archive - http://www.classicalarchives.com/ subscription site, but also has free stuff
Derek R. Audette - http://derekaudette.ottawaarts.com/index2.php
Free Christmas MP3s - http://christmasmpfree.com/
Free Kid’s Music - http://freekidsmusic.com/
Free Solo Guitar - http://freesologuitar.com/
Free Solo Piano - http://freesolopiano.com/
Free Music Directory - http://thefreemusicdirectory.com/
Freeplay Music - http://www.freeplaymusic.com/
Ghost Notes - http://ghostnotes.blogspot.com/
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Great Songs Free - http://greatsongsfree.com/free-MP3-music-downloads.html
ILoveWavs - http://greatsongsfree.com/free-MP3-music-downloads.html
Internet Audio Guy - http://www.internetaudioguy.com/iag/freemusic/mp3downloads.htm
Jamendo - http://www.jamendo.com/en/
Kevin MacLeod - http://www.incompetech.com/
MFiles - http://www.mfiles.co.uk/index.htm
MobyGratis - http://www.mobygratis.com/film-music.html no commercial use; must apply for license
(and be approved) prior to being able to download
Music Download.com - http://music.download.com/
Sonnyboo - http://www.sonnyboo.com/music/music.htm
The Free Music Directory - http://thefreemusicdirectory.com/
WikiProject Free Music - http://en.wikipedia.org/wiki/Wikipedia:Sound/list
Wolfgang’s Vault - http://www.wolfgangsvault.com/

Graphics
Free graphic editors, utilities, and tools for graphic creation, photo correction, and photo
manipulation
Graphic Tools and Editors
About.comGraphics - http://thefreemusicdirectory.com/ Tutorials and resources for the most popular
graphic editors
Andrea Mosaic - http://www.andreaplanet.com/andreamosaic/ Create your own photo mosaics made
with your own pictures
AxiomX PicSizer - http://www.axiomx.com/picsizer.htm
Blender - http://www.blender.org/ 3D creation graphics tool
Cooltext - http://cooltext.com/ Free online graphics generator plus 1200+ font archive
CreaToon - http://www.creatoon.com/ Free 2D animation software
FreeSerif - http://www.freeserifsoftware.com/ Edit and enhance your digital images and photos for print,
email, and the web
Imagegrab - http://paul.glagla.free.fr/imagegrab_en.htm Grab a ‘still’ image from video
Irfanview - http://www.irfanview.com/ Image & Video Viewer
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FastStone Image Viewer - http://www.faststone.org/FSViewerDetail.htm An image browser, converter,
and editor that supports all major graphic formats
FastStone Image Resizer - http://www.faststone.org/FSResizerDetail.htm Convert, rename, resize, crop,
rotate, and add text and watermarks in a quick & easy batch mode.
Gimp - http://www.gimp.org/ Photo retouching, image composition, and image authoring
GimpShop - http://www.gimpshop.com/ A modification of GIMP, intended to replicate the feel of Adobe
Photoshop
Movie Clapper Board Generator - http://www.fodey.com/generators/movie/clapper_board.asp Generate/
personalize a scene-opening clapper board
Paintnet - http://www.getpaint.net/download.html Image and photo editing software
Photoscape - http://www.photoscape.org/ps/main/index.php Easy photo editing software to fix and
enhance photos
Picasa - http://picasa.google.com/ Google’s imaging editing software
Pixort - http://www.pixort.com/ Image review and sorting
PhotoShape Classic - http://bobyte.com/ Easily give 3D perspective to your images by rotating them
three-dimensionally with only your mouse.
Sqirlz Water Reflections - http://www.xiberpix.net/SqirlzReflect.html
Stoik Image 4.0 - http://www.stoik.com/imagicfree/index.html Easily import, organize, and automatically enhance your photos
Winmorph - http://www.debugmode.com/winmorph Morph one picture into another
XiberPix - http://www.xiberpix.net/index.html Warp, bend, and loop text and images; morph two or
more images; rippling water reflections

Free Photos/Backgrounds/Etc
http://www.cgtextures.com/ - Textures/backgrounds
http://www.free-graphics.com/ - Mostly clipart
http://creativity103.com/
http://graphicssoft.about.com/od/freedownloads/l/blframes_t01.htm - Masks/edge frames
http://morguefile.com/
http://www.dreamstime.com/free-images_pg1
http://www.everystockphoto.com/
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http://www.freefoto.com/index.jsp
http://www.flickr.com/photos/library_of_congress - Historic photos from US Library of Congress
http://flickr.com/photos/smithsonian
http://www.fontplay.com/freephotos/
http://www.freerangestock.com/
http://www.freephotos.se/
http://www.free-photographs.net/
http://www.free-stockphotos.com/
http://www.freephotobank.org/main.php
http://www.grsites.com/textures/ - Textures/backgrounds
http://office.microsoft.com/en-us/clipart/default.aspx?lc=en-us – Must have a Microsoft program that uses
the Microsoft Clipart Gallery
http://www.reelworship.com - Christian backgrounds & video clips
http://www.shorpy.com/
http://www.vecteezy.com/ - Free vector graphics

Free Photoshop/Elements Add-ons
About.com http://graphicssoft.about.com/od/photoshopactionsFree_Adobe_Photoshop_Actions_and_Scripts_to_Download.htm

Action Central - http://www.atncentral.com/download.htm
Add-on/Tools for Photoshop Elements http://graphicssoft.about.com/od/pselementsaddons/Addons_and_Tools_for_Photoshop_Elements.htm
Adobe Exchange http://www.adobe.com/cfusion/exchange/index.cfm?event=productHome&exc=16&loc=en_us
Deviant Art - http://browse.deviantart.com/resources/applications/psactions/?order=9&alltime=yes
Elated - http://www.elated.com/actionkits/
Finesse FX - http://finessefx.com/actions.php
Liknes - http://www.liknes.no/Photoshop/index.asp
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Media Chance - http://mediachance.com/
Paint Engine http://fantasticmachines.com/store/index.php?cPath=24&osCsid=7455d27614b3cc803c9d85559aa04744
Panos FX http://www.panosfx.com/index.php?option=com_content&task=category&sectionid=4&id=13&Itemid=27
PhotographyBB - http://photographybb.com/forum/index.php
The Plugin Site - http://www.thepluginsite.com/resources/freeps.htm
ReynsPhoto - http://www.reynsphoto.com/articles/Post_Processing/extra/70_Photoshop_Actions_app.php
Using Actions in Photoshop Elements - http://graphicssoft.about.com/od/pselements/qt/actions.htm
Virtual Photographer - http://www.optikvervelabs.com/default.asp
Visual Blast - http://www.visual-blast.com/

Fonts
http://eknp.com/
http://www.1001freefonts.com/
http://www.acidfonts.com/
http://www.bvfonts.com/fonts/fonts.php?show=free&by=date
http://www.chank.com/freefonts.php
http://www.dingbats-uk.org.uk/download/index.html
http://www.drybohnz.com/dryheavesfonts2004/fonts.html
http://www.flashfonts.com/flashsite/fontspage.htm
http://www.fonts101.com/
http://www.fontbros.com/free_fonts.php
http://www.fontdiner.com/main.html
http://www.fontfiles.com/
http://www.fontframe.com/topenter.html
http://www.fontfreak.com/main.htm
http://www.fontgarden.com/
http://fonthead.com/freeware.php
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http://www.fontmagic.com/
http://www.fontmaniac.com/
http://www.fontsearchengine.com/
http://www.highfonts.com/
http://www.houseoflime.com/fonts.html
http://www.jabroo.com/
http://www.misprintedtype.com/v3/fonts.php
http://www.urbanfonts.com/

Font Viewers
Aksoft – http://www.aksoft.net/progs/akfontviewer/index.html View samples of all your installed fonts
in Windows
FontLoader - http://www.aaafreebies.com/programs/fontloaderprogram.htm FontLoader offers a shell
context menu extension that lets you load and install fonts by right-clicking on a font file or a folder
containing fonts.
FontViewer - http://www.ampsoft.net/utilities/FontViewer.php View, install and uninstall fonts, and
organize them in categories
Free and Easy Font Viewer - http://www.styopkin.com/details_free_and_easy_fonts_viewer.html View
all your installed fonts simultaneously

VIDEO
Free video editors, converters, screen recording, codec tools, and motion backgrounds
Video Tools and Editor
Applian FLV Player - http://applian.com/flvplayer/ View FLV videos at 1x, 2x or full screen. Plays
URLs, streams, and local files.
Avidemux - http://fixounet.free.fr/avidemux/ Designed for simple cutting, filtering, and encoding tasks
Avidemux Tutorial – http://www.mythtv.org/wiki/index.php/Avidemux Tutorial for the above program
AviScreen - http://www.bobyte.com/ An application for capturing screen activity (ScreenCast) in the
form of AVI video or images.
Avisplitter - http://bobyte.com/ AVI video splitter, video joiner. Many free tools here.
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AviTricks Video Editor - http://www.bobyte.com/ Non-linear, non-destructive AVI video editor with
real-time preview. It makes cutting and joining footage easy.
CamStudio 2.0 - http://sourceforge.net/projects/camstudio/ Darn close to the commercial screen capturing program, Camtasia. Output as AVI or SWF
FFDShow - http://www.free-codecs.com/FFDShow_download.htm MPEG-4 video decoder
Free codecs - http://free-codecs.com/ Free audio and video codecs
Gspot - http://www.headbands.com/gspot/ Full information on video (codec used, diagnostic, repair,
etc.)
HuffyUV - http://www.free-codecs.com/HuffYUV_download.htm AVI compression codec – great for
Proshow. Excellent way to reduce huge, uncompressed AVIs without quality loss!
Imagegrab - http://paul.glagla.free.fr/imagegrab_en.htm Grab a ‘still’ image from video
K-Lite Codec Pack - http://www.free-codecs.com/HuffYUV_download.htm Call Photodex support on a
codec issue and chances are they’ll recommend this all-in-one codec pack.
Lagarith - http://www.free-codecs.com/download/Lagarith_Lossless_Video_Codec.htm Another lossless
AVI compression codec – runs a little slower, but compresses to even smaller files than HuffyUV.
MediaInfo - http://mediainfo.sourceforge.net/en Supplies technical and tag information about a video or
audio file
MPEG StreamClip - http://www.squared5.com/ A powerful free video converter, player, and editor. Cut,
trim and join movies. Download videos from YouTube and Google by entering the page URL. Great tool
to retrieve your work from your DVD (VOB files) and into AVI or MPEG when you have lost your
ProShow files.
MWSnap - http://www.snapfiles.com/get/mwsnap.htmlhttp://www.snapfiles.com/get/mwsnap.html
Static screen capture utility in BMP, PNG, JPG, GIF, TIFF
Rad Video tools - http://www.radgametools.com/bnkdown.htm Various video tools – VERY easy to use
video conversion utility
Sherlock - http://www.radgametools.com/bnkdown.htm Detect and find codecs on your system and see
if they are broken.
Stoik Video Converter - http://www.stoik.com/products/svc/index.html Convert AVI, WMV, and DV
files in all possible combinations
Super - http://www.erightsoft.com/SUPER.html Converts movie files, including VOB
SyncView - http://software.sdecnet.com/index.php?option=com_content&task=view&id=18 Sync your
AVI, MPEG audio to the video
Ulead DV converter - http://www.ulead.com/download/dvconverter/download.htm Changes DV Type I
format video to DV Type II
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Virtualdub - http://www.virtualdub.org/ Converts just about anything to anything (PAL to NTSC, removes audio, etc.)
VirtualDubMod - http://sourceforge.net/project/showfiles.php?group_id=65889&package_id=63653
Convert VOB files to AVI
Video Inspector - http://www.kcsoftwares.com/index.php?download With VideoInspector you’ll know
why your video has no sound or refuses to play correctly.
VLC mediaplayer - http://www.videolan.org/vlc/ Multimedia player for various audio and video formats
WinDV - http://windv.mourek.cz/ Captures video from DV device into AVI; records AVI into a DV
device via FireWire interface
Wink - http://www.debugmode.com/wink/ A tutorial and presentation creation software. Using Wink,
you can capture screenshots, add explanations boxes, titles, etc.
Wax - http://www.debugmode.com/wax/ High performance and flexible video compositing and special
effects software
Xmpeg - http://www.xmpeg.net/DownloadMoreinfos.asp?ID=1 Convert VOB to AVI, MPEG, etc.

Motion/Animated Backgrounds
Internet Archive - http://www.archive.org/details/movies library of free movies, films, and videos
Classic Movie Sounds – http://www.classicmovies.org/soundcartoons.htm Assorted cartoons and animated films
MovieTools-http://www.classicmovies.org/soundcartoons.htm
MovieWavs – http://www.moviewavs.com/Movies/Production_Companies.html Download wavs of the
major production companies
Royalty Free Stock Video - http://royaltyfreestockvideofootage.com/rfvf_store/index.php?cPath=31
Lots of free ones – just look!
Studio Trailers Movie Digest - http://www.digital-digest.com/movies/movie_index.php?type=studio
Stock Footage for Free - http://stockfootageforfree.com/ Commercial use allowed
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MISCELLANEOUS
A little of this and a little of that - other handy utilities/tools to have in your arsenal
Tools and Utilities
Advanced Renamer - http://aren.hulubulu.net/ Great utility for organizing digital pictures for both
professionals and beginners. Thumbnail mode lets you display thumbnails directly in the file list, giving
you maximum control of the renaming process. MP3 files often have messed-up names and contain
weird characters. Change the names of your favorite music files to more suitable names using the builtin ID3 functions.
Creative Commons Search Engine - http://search.creativecommons.org/ Look for photos, music, text,
books, and other content that’s free to share or modify for your own purposes. The Creative Commons
search engine can help you find tons of (legally) free stuff on the web.
DVD Shrink - http://www.dvdshrink.org/ Shrink your DVD output to fit on a standard DVD disc
IESpell - http://www.iespell.com/ A spell checker for Internet Explorer—good for forum spell checking
ImgBurn - http://www.imgburn.com/ Free ISO burning software
FileHippo - http://filehippo.com/ Lots of freeware
FlashKit - http://www.flashkit.com/ Flash animations, fonts, graphics
The Freebie Directory - http://www.freebiedirectory.com/ The name pretty much says it all
The Internet Archive - http://www.archive.org/index.php The Internet Archive is a digital library of
Internet sites and other cultural artifacts in digital form.
JAlbum - http://jalbum.net/ Album software & free web hosting. With Jalbum, it’s easy to create your
own photo album site.
Jasp http://www.freedownloadscenter.com/Utilities/File_Splitting_UtilitiesJASP___Just_Another_File_Split_Program.html

You can use this utility to split large files (up to 4G) into smaller parts
.
KarensPowerTools - http://www.karenware.com/powertools/ptdirprn.asp Handy computer utilities for
experienced computer users
Magnifixer - http://www.blacksunsoftware.com/lensview.html Screen magnifier
Newspaper Headline - http://www.fodey.com/generators/newspaper/snippet.asp Create a fake newspaper clipping with your own headline
OpenOffice - http://www.openoffice.org/ If it looks like Microsoft Office, is fully compatible with
Microsoft Office, then it must be Microsoft Office. But it isn’t! You can also open/edit Adobe PDF files.
Microsoft Works (compliments of Microsoft) is included in the OpenOffice download.
PDF Creator- http://sourceforge.net/projects/pdfcreator/
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Rename Master - http://www.joejoesoft.com/cms/showpage.php?cid=108 Rename large groups of files
(i.e., photos!) with a few clicks
Scanning Tips - http://www.scantips.com/ Scanning Basics 101
Smartclose - http://bmproductions.fixnum.org/ Close down all running background apps - Wizard
interface. One click closes all but required OS processes and makes a backup to enable turning everything back on when needed. Great for shutting everything down when you want to give as much computer resources as possible to Proshow.
Storyboard Pro - http://movies.atomiclearning.com/k12/storyboardpro Make a storyboard for your next
project
Unlocker - http://ccollomb.free.fr/unlocker/ For when you get “ERROR - CANNOT DELETE THIS
FILE. IT’S BEING USED BY ANOTHER PERSON OR PROGRAM”

Photography
Alex Nolan Digital Tricks - http://www.alexnolan.net/articles/digital_photography.htm
CambridgeInColor- http://www.cambridgeincolour.com/tutorials/digital-camera-pixel.htm
Camera Hobby- http://www.camerahobby.com/EBook-TOC.htm
Digital Camera Resource- http://www.dcresource.com/
Digital Photography Tips- http://www.dslrtips.com/workshops/DSLR_%20...%20tips.shtml
DSLR Tips-http://www.dslrtips.com/
Imaging Resource-http://www.dslrtips.com/
Ken Rockwell-http://www.kenrockwell.com/tech.htm
PBase Magazine- http://www.pbase.com/magazine
Photo Answers -http://www.photoanswers.co.uk/ includes some Photoshop video tutorials
PhotographyBB Magazine- http://www.photographybb.com/magazine/
PhotonHead- http://www.photographybb.com/magazine/
The Digital Podcast- http://www.thedigitalstory.com/podcast/

Web File Storage
4 Shared- http://www.4shared.com/
FileFactory-http://www.filefactory.com/
MediaFire- http://www.mediafire.com/
YouSendIt – http://www.yousendit.com/ only the LITE version is free
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XDrive -http://www.yousendit.com/

